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About this information product

...............................................................................................................................................................................................................................................................

Purpose This preface provides an overview of this information product, which
is the Navis™ Optical Network Management System (NMS)
Administration Guide, Release 7.0.

The purpose of this Administration Guide is to explain to users how
to administer the Navis™ Optical Network Management System
(NMS), Release 7.0 (R7.0).

Reason for reissue Issue 1 of this Administration Guide is a new document that supports
the Navis™ Optical NMS, R7.0

Safety labels This document does not use safety labels.

Intended audience This document is written primarily for operations personnel who
administer the Navis™ Optical NMS.

....................................................................................................................................................................................................................................
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How to use this
information product

This document contains:

• task information, which includes administration tasks (that is,
step-by-step instructions).

• conceptual information, which is specific data related to the
tasks.

Both types of information is presented within the chapters of this
Administration Guide.

Chapter descriptions

The following table describes the information in each chapter of this
Administration Guide.

Section Title Description

Preface About this
information product

Explains this document’s purpose,
its intended audience, and how to
use the document.

Chapter
1

Chapter 1,
“Administration
Overview”

Provides an overview of the
administration process.

Chapter
2

Chapter 2,
“Platform
Administration”

Contains HP-UX and Windows
configuration set-up, printer
set-up, power on and power down
tasks.

Chapter
3

Chapter 3, “System
Administration”

Explains how to start and stop the
system, set preferences, restart the
database and how to perform other
system administration tasks.

Chapter
4

Chapter 4, “Users
and User Profiles”

Provides the conceptual
information needed to comprehend
the administration of users and
user profiles in the Navis™ Optical
NMS and the tasks that are needed
to add users to and to assign
privileges and restrict access to
the Navis™ Optical NMS
application.

Administration Guide About this information product
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Section Title Description

Chapter
5

Chapter 5,
“Geographic
Domain
Partitioning”

This chapter provides the
conceptual information needed to
comprehend the administration of
the Geographic Domain
Partitioning feature and the related
tasks that are needed to administer
and maintain the feature.

Chapter
6

Chapter 6, “Service
Domain
Partitioning”

Provides the conceptual
information needed to comprehend
the administration of the Service
Domain Partitioning feature and
the related tasks that are needed to
administer and maintain the
feature.

Chapter
7

Chapter 7,
“Provisioning
Administration”

Contains tasks on managing areas,
aggregates, and scheduled entities.

Chapter
8

Chapter 8,
“Reliability and
Service Recovery ”

Provides instructions on how to
perform hot and cold backups.

Chapter
9

Chapter 9,
“Off-Line Tools”

Contains tasks for off-line tools.

Chapter
10

Chapter 10, “EMS
Management ”

Describes how to add new element
management systems, perform a
database synchronization, and
view LAN status information.

Chapter
11

Chapter 11,
“Trouble Clearing”

Contains troubleshooting
procedures.

Chapter
12

Chapter 12,
“Software Release,
Version, and Patch
Information”

Provides instructions on how to
upgrade the system.

Appen-
dix A

Appendix A,
“Navis™ Optical
NMS Filesystems”

Contains a list of file systems.

Administration Guide About this information product
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Section Title Description

Appen-
dix B

Appendix B,
“Navis™ Optical
NMS Configuration
Parameters”

Is a placeholder for general
information about system
configuration parameters.

Appen-
dix C

Appendix C,
“Navis™ Optical
NMS Common
UNIX Commands
and Tasks”

Contains explanations of several
UNIX commands that are used in
administrative tasks.

Glossary “Glossary” Contains a list of abbreviations,
acronyms, and terms that are
commonly used in the Navis™

Optical NMS documentation
library.

Index Index Enables the user to find
information on specific topics.

Conventions used This Administration Guide relies on the following typographical
conventions to distinguish between computer input and output.

• When describing the Navis™ Optical NMS software, fields in
windows and field entries are identified with this font.

• When describing the UNIX® environment, text and numbers that
the user inputs to the computer are identified with boldface
type.

• In the UNIX environment, text and numbers that the computer
outputs to the user are identified with monospace type.

Related documentation This Administration Guide is part of a set of documents that supports
the Navis™ Optical NMS.

Administration Guide About this information product

....................................................................................................................................................................................................................................

x x i i Lucent Technologies 365-309-264R7.0
Issue 1, July 2002

,



List of documents

The documents that support the Navis™ Optical NMS R7.0 application
are the following:

• Navis™ Optical Network Management System Getting Started
Guide, (365-309-260R7.0) instructs users how to begin using the
product to provision and manage a network. This document
includes tasks and conceptual information.

• Navis™ Optical Network Management System Applications and
Planning Guide, (365-309-261R7.0) describes the Navis™ Optical
NMS features and applications, provides a product description
and the hardware platforms for the product, and describes system
planning and engineering, ordering, and product support. This
document contains conceptual information only.

• Navis™ Optical Network Management System Provisioning
Guide, (365-309-262R7.0) instructs users how to use the product
to provision and manage a network. This document includes tasks
and conceptual information.

• Navis™ Optical Network Management System Maintenance
Guide, (365-309-263R7.0) instructs users on how to maintain the
product and the network. This document includes tasks and
conceptual information.

• Navis™ Optical Network Management System Administration
Guide, (365-309-264R7.0) instructs users on how to administer
the product and the network. This document includes tasks and
conceptual information.

Glossary

This Administration Guide contains a glossary that will be helpful to
users of the Navis™ Optical NMS.

On-line documentation

The Navis™ Optical NMS documentation set is provided in HTML
format and is available on CD-ROM with the Navis™ Optical NMS
software. A separate CD-ROM, which is titled Navis™ Optical NMS
User Documentation CD-ROM, (365-309-265R7.0), can be ordered.
This CD-ROM iincludes the full set of documents listed previously.

Screen help

The Navis™ Optical NMS software includes screen help for each
form, which describes the purpose of the form, each field, and each
button.

Administration Guide About this information product
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How to comment To comment on this information product, go to the Online Comment
Form (http://www.lucent-info.com/comments) or email your comments
to the Comments Hotline (ctiphotline@lucent.com).

How to order To order Navis™ Optical NMS information products, contact your
Lucent Technologies customer team representative or contact Lucent
Technologies at:

• From the United States, call 888-LUCENT8 (888-582-3688),
prompt 1.

• From Canada, call 317-322-6615.

• From Europe, the Middle East, Africa, Asia, the Pacific, China,
the Caribbean, and Latin America, call 317-322-6416.

Administration Guide About this information product
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1 Administration Overview

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides an overview of the Navis™ Optical Network
Management System (NMS) administration process.

Contents
Administration Basics 1-2

Who Performs Administration Tasks? 1-3

Administer Hardware Configurations 1-4

....................................................................................................................................................................................................................................
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Administration Basics
....................................................................................................................................................................................................................................

What administration of the
application includes

The administration of the Navis™ Optical NMS application includes
the security management of the application and the administration of
Geographic Domain Partitioning and Service Domain Partitioning,
which are optional Navis™ Optical NMS features.

Admininistrative support
provided

The administrative support provided by supports the Navis™ Optical
NMS application includes the following:

• Security management support, which includes tasks associated
with how to add and delete user IDs and profiles

• Provisioning support, which includes tasks used to add or delete
geographic domains or to list network elements.

• System support, which includes system-related tasks, such as how
to backup or recover the system.

Platform Administration
and Application
Administration

Administration of the Navis™ Optical NMS application includes the
following areas:

• Platform Administration contains critical setup tasks that are
performed outside of the Navis™ Optical NMS application, which
include tasks for powering on or powering off the HP servers, the
desktops , adding users to desktops, and assigning user
privileges.

• Application Administration, which includes tasks and concepts
specific to the Navis™ Optical NMS application.

Administration Overview

....................................................................................................................................................................................................................................
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Who Performs Administration Tasks?
....................................................................................................................................................................................................................................

Introduction Administrative tasks are performed by users with a system
administrator user type.

Navis™ Optical NMS
system administrator user

types

Navis™ Optical NMS has the following system administrator user
types:

• Navis™ Optical NMS System Administrator, which is the
dacscan user with privileges to start or stop the Navis™ Optical
NMS.

• Navis™ Optical NMS Administrator, which is an sa user allowed
to create other Navis™ Optical NMS application users.

In addition to those system administrator user types, there are also
hardware administrators for UNIX and Windows systems known as
OS (Operating System) Superusers. The OS Superuser has ultimate
power over UNIX or Windows hardware, and are root and
Administrator respectively.

For a description of Navis™ Optical NMS user types, see Chapter 4 of
this document.

Functions Users with system administrator privileges are able to perform tasks
that enable them to:

• Provide security management, provisioning, and system support
to the Navis™ Optical NMS host and to the Network Map.

• Control the appearance of the Network Map

Administration Overview
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Administer Hardware Configurations
....................................................................................................................................................................................................................................

Introduction Navis™ Optical NMS supports various hardware configurations.

List of hardware
configurations

The following hardware configurations are supported:

• single server

• single server (with disk mirroring)

• local redundancy

• geographic redundancy

For details on the hardware configurations, refer to the Navis™

Optical NMS Applications and Planning Guide.

Administration Overview

....................................................................................................................................................................................................................................
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2 Platform Administration

Overview
....................................................................................................................................................................................................................................

Purpose

This chapter contains information on how to:

• power on and power down servers and desktops

• perform configuration setup tasks

• add various types of printers

Contents
Section I: Power on Servers 2-3

Power on an HP Server in a Single Server
Configuration

2-4

Power on HP Servers in a Local Redundancy
Configuration

2-5

Power on HP Servers in a Geographic Redundancy
Configuration

2-6

Power on a Windows Terminal Server 2-7

Section II: Power Down Servers 2-8

Power Down an HP Server in a Single Server
Configuration

2-9

....................................................................................................................................................................................................................................
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Power Down HP Servers in a Local Redundancy
Configuration using SAM

2-11

Power Down HP Servers in a Geographic
Redundancy Configuration

2-13

Power Down a Windows Terminal Server 2-16

Section III: Power on Desktops 2-18

Power on an HP-UX Workstation 2-19

Power on a Windows Desktop 2-20

Section IV: Power Down Desktops 2-21

Power Down an HP-UX Workstation 2-22

Power Down a Windows Desktop 2-23

Section V: Configuration Tasks 2-24

Add a Workstation to the Navis™ Optical NMS
Host

2-25

TIM TCP/IP Configuration Setup 2-27

Asynchronous Port Setup for TIM Interface 2-31

Section VI: Printer Administration 2-34

Install a Network Printer on an HP Server 2-35

Add a Network Printer 2-37

Add a Local Serial Printer 2-39

Set Up the CDE Printer Icon 2-40

Overview Platform Administration
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Section I: Power on Servers

Overview
....................................................................................................................................................................................................................................

Purpose This section provides information on how to power on HP servers in
the following configurations:

• single server configuration

• geographic redundancy configuration

• local redundancy configuration

This section also contains information on how to power on a
Windows terminal server.

Contents
Power on an HP Server in a Single Server
Configuration

2-4

Power on HP Servers in a Local Redundancy
Configuration

2-5

Power on HP Servers in a Geographic Redundancy
Configuration

2-6

Power on a Windows Terminal Server 2-7

Platform Administration

....................................................................................................................................................................................................................................
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Power on an HP Server in a Single Server Configuration
....................................................................................................................................................................................................................................

Purpose This procedure is used to power on an HP server in a single-server
hardware configuration.

Important! When the system is powered on, it does not
automatically start the Navis™ Optical NMS application.

Task Complete these steps to power on the HP server in a single-server
configuration:
............................................................................................................................................................

1 Power on all associated peripherals, for example, the control terminal,
external disk drives, external tape drives, and modems.

............................................................................................................................................................

2 Press the power switch or turning the key, as appropriate, on the HP
server.

Result:

The HP server runs a sequence of diagnostics then boots into
multi-user mode. The server is ready when the Console Login

prompt displays on the controlling terminal. Its initial run level
setting is set to init 3. Refer to “init Command for Changing
Run Levels” (C-2).

Section I: Power on Servers Platform Administration
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Power on HP Servers in a Local Redundancy Configuration
....................................................................................................................................................................................................................................

Purpose This procedure is used to power on HP servers in a local redundancy
configuration.

Important! When the system is powered on, it does not
automatically start the Navis™ Optical NMS application.

Task Complete these steps to power on the primary server and standby
HP server(s) in a local redundancy configuration:
............................................................................................................................................................

1 Power on all peripherals associated with the cluster, for example,
control terminal(s), external disk drives, external tape drives, and
modems.

............................................................................................................................................................

2 Power on the primary HP server by pressing the power switch or
turning the key, as appropriate.

Result:

The HP server runs a sequence of diagnostics then boots into
multi-user mode. The server is ready when the Console Login

prompt displays on the controlling terminal.

............................................................................................................................................................

3 Power on the standby HP server(s) by pressing the power switch or
turning the key, as appropriate.

Result:

The standby server(s) runs a sequence of diagnostics, then boots
into multi-user mode. The server(s) is ready when the Console

Login prompt displays on the controlling terminal.

Section I: Power on Servers Platform Administration
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Power on HP Servers in a Geographic Redundancy
Configuration
....................................................................................................................................................................................................................................

Purpose This procedure is used to power on an HP server with any of the
geographic redundancy configurations.

Important! When the system is powered on, it does not
automatically start the Navis™ Optical NMS application. Note
that the designation of primary and standby servers in this task
refers to the current status of the servers not the status of the
servers at installation.

Task Complete these steps to power on the HP server in a geographic
redundancy configuration:
............................................................................................................................................................

1 Start the primary server. See “Power on an HP Server in a Single
Server Configuration” (2-4).

............................................................................................................................................................

2 Start the standby server. See “Power on an HP Server in a Single
Server Configuration” (2-4).

Section I: Power on Servers Platform Administration
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Power on a Windows Terminal Server
....................................................................................................................................................................................................................................

Purpose This procedure is used to power on a Windows terminal server.

Task Complete these steps to power on a Windows terminal server:
............................................................................................................................................................

1 Power on all associated peripherals, for example, control terminal(s),
external disk drives, external tape drives, and modems.

............................................................................................................................................................

2 Power on the server by pressing the power switch or turning the key,
as appropriate.

Result:

The server runs a sequence of diagnostics. The server is ready
when the Windows login dialog box displays.

Section I: Power on Servers Platform Administration
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Section II: Power Down Servers

Overview
....................................................................................................................................................................................................................................

Purpose This section contains information on how to power down HP servers
in the following configurations:

• single server configurations

• local redundancy configurations

• geographic redundancy configurations

In addition, this section contains information on how to power down a
Windows terminal server.

Contents
Power Down an HP Server in a Single Server
Configuration

2-9

Power Down HP Servers in a Local Redundancy
Configuration using SAM

2-11

Power Down HP Servers in a Geographic
Redundancy Configuration

2-13

Power Down a Windows Terminal Server 2-16

Platform Administration

....................................................................................................................................................................................................................................
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Power Down an HP Server in a Single Server Configuration
....................................................................................................................................................................................................................................

Purpose This procedure is used to shut down the Navis™ Optical NMS
application and to power down a single server.

Before you begin Be sure to follow the steps below to shut down the application and
power down the server. Use local procedures to inform users that the
application will be shut down.

Task Complete these steps to power down a single server:
............................................................................................................................................................

1 On the control terminal, log in as root.

............................................................................................................................................................

2 Shut down the Navis™ Optical NMS application; see the “Stop the
Navis™ Optical NMS Application on a Single Server” (3-15)
procedure.

............................................................................................................................................................

3 At the prompt, type cd /.

Result:

The directory is changed.

............................................................................................................................................................

4 At the prompt, type shutdown -h -y 0.

Important! The 0 parameter in the command line shutdown -h
-y 0 causes the shutdown process to begin in 0 seconds, or
immediately. To delay the shutdown process, replace the 0 with
the number of seconds to wait before the shutdown is to
commence. Refer to “shutdown Command for Halting or
Rebooting Servers” (C-10).

Result:

The shutdown process initiates and eventually displays the
following message unless the message wait for UPS to turn

off power message is printed:
System has halted

OK to turn off power or reset system

Section II: Power Down Servers Platform Administration
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............................................................................................................................................................

5 Power off the HP server by pressing the power switch or turning the
key, as appropriate.

Result:

The HP server is powered off.

............................................................................................................................................................

6 Power off all associated peripherals, for example, the control terminal,
external disk drives, external tape drives, and modems.

Section II: Power Down Servers
Power Down an HP Server in a Single
Server Configuration

Platform Administration
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Power Down HP Servers in a Local Redundancy Configuration
using SAM
....................................................................................................................................................................................................................................

Purpose This procedure is used to power down HP servers in a local
redundancy configuration that relies on HP’s MC/ServiceGuard cluster
administration GUI.

Before you begin Be sure to follow the steps below to shut down the application and
power down the server. Use local procedures to inform users that the
application will be shut down.

Task Complete these steps to power down an HP server in a local
redundancy configuration:
............................................................................................................................................................

1 Log into any server in the cluster as root.

............................................................................................................................................................

2 Shut down the Navis™ Optical NMS application; see the “Stop the
Navis™ Optical NMS Application on a Single Server” (3-15)
procedure.

............................................................................................................................................................

3 Enter sam at the prompt and pressEnter.

Result:

The System Administration Manager window is displayed.

............................................................................................................................................................

4 From the System Administration Manager window, select Clusters >
High Availability Clusters > Cluster Admin.

............................................................................................................................................................

5 Select ITM Cluster, then select Actions > Shutdown Cluster.

Result:

The shutdown process initiates and eventually displays the
following message unless the message wait for UPS to turn

off power message is printed:
System has halted

OK to turn off power or reset system

Section II: Power Down Servers Platform Administration
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............................................................................................................................................................

6 Power off the HP server by pressing the power switch or turning the
key, as appropriate.

Result:

The HP server is powered off.

............................................................................................................................................................

7 Repeat Step 4 through Step 6 until all cluster servers are off.

............................................................................................................................................................

8 Power off all peripherals associated with the cluster, for example, the
control terminal, external disk drives, external tape drives, and
modems.

Section II: Power Down Servers
Power Down HP Servers in a Local
Redundancy Configuration using SAM

Platform Administration
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Power Down HP Servers in a Geographic Redundancy
Configuration
....................................................................................................................................................................................................................................

Purpose This procedure is used to power down an HP server in any geographic
redundancy configuration.

Before you begin Be sure to follow the steps below to shut down the application and
power down the server. Use local procedures to inform users that the
application will be shut down.

Task Complete these steps to power down an HP server in a
geographic redundancy configuration:
............................................................................................................................................................

1 Log in on the control terminal of the primary server as root.

............................................................................................................................................................

2 Shut down the Navis™ Optical NMS application; see the “Stop the
Navis™ Optical NMS Application on a Single Server” (3-15)
procedure.

............................................................................................................................................................

3 At the prompt, type cd /.

Result:

The directory is changed.

............................................................................................................................................................

4 At the prompt, type shutdown -h -y 0.

Important! The 0 parameter in the command line shutdown -h
-y 0 causes the shutdown process to begin in 0 seconds, or
immediately. To delay the shutdown process, replace the 0 with
the number of seconds to wait before the shutdown is to
commence. Refer to “shutdown Command for Halting or
Rebooting Servers” (C-10).

Result:

The shutdown process initiates and eventually displays the
following message unless the message wait for UPS to turn

off power message is printed:
System has halted

OK to turn off power or reset system
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............................................................................................................................................................

5 Power off the HP server by pressing the power switch or turning the
key, as appropriate.

Result:

The HP server is powered off.

............................................................................................................................................................

6 Power off all associated peripherals, for example, the control terminal,
external disk drives, external tape drives, and modems.

............................................................................................................................................................

7 Log in on the control terminal of the secondary server as root.

............................................................................................................................................................

8 At the prompt, type cd /.

Result:

The directory is changed.

............................................................................................................................................................

9 At the prompt, type shutdown -h -y 0.

Important! The 0 parameter in the command line shutdown -h
-y 0 causes the shutdown process to begin in 0 seconds, or
immediately. To delay the shutdown process, replace the 0 with
the number of seconds to wait before the shutdown is to
commence. Refer to “shutdown Command for Halting or
Rebooting Servers” (C-10).

Result:

The shutdown process initiates and eventually displays the
following message unless the message wait for UPS to turn

off power message is printed:
System has halted

OK to turn off power or reset system

............................................................................................................................................................

10 Power off the HP server by pressing the power switch or turning the
key, as appropriate.

Result:

The HP server is powered off.
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............................................................................................................................................................

11 Power off all associated peripherals, for example, the control terminal,
external disk drives, external tape drives, and modems.
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Power Down a Windows Terminal Server
....................................................................................................................................................................................................................................

Purpose This procedure is used to power down a Windows terminal server.

Before you begin Before you begin this task, be sure that the Navis™ Optical NMS
application has been shut down.

Task Complete these steps to power down a Windows terminal server:
............................................................................................................................................................

1 Log in to the server as Administrator.

............................................................................................................................................................

2 Press the Ctrl, Alt, and Del buttons.

Result:

The Windows Security dialog box displays.

............................................................................................................................................................

3 Press the Shut Down button.

Result:

The Shut Down Windows dialog box displays.

............................................................................................................................................................

4 Select the Shut Down button.

Result:

The Shutdown Computer dialog box displays.

............................................................................................................................................................

5 Select the OK button.

Result:

The Windows terminal server powers down.

............................................................................................................................................................

6 Power off the terminal server by pressing the power switch or turning
the key, as appropriate.

Result:

The terminal server is powered off.
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............................................................................................................................................................

7 Power off all associated peripherals, for example, the control terminal,
external disk drives, external tape drives, and modems.
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Section III: Power on Desktops

Overview
....................................................................................................................................................................................................................................

Purpose This section contains information on how to power on HP and
Windows workstations.

Contents
Power on an HP-UX Workstation 2-19

Power on a Windows Desktop 2-20

Platform Administration
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Power on an HP-UX Workstation
....................................................................................................................................................................................................................................

Purpose This procedure is used to power on an HP-UX workstation.

Task Complete these steps to power on the HP-UX workstation:
............................................................................................................................................................

1 Power on all associated peripherals, for example, control terminal(s),
external disk drives, external tape drives, and modems.

............................................................................................................................................................

2 Power on the workstation by pressing the power switch or turning the
key, as appropriate.

Result:

The workstation runs a sequence of diagnostics and then boots
to the X-Windows system. The workstation is ready when the
Common Desktop Environment (CDE) login dialog box
displays.
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Power on a Windows Desktop
....................................................................................................................................................................................................................................

Purpose This procedure is used to power on a Windows desktop.

Task Complete these steps to power on a Windows desktop:
............................................................................................................................................................

1 Power on all associated peripherals, for example, control terminal(s),
external disk drives, external tape drives, and modems.

............................................................................................................................................................

2 Power on the workstation by pressing the power switch or turning the
key, as appropriate.

Result:

The workstation runs a sequence of diagnostics. The workstation
is ready when the Windows login dialog box displays.
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Section IV: Power Down Desktops

Overview
....................................................................................................................................................................................................................................

Purpose This section contains information on how to power down HP and
Windows workstations.
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Power Down an HP-UX Workstation
....................................................................................................................................................................................................................................

Purpose This procedure is used to power down an HP-UX workstation.

Task Complete these steps to power down an HP-UX workstation:
............................................................................................................................................................

1 Log in to the workstation as root.

............................................................................................................................................................

2 At the prompt, type cd /.

Result:

The directory is changed.

............................................................................................................................................................

3 At the prompt, type shutdown -h -y 0.

Important! The 0 parameter in the command line shutdown -h
-y 0 causes the shutdown process to begin in 0 seconds, or
immediately. To delay the shutdown process, replace the 0 with
the number of seconds to wait before the shutdown is to
commence. Refer to “shutdown Command for Halting or
Rebooting Servers” (C-10).

Result:

The shutdown process initiates and eventually displays the
following message unless the message wait for UPS to turn

off power message is printed:
System has halted

OK to turn off power or reset system

............................................................................................................................................................

4 Power off the workstation by pressing the power switch or turning the
key, as appropriate.

Result:

The workstation is powered off.
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Power Down a Windows Desktop
....................................................................................................................................................................................................................................

Purpose This procedure is used to power down a Windows workstation.

Task Complete these steps to power down a Windows workstation:
............................................................................................................................................................

1 Log in to the workstation as Administrator.

............................................................................................................................................................

2 Select Start > Shut Down.

Result:

The Shut Down Windows dialog box displays.

............................................................................................................................................................

3 Select the Shut Down button then select Yes.

Result:

The Windows workstation powers down.

............................................................................................................................................................

4 Power off the workstation by pressing the power switch or turning the
key, as appropriate.

Result:

The workstation is powered off.
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Section V: Configuration Tasks

Overview
....................................................................................................................................................................................................................................

Purpose This section contains tasks that explain how to configure Navis™

Optical NMS hardware and how to set up supporting processes.

Contents
Add a Workstation to the Navis™ Optical NMS
Host

2-25

TIM TCP/IP Configuration Setup 2-27

Asynchronous Port Setup for TIM Interface 2-31
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Add a Workstation to the Navis™ Optical NMS Host
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a workstation to the Navis™ Optical
NMS host.

Task Complete these steps to add a workstation to the Navis™ Optical
NMS host:
............................................................................................................................................................

1 Log in to the Navis™ Optical NMS host as root.

............................................................................................................................................................

2 At the prompt, enter ksh /install/add.ethers.

............................................................................................................................................................

3 At the prompt, enter y and press Enter.

............................................................................................................................................................

4 At the prompt, enter the workstation name and press Enter.

............................................................................................................................................................

5 Enter y to confirm that the name was entered correctly then press
Enter.

............................................................................................................................................................

6 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

7 Enter y if the entry of the IP address is correct.

Enter n if the IP address is incorrect and enter the correct IP address
to continue.

............................................................................................................................................................

8 Log in to the workstation.

............................................................................................................................................................

9 At the prompt, enter pg /etc/hosts.

Result:

The system outputs the contents of the/etc/hosts file.
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............................................................................................................................................................

10 View the contents of the /etc/hosts file to determine if an entry
exists for the workstation.

..........................................................................................................................................................

11 IF THEN

an entry exists, proceed to the next step.

an entry does not exist, add the workstation information to the
bottom of the /etc/hosts file.

............................................................................................................................................................

12 Download the Navis™ Optical NMS GUI.

Result:

The GUI is displayed.
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TIM TCP/IP Configuration Setup
....................................................................................................................................................................................................................................

Purpose This procedure is used to set up a Telecommunications Management
Network Integration Module (TIM) TCP/IP configuration.

Task Complete these steps to set up a TIM TCP/IP configuration:
............................................................................................................................................................

1 Log into the host as root.

............................................................................................................................................................

2 At the prompt, enter init 3.

Result:

The Navis™ Optical NMS application is stopped.

............................................................................................................................................................

3 At the prompt, enter cd /etc/dscan.

touch .tim

chmod 666 .tim

Result:

The file’s timestamp is updated and its permissions are changed.

............................................................................................................................................................

4 At the prompt, enter /etc/dscan/chg_env_var.

Result:

The following message will be displayed:
THE DEFAULT SETTINGS FOR <COMPANY_NAME> WILL NOW BE

DISPLAYED

YOU WILL BE PROMPTED TO CONFIRM THE SETTINGS.

PRESS ENTER TO CONTINUE:

............................................................................................................................................................

5 Press Enter.

Result:

A list of settings display with a prompt requesting whether or
not you want to change the settings.

............................................................................................................................................................

6 Type y and press Enter to continue.
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Result:

The WS-NMS Parameter Editor menu displays.

............................................................................................................................................................

7 Find the number corresponding to TIM_PORT or TIM_TCP.

Important! You may have to press Enter to view this selection.

............................................................................................................................................................

8 At the prompt, enter the number corresponding to TIM_PORT or
TIM_TCP.

Result:

The selection displays.

............................................................................................................................................................

9 At the prompt, enter 2 and press Enter.

Result:

You are prompted to enter the IP address for TIM.

............................................................................................................................................................

10 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

11 Enter y if the entry of the IP address is correct.

Enter n if the IP address is incorrect and enter the correct IP address
to continue.

Result:

You are prompted to enter the TIM hostname.

............................................................................................................................................................

12 Enter the hostname, then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

13 Enter y if the entry of the hostname is correct.
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Enter n if the hostname is incorrect and enter the correct hostname to
continue.

Result:

The following messages are displayed followed by a prompt to
add or change the TIM Interface login and password.

Updated host’s file successfully

Updated CCP file successfully

............................................................................................................................................................

14 Add or change the password as required.

Result:

The following message displays.

Updated TIM login file successfully

............................................................................................................................................................

15 Press Enter to return to the Edit Parameter menu.

Result:

You are in the Edit Parameter menu.

............................................................................................................................................................

16 Type q and press Enter, and type n and press Enter.

Result:

You have exited the menu.

............................................................................................................................................................

17 Log into the host as dacscan.

............................................................................................................................................................

18 Copy the parameters to the following file in the database:
/usr/dacscan/bin/DBinitParam

Result:

A list of parameters display without entries for TIM_PORT and
TIM_TCP.

............................................................................................................................................................

19 Log into the host as root.
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............................................................................................................................................................

20 At the prompt, enter init 4.

Result:

Navis™ Optical NMS application is started.
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Asynchronous Port Setup for TIM Interface
....................................................................................................................................................................................................................................

Purpose This procedure is used to set up an asynchronous port for the
Telecommunications Management Network Integration Module (TIM)
interface.

Before you begin In this procedure, you will be required to edit a file. To avoid losing
data, consider making a copy of this file before editing. If you choose
to copy this file, remember to delete it from the system when you are
finished editing.

Task Complete these steps to set up an asynchronous port:
............................................................................................................................................................

1 Log into the host as root.

............................................................................................................................................................

2 Enter sam at the prompt and pressEnter.

Result:

The System Administration Manager window is displayed.

............................................................................................................................................................

3 View the display, highlight Peripheral Devices then press Enter.

Result:

A new menu displays.

............................................................................................................................................................

4 Highlight Terminals and Modems then press Enter.

Result:

The current configuration displays.

............................................................................................................................................................

5 Press F4.

Result:

The main menu bar is activated.

............................................................................................................................................................

6 Select Actions then press Enter.
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Result:

A drop down menu displays.

............................................................................................................................................................

7 Select Add Modems then press Enter.

Result:

A note menu displays.

............................................................................................................................................................

8 Select OK.

Result:

A hardware scan occurs and returns with the installed
Mux/Serial cards and their respective hardware paths.

............................................................................................................................................................

9 Highlight Mux/Serial card with a h/w path of 12 then press tab three
times.

............................................................................................................................................................

10 Enter the port number, press tab once, then enter 9600 for the baud
rate.

............................................................................................................................................................

11 Press tab once, then unselect “Do you want the device for

calling out?” Use defaults for all other prompts, then press F5.

Result:

A device file is created, for example for port 3:

/dev/ttyd0p3

............................................................................................................................................................

12 Record the displayed device information then exit sam.

............................................................................................................................................................

13 At the prompt, enter vi /etc/inittab and press Enter.

Result:

The file is displayed.

............................................................................................................................................................

14 Locate the a0:2:respawn:/etc/getty -h ttyd0p3 9600 line.
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............................................................................................................................................................

15 Change the a0:2:respawn:/etc/getty -h ttyd0p3 9600 line to
a0:24:respawn:/etc/getty -h ttyd0p3 9600.

............................................................................................................................................................

16 Press Esc, then type :wq.

Result:

The file is saved.

............................................................................................................................................................

17 At the prompt, enter init q then press Enter.

Result:

The changed is initialized.
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Section VI: Printer Administration

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to add a network or local serial printer and
how to set up the Common Desktop Environment (CDE) printer icon.

Contents
Install a Network Printer on an HP Server 2-35

Add a Network Printer 2-37

Add a Local Serial Printer 2-39

Set Up the CDE Printer Icon 2-40
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Install a Network Printer on an HP Server
....................................................................................................................................................................................................................................

Purpose This procedure is used to install a network printer on an HP server
that is running the Navis™ Optical NMS application.

Before you begin Before you begin this task, collect the following information about the
network printer from the system administrator and/or by printing the
test/configuration page from the printer.

• Printer name

• IP Address

• LAN Hardware Address

• Name or IP address of the server providing spooler facilities

Task Complete these steps to add a network printer on an HP server:
............................................................................................................................................................

1 Take the printer off-line.

............................................................................................................................................................

2 Press the Menu button until TEST MENU appears in the display.

............................................................................................................................................................

3 Press the Item button until SELF TEST appears in the display.

............................................................................................................................................................

4 Press Enter.

Result:

A printer status sheet prints. This status sheet indicates the LAN
hardware address (LAN HW ADDRESS), network peripheral
name (HOST NAME), and the IP address, if these values have
been assigned to the printer.

............................................................................................................................................................

5 Press On Line.

............................................................................................................................................................

6 Using the system console, log in as root on the primary server via the
system console.
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............................................................................................................................................................

7 Enter ksh /install/prtinstall at the # prompt.

Result:

Additional prompts display.

............................................................................................................................................................

8 Respond to the IP address, printer name, and Type in the LAN

Hardware Address prompts.

Result:

The network printer is added.

Section VI: Printer Administration
Install a Network Printer on an HP Server

Platform Administration

....................................................................................................................................................................................................................................

2 - 3 6 Lucent Technologies 365-309-264R7.0
Issue 1, July 2002

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Add a Network Printer
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a network printer to your workstation.

Before you begin Before you begin this task, collect the following information:

• Printer name (the printer name must be six characters or less)

• IP Address

The network printer must be connected to Ethernet. The local serial
printer must be connected to the asynchronous mux board.

Task Complete these steps to add a network printer:
............................................................................................................................................................

1 Take the printer off-line.

............................................................................................................................................................

2 Press the Menu button until TEST MENU appears in the display.

............................................................................................................................................................

3 Press the Item button until SELF TEST appears in the display.

............................................................................................................................................................

4 Press Enter.

Result:

A printer status sheet prints. This status sheet indicates the LAN
hardware address (LAN HW ADDRESS), network peripheral
name (HOST NAME), and the IP address, if these values have
been assigned to the printer.

............................................................................................................................................................

5 Press On Line.

............................................................................................................................................................

6 Using the system console, log in as root on the primary server via the
system console.

............................................................................................................................................................

7 Enter ksh /install/prtinstall at the # prompt.

Result:

Additional prompts display.
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............................................................................................................................................................

8 Respond to the IP address, printer name, and Type in the LAN

Hardware Address prompts.

Result:

The network printer is added.
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Add a Local Serial Printer
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a local serial printer.

Before you begin Make sure you know the printer name, which must be 6 characters or
less.

Task Complete these steps to add a local serial printer to your
workstation:
............................................................................................................................................................

1 Using the system console, log in as root onto the primary server.

............................................................................................................................................................

2 Enter ksh /install/prtinstall at the # prompt.

............................................................................................................................................................

3 Answer the questions as appropriate.

Result:

The local serial printer is added.
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Set Up the CDE Printer Icon
....................................................................................................................................................................................................................................

Purpose This procedure is used to configure the workstation to print Navis™

Optical NMS forms to a local printer.

The workstation can be configured to enable the Common Desktop
Environment (CDE) printer icon to be used to print Navis™ Optical
NMS forms to a local printer.

Task Complete these steps to set up the CDE printer icon:
............................................................................................................................................................

1 Log in as root.

............................................................................................................................................................

2 Enter cd /config at the UNIX prompt.

............................................................................................................................................................

3 Enter vi sys.vuewmrc.

............................................................................................................................................................

4 Change the PUSH_ACTION variable in the CONTROL Printer section
to PUSH_ACTION f.action PrintPush.

............................................................................................................................................................

5 Save the file.

............................................................................................................................................................

6 Exit the file.

............................................................................................................................................................

7 Enter cd /usr/vue/config/types.

............................................................................................................................................................

8 Enter vi PrintPush.vf.

............................................................................................................................................................

9 Change the EXEC-STRING variable in the Action PrintPush section to
EXEC-STRING bin/ksh -c ’xwd -frame | xpr -device ps
-cutoff 70 -rv | lp -o nb -o postscript’.

............................................................................................................................................................

10 Save the file.
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............................................................................................................................................................

11 Exit the file.

............................................................................................................................................................

12 Select Exit on the CDE to reboot the workstation.
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3 System Administration

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes administration tasks for the Navis™ Optical
NMS application.

Contents
Section I: Start the Navis™ Optical NMS
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3-5
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Single Server

3-6
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Windows Terminal Server

3-8

Section II: Start the Navis™ Optical NMS
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3-9

Start the Navis™ Optical NMS Application on a
Windows Terminal Server

3-10

Start the Navis™ Optical NMS Application on an
HP-UX Workstation

3-11

Start the Navis™ Optical NMS Application on a
Windows PC

3-12

Section III: Stop the Navis™ Optical NMS
Application on the Desktops and Servers

3-13
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Stop the Navis™ Optical NMS Application on a
Desktop

3-14

Stop the Navis™ Optical NMS Application on a
Single Server

3-15

Stop Navis™ Optical NMS on a Windows Terminal
Server

3-17

Stop the Navis™ Optical NMS on a Server
Configured with an UPS

3-18

Section IV: Geographic Redundancy
Configuration

3-19
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3-20

Stop the Navis™ Optical NMS Application on a
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3-21
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3-24

Stop the Navis™ Optical NMS Application on Local
Redundancy Configurations

3-26
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Local Redundancy Configuration using SAM

3-27
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Specific Server using SAM

3-28

Stop the Navis™ Optical NMS Application on a
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3-29

Switch to a Standby Server in a Local Redundancy
Configuration using SAM

3-30

Enable Automatic Package Switching in a Local
Redundancy Configuration using SAM

3-32

Disable Automatic Package Switching in a Local
Redundancy Configuration using SAM

3-33
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3-34
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Restart the Oracle Database 3-37

Stop the Oracle Database 3-38

Section VII: Administer the System cron File 3-39
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Section I: Start the Navis™ Optical NMS Application on the
Servers

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to start the Navis™ Optical NMS
application on HP servers and a Windows terminal server.

Background The initial step to start Navis™ Optical NMS is to power on the
server. (See the power on tasks in Chapter 2, “Platform
Administration”.) A single server configuration may or may not have
mirrored disks.

This section includes tasks for single-server configurations only. For
start and stop tasks that support geographic and local redundancy
configurations, see “Section IV: Geographic Redundancy
Configuration” (3-19) and “Section V: Local Redundancy
Configuration” (3-22).

Start the host application The application starts when the Navis™ Optical NMS application is set
to run level 4. See “Run level 4” (C-2) for additional details.
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Start the Navis™ Optical NMS Application on a Single Server
....................................................................................................................................................................................................................................

Purpose This procedure is used to start the Navis™ Optical NMS application
on a single server.

Before you begin The single server must be powered up. See “Power on an HP Server
in a Single Server Configuration” (2-4).

The GUI must be downloaded on the workstation(s) or terminal
server(s).

Start Navis™ Optical NMS
on a single server

Complete these steps to start the Navis™ Optical NMS application
on a single server.
............................................................................................................................................................

1 Log into the server as root.

............................................................................................................................................................

2 At the prompt, enter who -r.

Result:

A message displays a line of current run level information, such
as run-level 3 Oct 30 11:26 3 0 S.

..........................................................................................................................................................

3 Continue with one of the following options.

IF THEN

run-level is 3, proceed to the next step to continue.

run-level is 4, the application is already running; no
further action is necessary.

run-level is not 3 or 4, contact the system support staff.

............................................................................................................................................................

4 At the prompt, enter init 4.

Result:

The run level is changed to run-level 4.
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............................................................................................................................................................

5 At the prompt, enter tail —f/etc/rc.log.

Important! To terminate this command, press the Ctrl and c
buttons.

Result:

The message,

WS-NMS Application has been started...

HP-UX run-level transition completed

<Weekday> MMM DD HH:MM:SS <timezone> YYYY

displays.
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Start the Navis™ Optical NMS Application on a Windows
Terminal Server
....................................................................................................................................................................................................................................

Overview Once the Windows terminal server is powered on (“Power on a
Windows Terminal Server” (2-7)), it is not necessary to start the
Navis™ Optical NMS application on a Windows terminal server;
therefore, a procedure is not required.

Section I: Start the Navis™ Optical NMS
Application on the Servers

System Administration

....................................................................................................................................................................................................................................

3 - 8 Lucent Technologies 365-309-264R7.0
Issue 1, July 2002



Section II: Start the Navis™ Optical NMS Application on the
Desktops

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to start the Navis™ Optical NMS
application on the desktops that are the user interface.

Background Once the servers are powered up (as described in the previous section
of this chapter), users can start the Navis™ Optical NMS application:

• on a single server or server configured for geographic
redundancy

• on an HP-UX workstation

• on a Windows desktop

This section includes information on how to start the Navis™ Optical
NMS application on HP-UX and Windows desktops in a single-server
configuration only. For information on how to start workstations in a
local redundancy configuration, see “Section V: Local Redundancy
Configuration” (3-22).
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Start the Navis™ Optical NMS Application on a Windows
Terminal Server
....................................................................................................................................................................................................................................

Overview Once the Windows terminal server is powered on (“Power on a
Windows Terminal Server” (2-7)), it is not necessary to start the
Navis™ Optical NMS application on a Windows terminal server,
therefore a procedure is not required.
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Start the Navis™ Optical NMS Application on an HP-UX
Workstation
....................................................................................................................................................................................................................................

Purpose This procedure is used to start the Navis™ Optical NMS application
on an HP-UX workstation.

Before you begin Be sure that the HP-UX workstation is powered on. See “Power on an
HP-UX Workstation” (2-19).

Task Complete these steps to start the Navis™ Optical NMS application
on an HP-UX workstation:
............................................................................................................................................................

1 Log in to the HP-UX workstation.

Result:

The Navis™ Optical NMS icon displays on the Common
Desktop Environment (CDE) panel. (The icon may display as a
Lucent logo.)

..........................................................................................................................................................

2 Continue with one of the following.

IF... THEN...

the Navis™ Optical NMS
icon displays on the
Common Desktop
Environment (CDE) panel:

double-click the icon.

Important! The icon may display as a
Lucent logo.

Result: The Navis™ Optical NMS
Network Map displays.

the icon does not display: contact the system support staff. (See
the Technical support information
located at the beginning of this
document for details.)
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Start the Navis™ Optical NMS Application on a Windows PC
....................................................................................................................................................................................................................................

Purpose This procedure is used to start the Navis™ Optical NMS application
on a Windows PC.

Before you begin Before running Navis™ Optical NMS on a Windows PC, the desktop
must be powered on. Refer to “Power on a Windows Desktop” (2-20).
In addition, the Navis™ Optical NMS application must be loaded on
the desktop.

Task Complete these steps to start Navis™ Optical NMS on a Windows
desktop:
............................................................................................................................................................

1 Log into the Windows desktop.

Result:

The Windows desktop displays.

..........................................................................................................................................................

2 Continue with one of the following.

IF THEN

the icon displays on the
desktop:

double-click the icon.

Result: The Navis™ Optical NMS
Network Map displays.

the icon does not display
on the desktop:

contact the system support staff. (See
the Technical support information
located at the beginning of this
document for details.)
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Section III: Stop the Navis™ Optical NMS Application on the
Desktops and Servers

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to stop Navis™ Optical NMS.

Stop the host application The Navis™ Optical NMS application stops when Navis™ Optical
NMS is brought to run level 3 (multi-user mode).

Under certain circumstances, it might be necessary to bring the
Navis™ Optical NMS application to run level 3, for example, if the
system needs a new software load. See “Run level 3” (C-2) for
additional details.

This section includes procedures for single-server configurations only.
For procedures that support geographic and local redundancy
configurations, see “Section IV: Geographic Redundancy
Configuration” (3-19) and “Section V: Local Redundancy
Configuration” (3-22).
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Stop the Navis™ Optical NMS Application on a Desktop
....................................................................................................................................................................................................................................

Purpose This procedure is used to stop the Navis™ Optical NMS application on
a desktop.

Related information Other procedures are required to stop the Navis™ Optical NMS
application on single servers or on servers that are configured for
local redundancy or geographic redundancy:

• To stop the Navis™ Optical NMS application on a single server,
see “Stop the Navis™ Optical NMS Application on a Single
Server” (3-15).

• To stop the Navis™ Optical NMS application on servers
configured for local redundancy, see “Stop the Navis™ Optical
NMS Application on Local Redundancy Configurations” (3-26).

• To stop the Navis™ Optical NMS application on servers
configured for geographic redundancy, see “Stop the Navis™

Optical NMS Application on a Geographic Redundancy
Configuration” (3-21).

Task Complete these steps to stop the Navis™ Optical NMS application
on a desktop:
............................................................................................................................................................

1 On the Network Map, do one of the following:

• Select File > Exit.

• Select the close button in the top right corner of the Network
Map.

Result:

A confirmation dialog box displays.

............................................................................................................................................................

2 At the dialog box, select OK.

Result:

The Navis™ Optical NMS session is terminated.
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Stop the Navis™ Optical NMS Application on a Single Server
....................................................................................................................................................................................................................................

Purpose This procedure is used to stop the Navis™ Optical NMS application on
a single server.

Stop Navis™ Optical NMS
on a single server

Complete these steps to stop the Navis™ Optical NMS application
on a single server.
............................................................................................................................................................

1 Log into the server as root.

............................................................................................................................................................

2 At the prompt, enter who -r.

Result:

A message displays a line of current run level information, such
as run-level 4 Oct 30 11:26 3 0 S.

..........................................................................................................................................................

3 Continue with one of the following options.

IF THEN

run-level is 4, proceed to the next step to continue.

run-level is 3, the application is not running; no
further action is necessary.

run-level is not 3 or 4, contact the system support staff. (See
the Technical support information
located at the beginning of this
document for details.)

............................................................................................................................................................

4 At the prompt, enter init 3.

Result:

The run level is changed to run-level 3.

............................................................................................................................................................

5 At the prompt, enter tail —f/etc/rc.log.

Important! To terminate this command, press the Ctrl and c
buttons.
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Result:

The message,

HP-UX run-level transition completed

<Weekday> MMM DD HH:MM:SS <timezone> YYYY

displays.
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Stop Navis™ Optical NMS on a Windows Terminal Server
....................................................................................................................................................................................................................................

Overview Since the Navis™ Optical NMS application is not run on a Windows
terminal server, a procedure is not required.
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Stop the Navis™ Optical NMS on a Server Configured with an
UPS
....................................................................................................................................................................................................................................

Introduction An Uninterruptible Power Supply (UPS) protects against power
failures. It is used to protect the main servers and their essential
peripherals from minutes of power failure. In the case of a longer
power loss, the UPS enables the system to shut down gracefully.

Configurable file The UPS provides a configurable file that contains two timers used in
the shutdown process. When the Navis™ Optical NMS application
receives notification to indicate a loss of AC power, the application
runs a shutdown script that results in a graceful shutdown of the
application within the time limit of these timers:

• shutdown_delay_mins: This parameter indicates the number of
minutes following notification that its UPS has switched to
internal battery power before the UPS monitor initiates a
shutdown. The default value for this parameter is one minute.

• shutdown_timeout_mins: This parameter indicates the number of
minutes to monitor the shutdown operation before a reboot is
initiated with the halt option. The default value for this parameter
is five minutes.

These timers are tunable at time of installation and can be changed
subsequent to installation; however, normally they should not need to
be changed. UPS is not supported in local redundancy configurations
and is only compatible with Non-Safeguard configurations.

Systems configured with UPS are brought into init level 4
automatically on power up.
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Section IV: Geographic Redundancy Configuration

Overview
....................................................................................................................................................................................................................................

Purpose This section contains tasks to start and stop the Navis™ Optical
NMSapplication on an HP server configured for geographic
redundancy.
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Start the Navis™ Optical NMS Application on a Geographic
Redundancy Configuration
....................................................................................................................................................................................................................................

Purpose This procedure is used to start the Navis™ Optical NMS application
on a server configured for simplified or full geographic redundancy.

Before you begin The server configured for simplified or full geographic redundancy
must be powered up; see “Power on HP Servers in a Geographic
Redundancy Configuration” (2-6).

Task Complete these steps to start the Navis™ Optical NMSapplication
on a server configured for simplified or full geographic
redundancy:
............................................................................................................................................................

1 Log in to the primary server as root.

............................................................................................................................................................

2 Enter ksh /usr/dacscan/bin/StartUp.

Result:

Navis™ Optical NMS is initiated on the simplified or full
geographic redundancy server. If problems are identified, the
startup terminates.
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Stop the Navis™ Optical NMS Application on a Geographic
Redundancy Configuration
....................................................................................................................................................................................................................................

Purpose This procedure is used to stop the Navis™ Optical NMSapplication on
a server configured for simplified or full geographic redundancy.

Task Complete these steps to stop the Navis™ Optical NMS application
on a server configured for simplified or full geographic
redundancy:
............................................................................................................................................................

1 Log on to the primary server using a geographic redundancy
configuration as root.

............................................................................................................................................................

2 At the prompt, enter ksh /usr/dacscan/bin/ShutDown.

Result:

The Navis™ Optical NMS application is stopped.
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Section V: Local Redundancy Configuration

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to start and stop the Navis™ Optical NMS
application on an HP server configured for local redundancy that
relies on HP’s MC/ServiceGuard cluster administration GUI. It
explains how to switch to a backup server configured for local
redundancy using the cluster administration GUI and it includes
package switching tasks and information on how to administer
clusters.

Switchovers Because a redundant server configuration can switch to its standby
server when needed, a redundant server configuration enhances system
availability. A switchover might occur if a hardware failure occurs, a
software upgrade is needed, or if general maintenance needs to be
performed. If the primary server fails, the standby server takes over.

Note: Switchover procedures are not provided for single-server
configurations because they cannot be switched.

Monitoring the switchover Monitoring the switchover consists of two processes, the pulse
process and the heartbeat process, which must be present on each
server and which can be started and stopped manually on each server.
The standby server has a pulse process that monitors the heartbeat of
the primary server to determine if it is alive (up and running). The
heartbeat process, which resides on the primary server, is the detection
mechanism for the standby server.
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Stop the Navis™ Optical NMS Application on a
Local Redundancy Configuration using SAM

3-29

Switch to a Standby Server in a Local Redundancy
Configuration using SAM

3-30
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Start the Navis™ Optical NMS Application on a Local
Redundancy Configuration
....................................................................................................................................................................................................................................

Purpose This procedure is used to start the Navis™ Optical NMS application
on HP servers configured for local redundancy using HP’s
MC/ServiceGuard cluster administration GUI.

Before you begin The servers within the cluster must be powered up. See “Power on
HP Servers in a Local Redundancy Configuration” (2-5).

Related information This task can also be performed using SAM. See “Start the Navis™

Optical NMS Application on a Local Redundancy Configuration using
SAM” (3-27) for details.

Task Complete these steps to start the Navis™ Optical NMS application
on HP servers configured for local redundancy using HP’s
MC/ServiceGuard cluster administration GUI:
............................................................................................................................................................

1 Log in to any server within the cluster as root.

............................................................................................................................................................

2 Determine if the package is running on a member of the cluster by
viewing the cluster/application status. Refer to “View Cluster Status
Information” (3-35).

............................................................................................................................................................

3 If the application is not running on a member of the cluster, proceed
to the next step to continue.

If the application is running on a member of the cluster, further
action is not necessary and the task is ended.

............................................................................................................................................................

4 Start the Navis™ Optical NMS application.

Result:

The Navis™ Optical NMS application is started.
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............................................................................................................................................................

5 Repeatedly perform a status check to view the cluster/application
status (see “View Cluster Status Information” (3-35) for details) until
a Running status displays.

Result:

Application status moves from Halted to Starting to Running.
Since the status changes take several minutes to complete, the
status check is performed repeatedly until the required results
display.
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Stop the Navis™ Optical NMS Application on Local
Redundancy Configurations
....................................................................................................................................................................................................................................

Purpose This procedure is used to stop the Navis™ Optical NMS application on
HP servers configured for local redundancy using HP’s MC/Service
Guard cluster administration GUI.

Task Complete these steps to stop the Navis™ Optical NMS application
on HP servers configured for local redundancy using HP’s
MC/Service Guard cluster administration GUI:
............................................................................................................................................................

1 Log into any server in the cluster as root.

............................................................................................................................................................

2 Determine if the package is running on a member of the cluster by
viewing the cluster/application status. Refer to “View Cluster Status
Information” (3-35).

............................................................................................................................................................

3 If the application is running on a member of the cluster, proceed to
the next step to continue.

If the application is not running on a member of the cluster, further
action is not necessary and the task is ended.

............................................................................................................................................................

4 Stop the Navis™ Optical NMS application. See “Stop the Navis™

Optical NMS Application on a Specific Server using SAM” (3-28).

Result:

Navis™ Optical NMS application is stopped.

............................................................................................................................................................

5 Repeatedly perform a status check to view the cluster/application
status (see “View Cluster Status Information” (3-35) for details) until
a Halted status displays.

Result:

Application status moves from Running to Stopping to Halted.
Since the status changes take several minutes to complete, the
status check is performed repeatedly until the required results
display.
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Start the Navis™ Optical NMS Application on a Local
Redundancy Configuration using SAM
....................................................................................................................................................................................................................................

Purpose This procedure is used to start the Navis™ Optical NMS application
on a specific server using the SAM application. This task may be
used, for example, to isolate a problem on the server.

Task Complete these steps to start the Navis™ Optical NMS application
on a specific server.
............................................................................................................................................................

1 Log in to either the primary or the standby server as root.

............................................................................................................................................................

2 Enter sam at the prompt and press Enter.

Result:

The System Administration Manager window is displayed.

............................................................................................................................................................

3 Select Clusters > High Availability Clusters > Package Admin.

............................................................................................................................................................

4 Highlight the ITMHost entry.

............................................................................................................................................................

5 On the pull down menu, select Actions > Start a package > Start a
package on a specific node.

............................................................................................................................................................

6 Check enable package switching.

............................................................................................................................................................

7 Highlight Node entry.

............................................................................................................................................................

8 Select OK.

Result:

The Navis™ Optical NMS application starts on the specific
server.
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Stop the Navis™ Optical NMS Application on a Specific Server
using SAM
....................................................................................................................................................................................................................................

Purpose This procedure is used to stop the Navis™ Optical NMS application on
a specific server using the SAM application.

Task Complete these steps to stop the Navis™ Optical NMS application
on a specific server using SAM:
............................................................................................................................................................

1 Log in to either the primary or the standby server as root.

............................................................................................................................................................

2 Enter sam at the prompt and press Enter.

Result:

The System Administration Manager window is displayed.

............................................................................................................................................................

3 Select Clusters > High Availability Clusters > Package Admin.

............................................................................................................................................................

4 Highlight the ITMHost entry.

............................................................................................................................................................

5 On the pull down menu, select Actions > Halt package.

............................................................................................................................................................

6 At the displayed dialog box, confirm that the package should be
halted.

Result:

The package is stopped.
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Stop the Navis™ Optical NMS Application on a Local
Redundancy Configuration using SAM
....................................................................................................................................................................................................................................

Purpose This procedure is used to stop the Navis™ Optical NMS application on
HP servers configured for local redundancy using the SAM
application.

Task Complete these steps to stop the Navis™ Optical NMS package:
............................................................................................................................................................

1 Log into the cluster as root.

............................................................................................................................................................

2 Enter sam at the prompt and press Enter.

Result:

The System Administration Manager window is displayed.

............................................................................................................................................................

3 From the System Administration Manager window, select Clusters >
High Availability Clusters > Cluster Admin.

............................................................................................................................................................

4 Select ITM Cluster, then select Actions > Shutdown Cluster .

Result:

The shutdown process initiates and eventually displays the
following message unless the message wait for UPS to turn

off power message is printed:
System has halted

OK to turn off power or reset system
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Switch to a Standby Server in a Local Redundancy
Configuration using SAM
....................................................................................................................................................................................................................................

Purpose This procedure is used to switch to a standby server in a local
redundancy configuration using SAM.

Before you begin If package switching is disabled, the application must be started and
switching must be enabled.

Task Complete these steps to switch to a standby server in a local
redundancy configuration configuration:
............................................................................................................................................................

1 Log in to either the primary or the standby machine as root.

............................................................................................................................................................

2 Enter sam at the prompt and press Enter.

Result:

The System Administration Manager window is displayed.

............................................................................................................................................................

3 Select the Clusters option.

............................................................................................................................................................

4 Select the High Availability Clusters option.

............................................................................................................................................................

5 Select the Package Administration option.

............................................................................................................................................................

6 Highlight the ITMHost entry.

............................................................................................................................................................

7 Select the Actions menu.

............................................................................................................................................................

8 Select the Move a Package option.

............................................................................................................................................................

9 Select the Standby Host entry.

............................................................................................................................................................

10 Select OK.
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............................................................................................................................................................

11 Confirm that the system successfully switched over.
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Enable Automatic Package Switching in a Local Redundancy
Configuration using SAM
....................................................................................................................................................................................................................................

Purpose This procedure is used to enable package switching in a local
redundancy configuration using SAM.

Task Complete these steps to enable package switching:
............................................................................................................................................................

1 Using the system console, log into the primary or the standby server
as root.

............................................................................................................................................................

2 Enter sam at the prompt and press Enter.

Result:

The System Administration Manager window is displayed.

............................................................................................................................................................

3 Select the Clusters option.

............................................................................................................................................................

4 Select the High Availability Clusters option.

............................................................................................................................................................

5 Select the Package Administration option.

............................................................................................................................................................

6 Highlight the ITMHost entry.

............................................................................................................................................................

7 From the Actions menu, select Modify Failover Options.

............................................................................................................................................................

8 Change Automatic Switching value to Enable.

............................................................................................................................................................

9 Select OK.

Result:

Package switching is enabled.
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Disable Automatic Package Switching in a Local Redundancy
Configuration using SAM
....................................................................................................................................................................................................................................

Purpose This procedure is used to disable automatic package switching in a
local redundancy configuration using SAM.

Task Complete these steps to disable package switching using SAM:
............................................................................................................................................................

1 Using the system console, log into the primary or the standby server
as root.

............................................................................................................................................................

2 Enter sam at the prompt and press Enter.

Result:

The System Administration Manager window is displayed.

............................................................................................................................................................

3 Select the Clusters option.

............................................................................................................................................................

4 Select the High Availability Clusters option.

............................................................................................................................................................

5 Select the Package Administration option.

............................................................................................................................................................

6 Highlight the ITMHost entry.

............................................................................................................................................................

7 From the Actions menu, select Modify Failover Options.

............................................................................................................................................................

8 Change Automatic Switching value to Disable.

............................................................................................................................................................

9 Select OK.

Result:

Package Switching is disabled.
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Re-add the HP Server to a Cluster in a Local Redundancy
Configuration using SAM
....................................................................................................................................................................................................................................

Purpose This procedure is used to re-add the HP server to a cluster in a local
redundancy configuration using SAM.

Task Complete these steps to re-add the server to the cluster:
............................................................................................................................................................

1 Using the system console, log into either the primary or the standby
server as root.

............................................................................................................................................................

2 Enter sam at the prompt and press Enter.

Result:

The System Administration Manager window is displayed.

............................................................................................................................................................

3 Select Clusters option.

............................................................................................................................................................

4 Select High Availability Clusters option.

............................................................................................................................................................

5 Select Package Administration option.

............................................................................................................................................................

6 Highlight the ITMHost entry.

............................................................................................................................................................

7 From the Actions menu, select Specify node to join the cluster.

............................................................................................................................................................

8 Highlight Host name.

............................................................................................................................................................

9 Select OK.

Result:

Host node joins the cluster.
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View Cluster Status Information
....................................................................................................................................................................................................................................

Purpose This procedure is used to view cluster status information in a local
redundancy configuration.

Task Complete these steps to view the cluster status information:
............................................................................................................................................................

1 Using the system console, log into the primary or the standby server
as root.

............................................................................................................................................................

2 Enter cmviewcl -v.

Result:

The cluster status information is displayed.

Section V: Local Redundancy Configuration System Administration

....................................................................................................................................................................................................................................

365-309-264R7.0
Issue 1, July 2002

Lucent Technologies 3 - 3 5

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Section VI: Restart and Stop the Oracle Database

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to restart and stop the Oracle database.

Definition: Oracle database The Oracle database is used to retain persistent copies of application
and customer data. Use of Oracle’s Transaction Processing Option
enables concurrency control and a high degree of data integrity.

Important Starting and stopping the database should be performed only at the
direction of Lucent Customer Support.
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Restart the Oracle Database
....................................................................................................................................................................................................................................

Purpose This procedure is used to restart the Oracle database.

Important! This procedure should be performed only with the
direction of Lucent Customer Support.

Task Complete these steps to restart the Oracle database:
............................................................................................................................................................

1 Using the system console, log in as oracle.

............................................................................................................................................................

2 Enter /usr/dacscan/toolbin/startdb.sh at the prompt.

Result:

A message is displayed on the form to indicate that the database
has been started.
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Stop the Oracle Database
....................................................................................................................................................................................................................................

Purpose This procedure is used to stop the Oracle database, which would need
to occur, for example, before backing up the Oracle database.

Important! This procedure should be performed only with the
direction of Lucent Customer Support.

Task Complete these steps to stop the Oracle database:
............................................................................................................................................................

1 Using the system console, log in as oracle.

............................................................................................................................................................

2 Stop the application on the primary server.

Reference:

For instructions, see the section “Stop the Navis™ Optical NMS
Application on a Desktop” (3-14), earlier in this chapter.

............................................................................................................................................................

3 Enter /usr/dacscan/toolbin/shutdb.sh at the prompt.

Result:

A message is displayed on the form and indicates that the
database has been stopped.
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Section VII: Administer the System cron File

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to administer the system cron file.

Background The cron file contains commands that are automatically executed at
set times.

Certain commands can be executed at desired times by using the
system cron. The root cron and dacscan cron operate independently.
The root cron has various administrative functions that are executed
on a routine basis, such as daily backups and file system space
monitoring. The dacscan cron has various application-related
functions, such as database syncs and auto-implementation.

File format The read-only root cron file format is such that everything on the
active line is separated by blanks or tabs. Each field of the active line
correlates to a subset of time. The following is an example of an
active line, with each field separated by a tab (indicated by -->):

min-->hour-->day-->month-->day-of-week-->command min: 0-59
hour: 0-23 day:1-31 month:1-12 day of week: 0-6 (Sunday=0)
command: program to be executed

In place of numerics, an asterisk (*) may be used to imply the whole
range (wild card). A sample active line may look like:

01 04,23 * * * ksh /usr/dacscan/bin/auto_backup &

This line implies that the auto_backup will execute in the background
one minute past the 4th hour (4:01 a.m.) and, again, one minute past
the 23rd hour (11:01 p.m.), every day, every month and every day of
the week.

The cron files can be edited; however, editing should be performed
only at the direction of Lucent Customer Support. Once the file is
created/edited, it must be loaded into the cron.
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Edit the System cron File 3-43
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View the dacscan cron File
....................................................................................................................................................................................................................................

Purpose This procedure is used to view the dacscan cron file.

Important! The dacscan cron file is a read-only file. It can only
be edited by the superuser (root user).

Task Complete these steps to view the dacscan cron file:
............................................................................................................................................................

1 Using the system console, log into the primary server as dacscan.

Important! Using the root login, you can alternatively enter su
- dacscan and enter the dacscan password.

............................................................................................................................................................

2 Enter crontab -l at the # prompt.

............................................................................................................................................................

3 Press Enter.

Result:

The dacscan cron file is displayed.
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View the root cron File
....................................................................................................................................................................................................................................

Purpose This procedure is used to view the root cron file.

Important! The root cron file is a read-only file. It can only be
edited by the superuser (root user).

Task Complete these steps to view the root cron file:
............................................................................................................................................................

1 Using the system console, log into the primary server as root.

............................................................................................................................................................

2 Enter crontab -l at the # prompt.

............................................................................................................................................................

3 Press Enter.

Result:

The root cron file is displayed.
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Edit the System cron File
....................................................................................................................................................................................................................................

Purpose This procedure is used to change the desired execution times of
commands in the system cron file.

Before you begin Important! The system cron file can only be edited by the
superuser (root user).

In this procedure, you will be required to edit a file. To avoid losing
data, consider making a copy of this file before editing. If you choose
to copy this file, remember to delete it from the system when you are
finished editing.

Task Complete these steps to edit the system cron file:
............................................................................................................................................................

1 Using the system console, log into the primary server as root.

............................................................................................................................................................

2 At the # prompt, type cd /usr/spool/cron/crontabs.

............................................................................................................................................................

3 At the # prompt, type ls -l.

Result:

The files root and dacscan are listed.

............................................................................................................................................................

4 Open the root or dacscan file using the vi editor and edit the
required parameter.

............................................................................................................................................................

5 Press Esc, and then type :wq to save and close the file.

..........................................................................................................................................................

6 Use one of the following to read the revised file into the system cron.

IF THEN

the root file was edited log in as root and then type: crontab
root at the # prompt.

Result: The root file is read into the
system cron.
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IF THEN

the dacscan file was edited log in as dacscan and type crontab
dacscan at the # prompt.

Result: The dacscan file is read
into the system cron.
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Section VIII: Monitor Space

Overview
....................................................................................................................................................................................................................................

Purpose Navis™ Optical NMS has an internal, space monitoring script that
periodically checks its own filesystems to verify that they are not
running out of space. The following section describes the Navis™

Optical NMS script that produces warning and recovery messages as
required.
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Monitor Space
....................................................................................................................................................................................................................................

Definition: Spacewatch
program

Spacewatch is a space monitoring and recovery program that provides
file-system monitoring once per hour for the following controller files:

• Provisioning documents directory (/dacscan/prov)

• Alarms directory (/dacscan/alarms)

• Application logs directory (/dacscan/log)

• Database archives directory (/dacscan/dbarch)

• Application users directory (/dacscan/users)

• Application trace information directory (/dacscan/trace)

Spacewatch executes according to the parameters defined in the root
cron file. These parameters should not be changed.

Warning messages If the dacscan/log file is over 60% full, Spacewatch sends this
warning message to the system event log: LOG_FILESYSTEM_SPACE_
LOW.

Recovery
actions/messages

Special recovery actions/messages are provided for the following files:

• If /dacscan/trace is over 80% full, its recovery action is:
Removed log files - Archives may be incomplete!

• If dacscan/log is over 80% full, its recovery action is: Removed
log files - Archives may be incomplete!

• If dacscan/users is over 80% full, its recovery message is:
″Logfile″ is running low on space, clean up

immediately!

• The dacscan/dbarch controller file recovery message is:
″Logfile″ removed database archive file - back up

database immediately!
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Section IX: Administer Performance Monitoring Data Export

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to administer the Performance Monitoring
Data Export feature via off-line tools.

Performance Monitoring Data Export is an optional feature that
enables the automatic capture of all 24-hour performance monitoring
data for all network elements controlled by the Navis™ Optical NMS
and the ITM-SC applications. During execution, it requests that all
24-hour performance monitoring data collected for the previous day
be transferred to an ASCII file—one per Element Management System
(EMS)—on a workstation or PC specified at the time of installation.

Contents
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Variable Settings

3-49

Change the Scheduled Run Time of the
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3-50
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Performance Monitoring Data Export Variables
....................................................................................................................................................................................................................................

Overview The Performance Monitoring Data Export feature executes according
to the values specified by certain environment variables that control
how this feature operates:

• $PM_LOG_WKST is a variable that exists on the server. It is the
workstation to which performance monitoring data is exported.

• $PM_LOG_DIR is a variable that exists on the server. It is the
directory on the $PM_LOG_WKST workstation where the
exported data is stored. In this directory, the user must create one
subdirectory for each day of the week, plus yesterday: Monday,
Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday, and
yesterday.

• $PM_DATA_FILE is variable file on the $PM_LOG_WKST
workstation that contains the exported performance monitoring
data.

• $PM_DATA_FILE_DIR is the directory on the server that
contains the request files. One request file must be created for
each EMS, based on the $PM_DATA_FILE environment
variable and the EMS name.

• $PM_EMS_TIMEOUT is the duration (in seconds) that is
allocated to the EMS to collect and export the requested data.
When this duration expires, a time-out error is logged.

For example, given these environment variables, the most recently
transferred performance monitoring data file is located at:

$PM_LOG_WKST:$PM_LOG_DIR/<yesterday>/$PM_DATA_FILE

The $PM_LOG_WKST and the $PM_LOG_DIR variables are located
on the server in the /etc/dscan directory. Their values are set at
installation. The remaining variables, ($PM_DATA_FILE ,
$PM_DATA_FILE_DIR and $PM_DATA_TIMEOUT ) are set up
when the export tool is run.
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Display Performance Monitoring Data Export Variable Settings
....................................................................................................................................................................................................................................

Purpose This procedure is used to display Performance Monitoring Data
Export variable settings.

Task Complete these steps to display Performance Monitoring Data
Export variable settings:
............................................................................................................................................................

1 From a workstation, log in as dacscan.

............................................................................................................................................................

2 To display Performance Monitoring Data Export variable settings,
enter one of the following at the prompt.

• To display all variable settings, type env.

• To display a specific variable’s setting, type
echo <$variable_name>.

Result:

The variable settings are displayed.
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Change the Scheduled Run Time of the Performance Monitoring
Data Export File Transfer
....................................................................................................................................................................................................................................

Purpose This procedure is used to change the scheduled run time of the
Performance Monitoring Data Export file transfer.

The Performance Monitoring Data Export file transfer process is
scheduled to run daily. By default, it is scheduled to run at 02:10 a.m.
local time.

Before you begin Important! This task should be performed only at the direction
of Lucent Customer Support.

In this procedure, you will be required to edit a file. To avoid losing
data, consider making a copy of this file before editing. If you choose
to copy this file, remember to delete it from the system when you are
finished editing.

Task Use these steps to change the scheduled run time of the
Performance Monitoring Data Export file transfer process.
............................................................................................................................................................

1 Log into the host as dacscan.

............................................................................................................................................................

2 Enter crontab -e.

............................................................................................................................................................

3 Locate the following line in the file, which is used to clean up the old
files and start the PM log file process:

mm hh * * * ksh /usr/dacscan/toolbin/StartPmData.sh >

/tmp/StartPmData.log

............................................................................................................................................................

4 Edit the mm and hh entries so they correspond with the required hour
(hh) and minute (mm).

............................................................................................................................................................

5 Enter <shift:wq!>.

Result:

The scheduled run time of the performance monitoring data file
transfer process is changed.
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Workstation Set Up for Data Export Task
....................................................................................................................................................................................................................................

Purpose This procedure is used to set up the workstation for PM data export to
monitor reports.

Before you begin Ensure that a dacscan login ID does not already exist on the
workstation.

You must access and edit the .rhosts file, which is typically located
in /usr/dacscan/.rhosts. (Under most conditions, the .rhosts file
does not have to be created or re-created.) To avoid losing data,
consider making a copy of this file before editing. If you choose to
copy this file, remember to delete it from the system when you are
finished editing.

In step 5, you must create a directory structure that can be used to
store data for each day of the week along with one subdirectory as a
backup yesterday directory. The access privileges for these directories
must be changed so their contents can be read by and written to by
the owner, group, and other.

Example:

cd /usr/dacscan

mkdir pm_export (This directory name is user specified; any
directory name can be assigned to the directory; however, the same
directory name must exist on the server.)

chmod 777 pm_export (Change the permissions on the directory just
created so it is accessible to all.)

cd pm_export (Change directories to the directory that you just
created.)

mkdir Monday (Make a subdirectory under pm_export called
Monday.)

chmod 777 Monday (Change the permissions of the directory
Monday so it is accessible to all.)

mkdir Tuesday (Make another subdirectory under pm_export called
Tuesday.)

chmod 777 Tuesday (Change the permissions of the directory
Tuesday so it is accessible to all.)
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Continue to make directories for each remaining day of the week,
along with a directory called yesterday, and change the access
privileges for each directory created.

You need write permissions for step 6.

Task Use these steps to create a dacscan login ID and to modify the
.rhosts file:
............................................................................................................................................................

1 Create a dacscan login ID.

............................................................................................................................................................

2 From a new terminal window on that workstation, log in as the
dacscan user.

............................................................................................................................................................

3 Enter cd $HOME.

............................................................................................................................................................

4 Using vi, access the .rhosts files and add a line to the file with the
name of the host machine where PF and performance monitoring
servers are running for the Navis™ Optical NMS application.

............................................................................................................................................................

5 On the workstation, set up a directory structure for storing PM data.
(See Before you begin.)

............................................................................................................................................................

6 Log into the Navis™ Optical NMS host server as dacscan.

............................................................................................................................................................

7 Enter remsh <name of Workstation> uname -a to test whether the
.rhosts file works correctly.

Result:

The name and operating system of the workstation are
displayed.
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Execute the PM Data Export Tool
....................................................................................................................................................................................................................................

Purpose This procedure is used to view relevant log information or the current
environment associated with the Performance Monitoring (PM) Data
Export tool, or to reissue the request to transfer the 24-hour
performance monitoring data associated with the previous day.

Related Information The Performance Monitoring Data Export tool allows a host user to
view relevant log information and to view the current environment
associated with this feature. It provides the means for a host user to
reissue the request to transfer 24-hour performance monitoring data
associated with the previous day.

Any user can access the Performance Monitoring Data Export tool
from the host server. It is located in /usr/dacscan/toolbin.

Task Use these steps to execute the Performance Monitoring Data
Export.
............................................................................................................................................................

1 From the system prompt, enter:

/usr/dacscan/toolbin/pm_export_tool.

Result:

A user menu is displayed.

..........................................................................................................................................................

2 IF THEN

You want to display the
Performance Monitoring
Data Export feature
overview

Enter 1

You want to display the
Performance Monitoring
Data Export feature
environment

Enter 2

You want to view the
Performance Monitoring
Data Export log entries for
mm/dd/yyyy

Enter 3
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IF THEN

You want to reissue the
request to export 24-hour
performance monitoring
data

(An option does not exist
to issue a request on an
individual EMS basis.)

Enter 4

You want to quit executing
the Performance
Monitoring Data Export
tool.

Enter 5

Result: Relevant log files are
created and are located in
/usr/dacscan/toolbin.

On a dedicated UNIX workstation,
uncompress the Performance
Monitoring Data Export files by
entering the command gunzip -c
<filename>
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Section X: Network Map

Overview
....................................................................................................................................................................................................................................

Purpose This section contains tasks associated with the Network Map,
including tasks associated with Network elements, Out-of-Domain
Objects (ODOs), changing the background map, and changing model
names.

Contents
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Install a New Background Map
....................................................................................................................................................................................................................................

Purpose This procedure is used to install a new background map on HP-UX
client machines or on Windows terminal servers.

The system administrator of the host will use an off-line hardware,
(such as a scanner) to scan the customer’s map and save it onto the
host machine as a .gif file. This map can be an image (.gif) file
scanned by the user and stored in the $DEST/jnm/itm/data/customer
directory of the host server.

If you need assistance with performing this task, contact Lucent
Customer Support.

Choosing a background
map

A new background map must be selected carefully so that it does not
obscure the icons and its displayed text. For example, a map that is
largely white hides the white text of the icon names.

When selecting a background map, keep the following in mind:

• Select a map that is mainly of a different color than the icons
and text displayed on the map.

• Select a map that includes colors that contrast sufficiently with
the icons and text displayed on the map so that they are easily
distinguished by the user.

Task Complete this step to install a new background map for all users:
............................................................................................................................................................

1 Contact Lucent Customer Support to perform this task.

Section X: Network Map System Administration

....................................................................................................................................................................................................................................

3 - 5 6 Lucent Technologies 365-309-264R7.0
Issue 1, July 2002

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Update Network Element and ODO Positions
....................................................................................................................................................................................................................................

Purpose Use the following procedure to update network element and
Out-of-Domain (ODO) positions on the Network Map.

Before you begin You must have Configuration management, Element Management,
or system administrator privileges to permit you to save the updated
network element and ODO positions on the Network Map. See
“Navis™ Optical NMS system administrator user types” (1-3) for a
description of what is allowable for system administrator users.

Task Complete these steps to permanently move a node or an ODO to
a new position on the Network Map:
............................................................................................................................................................

1 On the Network Map, select the node or ODO you want to reposition.

............................................................................................................................................................

2 Drag and drop the node or ODO to the new location.

Result:

The node or ODO and its connecting links are repositioned.

............................................................................................................................................................

3 Select the following menu option: File > Save Node and Label Map
Positions.

Result:

The network element or ODO location is updated.

Section X: Network Map System Administration

....................................................................................................................................................................................................................................

365-309-264R7.0
Issue 1, July 2002

Lucent Technologies 3 - 5 7

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Search the Location Reference Table
....................................................................................................................................................................................................................................

Purpose This procedure is used to search for location-type information for a
specific network element. The user may query by Office/Location/NE
ID, Area, or Node Type, or request a list of all location-type
information.

Network element queries display controlled or noncontrolled network
elements. Controlled network elements are those controlled or
cataloged by Navis™ Optical NMS. Noncontrolled network elements
include black boxes and ODOs.

Results received from controlled network element queries include
information about the digital cross-connect systems that are part of the
network.

Important! This search is limited to NEs that are controlled or
cataloged by the Navis™ Optical NMS application.

Task Complete these steps to search for location-type information for a
specific network element:
............................................................................................................................................................

1 On the Network Map, select Administration.

............................................................................................................................................................

2 Select Location Reference Table.

Result:

The Location Reference Table Query Box is displayed.

..........................................................................................................................................................

3 IF THEN

You want to query by
office location or network
element ID,

Enter the office location or network
element ID in the Office Location/NE
ID field.

You want to query by area
ID,

Select a value from the Area
drop-down list.

You want to query by node
type,

Select a value from the Node Type
drop-down list.

Section X: Network Map System Administration
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IF THEN

You want to query all
available location-type
information,

Leave all fields blank, then proceed to
the last step.

............................................................................................................................................................

4 Optional: Complete the Additional Information field.

............................................................................................................................................................

5 Select OK.

Result:

The Location Reference Table displays the requested
location-type information.

When the value ITMNM displays in the Type field, this represents
Navis™ Optical NMS. When SNMS displays in the Type field, this
represents Navis™ Optical EMS.

Section X: Network Map
Search the Location Reference Table
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Modify Noncontrolled Network Element Information
....................................................................................................................................................................................................................................

Purpose This procedure is used to modify the description or administration
information of an existing noncontrolled network element, including
black boxes and ODOs.

Task Complete these steps to modify the description or administrative
information of a noncontrolled network element:
............................................................................................................................................................

1 From the Network Map, select Administration > Location Reference
Table.

Result:

The Location Reference Table Query Box is displayed.

............................................................................................................................................................

2 In the Office Location/NE ID field, enter the appropriate existing
noncontrolled network elements.

............................................................................................................................................................

3 Optional: In the Additional Information field, enter any additional
information.

............................................................................................................................................................

4 Optional: Select the Area associated with the noncontrolled network
element from the drop-down menu.

............................................................................................................................................................

5 Optional: Select the Node Type associated with the noncontrolled
network element from the drop-down menu.

............................................................................................................................................................

6 Click OK.

Result:

The Location Reference Table is displayed.

When the value ITMNM displays in the Type field, this represents
Navis™ Optical NMS. When SNMS displays in the Type field, this
represents Navis™ Optical EMS.

Section X: Network Map System Administration
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............................................................................................................................................................

7 To modify the information, either click the first box in a row to select
the row or click a box in a specific column to modify the information.
You may modify rows in the following columns:

• Description

• Acronym

• Additional Information

............................................................................................................................................................

8 Select Actions > Update.

............................................................................................................................................................

9 Select File > Close.

Result:

The description or administration information of the
noncontrolled network element is modified.

Section X: Network Map
Modify Noncontrolled Network Element
Information
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Change the Model Name of a Network Element
....................................................................................................................................................................................................................................

Purpose This procedure is used to change a model name of a network element.

Task Complete these steps to change a model name of a network
element:
............................................................................................................................................................

1 Delete the network element that has a model name to be changed. See
the Navis™ Optical Network Management System Provisioning
Guide for details.

Result:

The network element is deleted.

............................................................................................................................................................

2 Add the network element and enter the new model name. See the
Navis™ Optical NMS Provisioning Guide for details.

Important! Navis™ Optical EMS network elements do not need
to be re-added because they are automatically discovered by
Navis™ Optical NMS.

Result:

The network element is added and contains a new model name.
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Section XI: Administer the TIM Northbound Interface

Overview
....................................................................................................................................................................................................................................

Purpose This section explains how to set filtering criteria for Navis™ Optical
NMS alarms to be sent to the TMN Integration Module (TIM)
northbound Alarm Interface, which is an optional feature.

Contents
Set Filtering Criteria for Navis™ Optical NMS
Alarms

3-64
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Set Filtering Criteria for Navis™ Optical NMS Alarms
....................................................................................................................................................................................................................................

Purpose This procedure is used to set filtering criteria for Navis™ Optical NMS
alarms to be sent to the TIM northbound alarm interface.

Task Complete these steps to set filtering criteria for Navis™ Optical
NMS alarms:
............................................................................................................................................................

1 Start the Navis™ Optical NMS application.

Reference:

For instructions, see the section “Start the Navis™ Optical NMS
Application on an HP-UX Workstation” (3-11), earlier in this
chapter.

............................................................................................................................................................

2 On the Network Map, select Administration > NB Transmission
Filter.

Result:

The Alarm Transmission Filter form is displayed.

............................................................................................................................................................

3 To send service-affecting and non-service affecting alarms to the TIM
northbound alarm interface, select Both then click OK.

To send only service-affecting alarms to the TIM northbound alarm
interface, select SA then click OK.

Result:

The appropriate alarms are sent to the TIM northbound alarm
interface.

Section XI: Administer the TIM Northbound
Interface

System Administration

....................................................................................................................................................................................................................................

3 - 6 4 Lucent Technologies 365-309-264R7.0
Issue 1, July 2002

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Section XII: Set Preferences

Overview
....................................................................................................................................................................................................................................

Purpose This section defines how to set preferences in Navis™ Optical NMS.

Contents
Set Event Indications Preferences 3-66

Set Map Preferences 3-67

Set Alarm Preferences 3-68

Set Fault Management (FM) Operational
Preferences

3-69

Set Port Address Preferences 3-71
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Set Event Indications Preferences
....................................................................................................................................................................................................................................

Purpose This procedure is used to set event indications preferences for the
Network Event Summary.

Task Complete these steps to set event indications preferences:
............................................................................................................................................................

1 On the Network Map, select Administration > Preferences.

Result:

The Preferences form is displayed.

............................................................................................................................................................

2 Select the Event Indications tab.

Result:

The Event Indications form displays.

..........................................................................................................................................................

3 IF THEN

You want to set an audible
beep when a new alarm is
reported.

Select Set Beep On, then select the
number of beeps to sound when a new
alarm is reported.

You want to set the Event
form to display in the
foreground.

Select Set Event Screen to Foreground.

............................................................................................................................................................

4 Select OK.

Result:

The form closes. Changes to the event indications take effect
during the next and subsequent sessions.
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Set Map Preferences
....................................................................................................................................................................................................................................

Purpose This procedure is used to set map preferences.

Task Complete these steps to set map preferences:
............................................................................................................................................................

1 On the Network Map, select Administration > Preferences.

Result:

The Preferences form is displayed.

............................................................................................................................................................

2 Select the Map tab.

Result:

The Map form displays the User Login View and Link Width
sections.

..........................................................................................................................................................

3 IF THEN

You want to select a
different map view,

In the User Login View section’s Map
View field, highlight an entry in the
drop down list.

Important! System Area Map is the
default.

You want to specify area or
select no area,

In the User Login View section’s
Expand Area field, highlight an entry
in the drop down list.

You want to change the
Network Map’s link width
display,

In the Link Width section of the form,
select Normal to have links display at
a normal width or Heavy to have links
display at a wide width.

............................................................................................................................................................

4 Select OK.

Result:

The form closes. Changes to the map take effect during the next
and subsequent sessions.

Section XII: Set Preferences System Administration

....................................................................................................................................................................................................................................

365-309-264R7.0
Issue 1, July 2002

Lucent Technologies 3 - 6 7

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Set Alarm Preferences
....................................................................................................................................................................................................................................

Purpose This procedure is used to set alarm preferences on forms.

Task Complete these steps to set alarm preferences on forms:
............................................................................................................................................................

1 On the Network Map, select Administration > Preferences.

Result:

The Preferences form is displayed.

............................................................................................................................................................

2 Select the Alarm Information On Forms tab.

Result:

The Alarm Information on Forms form displays.

............................................................................................................................................................

3 Click each box corresponding to the form to be changed.

Result:

Each selected box is marked.

............................................................................................................................................................

4 Select OK.

Result:

The form closes.

............................................................................................................................................................

5 Close and restart the Navis™ Optical NMS application.

Result:

Changes to the alarm preferences take effect during the next and
subsequent sessions.
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Set Fault Management (FM) Operational Preferences
....................................................................................................................................................................................................................................

Purpose This procedure is used to set FM operational preferences.

Task Complete these steps to set FM operational preferences:
............................................................................................................................................................

1 On the Network Map, select Administration > Preferences.

Result:

The Preferences form is displayed.

............................................................................................................................................................

2 Select the FM Operational Mode tab.

Result:

The Fault Management Operational Mode form displays.

..........................................................................................................................................................

3 IF THEN

You want to set fault
management to use the
alarm approach,

Select Alarm Approach.

You want to set fault
management to use the
service approach,

Select Service Approach.

............................................................................................................................................................

4 Select OK.

Result:

An Attention dialog box displays indicating that the change will
take effect for the next and subsequent sessions.

............................................................................................................................................................

5 On the Attention dialog box. select OK.

Result:

The dialog box closes.

............................................................................................................................................................

6 On the Fault Management Operational Mode form, select OK.
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Result:

The Fault Management Operational Mode form closes.

Section XII: Set Preferences
Set Fault Management (FM) Operational
Preferences
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Set Port Address Preferences
....................................................................................................................................................................................................................................

Purpose This procedure is used to set port address preferences.

Important! The Port Address tab only displays if the Port
Aliasing feature is enabled during installation. If you have any
questions, contact Lucent Customer Support.

Task Complete these steps to set port address preferences:
............................................................................................................................................................

1 On the Network Map, select Administration > Preferences.

Result:

The Preferences form is displayed.

............................................................................................................................................................

2 Select the Port Address tab.

Result:

The Default Port Address form displays.

..........................................................................................................................................................

3 IF THEN

you want the port address
to default to a
customer-specific selection,

select the customer-specific button.

you want the port address
to default to network
management,

select Network Mgt.

............................................................................................................................................................

4 Select OK.

Result:

An Attention dialog box displays indicating that the change will
take effect for the next and subsequent sessions.

............................................................................................................................................................

5 On the Attention dialog box, select OK.

Result:

The dialog box closes.
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............................................................................................................................................................

6 On the Default Port Address form, select OK.

Result:

The Default Port Address form closes.

Section XII: Set Preferences
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4 Users and User Profiles

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides the conceptual information needed to understand
the administration of users on the Navis™ Optical NMS application’s
hardware platform and on the application itself and the tasks that are
needed to administer users in both the platform and application
environments.

Contents
User and User Profile Concepts 4-3

Create a User ID through the SAM GUI-Based
Program

4-6

Create a User ID through the SAM Terminal-Based
Program

4-10

Assign User Privileges to a User on a Windows PC 4-14

Assign User Privileges to a User on a Windows
2000 PC

4-16

Assign System Administrator Privileges to an
Administrator on a Windows PC

4-18

Add a User on an HP Server 4-20

Set up a User ID for Cut-Through to Navis™

Optical EMS
4-21

Add a User in the Application 4-22
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Modify a User in the Application 4-24

Delete a User in the Application 4-26

Add a User Profile in the Application 4-27

Modify a User Profile in the Application 4-28

Delete a User Profile in the Application 4-30

Add a User to a SAGE Workstation 4-31

Delete a User from a SAGE Workstation 4-33

Overview Users and User Profiles
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User and User Profile Concepts
....................................................................................................................................................................................................................................

The basics of user
administration

The users of Navis™ Optical NMS application are of two basic types:

• The users of Navis™ Optical NMS application are typically those
people who provision the application through the application’s
GUI.

• The system administrators of Navis™ Optical NMS application
are typically those people who administer and/or maintain the
health of the application for the users. System administrators are
often given access privileges that are denied to users.

User administration involves completing tasks on the hardware
platform that the Navis™ Optical NMS runs on and on the application
itself for both users and system administrators. Specifically, these
tasks include the following:

• creating user IDs through HP’s System Administration Manager
(SAM) GUI-based or terminal-based program and assigning
specific privileges to regular users and to system administrators
on a Windows desktops
Note: Users do not have to be added to HP servers because any
needed user IDs are loaded with the software.

• adding, modifying, and deleting user IDs and user profiles on the
application

• optionally adding or deleting Secure Access Gateway for
Enterprises (SAGE) users to/from an HP-UX client workstation

The default administrator The Navis™ Optical NMS has a default administrator login that is
called sa. This login is used by the initial user to do start-up tasks.
This initial user has access to all Navis™ Optical NMS screens,
including those screens that are needed to add other new users.

Users who are created by sa are typically set up with access to only a
subset of Navis™ Optical NMS screens. Therefore, to become
authorized, a user has to already have the correct permissions to
access these Navis™ Optical NMS screens or to have the sa change
his or her permissions.

Users and User Profiles
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User types and user
profile

The Navis™ Optical NMS application allows authorized users to have
different levels of access, which are controlled by a login ID, a
password, a user type, and a user profile.

The Navis™ Optical NMS User is the user who has access to the
Navis™ Optical NMS application. By default, this user is of the type
that is called regular user.

A user profile controls which task groupings a user can access. A user
can be assigned to more than one user profile.

The Navis™ Optical NMS offers the following user profiles:

• The Initial profile provides access to the Fault Management,
Configuration Management, Performance Monitoring, Preplan
Management, and NE Management task groupings. By default,
all new users are assigned to the Initial Profile.

• The Combined profile provides access to the All Tasks task
grouping, which includes the Fault Management, Configuration
Management, Performance Monitoring, Preplan Management, NE
Management, System Administrator, Fault Management (View
only), Configuration Management (View only), Performance
Monitoring (View only), Preplan Management (View only), and
the Geo Domain Administrator and the Service Domain
Administrator task groupings.

• The Provisioning (View Only) profile provides access to the
Configuration Management (View Only) task grouping.

• The Alarm Management profile provides access to the Fault
Management task grouping.

• The Geo Domain User profile provides access to all groups that
are included in the Initial profile, which include the Fault
Management, Configuration Management, Performance
Monitoring, Preplan Management, and NE Management task
groupings. Note that the Geographic Domain Partitioning is an
optional feature. Refer to Chapter 5, “Geographic Domain
Partitioning”.

User and User Profile Concepts Users and User Profiles
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• The Service Domain User profile provides access to the Fault
Management, Configuration Management, Performance
Monitoring, and Preplan Management task groupings. Note that
the Service Domain Partitioning is an optional feature. Refer to
Chapter 6, “Service Domain Partitioning”.

• The External CM User profile provides access to the
Configuration Management task grouping.

While each profile has a finite number of assigned tasks, the system
administrator can select which tasks to associate with a particular
profile.

In addition to the user profiles listed, the system administrator can add
a new profile, or modify or delete an existing profile. The Initial
Profile can never be deleted and the Combined Default Profile cannot
be modified or deleted.

SAGE Desktop Integration SAGE Desktop Integration is an optional feature for NMS
applications that allows users to access multiple Navis™ Optical NMS
systems through a web browser.

The system administrator can add or delete SAGE users to/from an
HP-UX client workstation.

Since SAGE requires each user to have an individual profile, the
system administrator needs to manage these, along with user logins
and passwords. The administrator needs to teach users how to log into
SAGE, how to change passwords, how to modify user attributes, and
how to interpret and respond to system messages.

For more detailed system administration instructions, refer to the
Secure Access Gateway for Enterprises (SAGE) Administration Guide.

User and User Profile Concepts Users and User Profiles
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Create a User ID through the SAM GUI-Based Program
....................................................................................................................................................................................................................................

Purpose This procedure is used to create a user ID for the application through
the GUI-based version of the SAM program using an HP-UX
workstation.

Task Complete these steps to create a user ID for the application
through SAM using an HP-UX workstation:
............................................................................................................................................................

1 Log into the workstation as root.

............................................................................................................................................................

2 On the Common Desktop Environment (CDE) panel (at the bottom of
the screen), select the terminal icon to open a dtterm window.

Result:

A dtterm window displays.

............................................................................................................................................................

3 Enter sam at the prompt and press Enter.

Result:

The System Administration Manager window is displayed.

............................................................................................................................................................

4 Double click the Accounts for Users and Groups icon.

Result:

The System Administration Manager form redisplays with
Groups and Local Users icons.

............................................................................................................................................................

5 Double click the Local Users icon.

Result:

The Accounts for Users and Groups form displays.

............................................................................................................................................................

6 Select Actions > Add.

Result:

The Add a User Account form displays.

Users and User Profiles
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............................................................................................................................................................

7 In the Login Name field, enter a value of up to 8 characters
representing the ID (such as the person’s abbreviated name).

Important! The valid characters allowed in the ID are lowercase
letters (a to z), numbers (0 to 9), and one or more underscores
(_). The first character must be a lowercase letter. The
underscores may be in any position after the first.

Result:

The Home directory field displays the directory path, which
includes the Login Name field’s value, such as
/home/<login_name>.

............................................................................................................................................................

8 At the Create Home directory field, select the box.

Important! The Create Home Directory box must be selected in
order to successfully add the user. If this box is not checked, a
corruption may occur in the /etc/passwd file that causes the
computer to boot up in single user mode.

............................................................................................................................................................

9 In the Primary Group Name field, enter dba or users.

Important! In most cases, dba is selected. User IDs within the
users group may be restricted from performing certain functions.

............................................................................................................................................................

10 In the Start-up Program field, enter /usr/bin/ksh.

Important! The remaining information is optional.

............................................................................................................................................................

11 Optional: Complete the remaining fields then select the Set Passwords
Options button.

Result:

The Password Options form is displayed.

............................................................................................................................................................

12 At the Password Options field, choose an option from the list then
select OK.

Create a User ID through the SAM
GUI-Based Program
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Result:

The Password Options form closes and the Add a User Account
window redisplays.

............................................................................................................................................................

13 Select OK to continue.

Result:

The Set User Password dialog box is displayed.

............................................................................................................................................................

14 Enter a password for the user ID, then click OK.

Result:

A verification message displays.

............................................................................................................................................................

15 Re-enter a password for the user ID, then click OK.

Result:

A Note dialog box displays a message that the user ID has been
added.

............................................................................................................................................................

16 On the Note dialog box, click OK.

Result:

The Note dialog box closes.

............................................................................................................................................................

17 To exit the Add a User Account form, select File > Exit.

Result:

The Accounts for Users and Groups form displays the new user
ID.

............................................................................................................................................................

18 To exit the Accounts for Users and Groups form, select File > Exit
SAM.

............................................................................................................................................................

19 At the prompt, type cat /etc/passwd | pg then view the display to
determine if permissions have been properly set for the created user
ID in the passwd file.

Create a User ID through the SAM
GUI-Based Program
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............................................................................................................................................................

20 For each user entered in the Login Name field in Step 7 of this task,
use the “Add a User in the Application” (4-22) task to add the user to
the Navis™ Optical NMS application.

Important! If this new user ID is to be used for cut-through
access to an EMS, the user ID must be added through the EMS
GUI. See “Set up a User ID for Cut-Through to Navis™ Optical
EMS” (4-21) for details.

Create a User ID through the SAM
GUI-Based Program
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Create a User ID through the SAM Terminal-Based Program
....................................................................................................................................................................................................................................

Purpose This procedure is used to create an application user ID through the
terminal (non-GUI) version of the SAM program, which may be
accessed through a telnet session.

Task Complete these steps to create an application user ID by
accessing SAM through a telnet session:
............................................................................................................................................................

1 Log into a workstation.

............................................................................................................................................................

2 Click the Start button in the taskbar, then select Run.

Result:

The Run dialog box displays.

............................................................................................................................................................

3 In the Open field of the Run dialog box, enter the following:

telnet <ip_address_or_hostname>

............................................................................................................................................................

4 On the host server that contains the SAM program, log in as root.

............................................................................................................................................................

5 At the prompt, type sam and press Enter.

Result:

A message indicates that the terminal version of sam is started.

............................................................................................................................................................

6 At the highlighted Accounts for Users and Groups selection, press
Enter.

Result:

A menu of User and Group options is displayed.

............................................................................................................................................................

7 Using the down arrow key, highlight the Users item and press Enter.

Result:

The Accounts for Users and Groups form is displayed.

Users and User Profiles
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............................................................................................................................................................

8 Using the Tab and arrow keys, scroll to the Actions menu selection,
then press Enter.

Result:

The Actions menu is displayed.

............................................................................................................................................................

9 At the highlighted Add entry, press Enter.

Result:

The Add a User Account form is displayed.

............................................................................................................................................................

10 In the Login Name field, enter a value of up to 8 characters
representing the ID (such as the person’s abbreviated name) and press
Enter.

Important! The valid characters allowed in the ID are lowercase
letters (a to z), numbers (0 to 9), and one or more underscores
(_). The first character must be a lowercase letter. The
underscores may be in any position after the first.

Result:

The cursor bypasses the User ID (UID) field, which is already
populated with a system-generated entry. The Home directory
field displays the directory path, which includes the Login Name
field’s value, such as /home/<login_name>.

............................................................................................................................................................

11 Use the Tab to move to Create Home Directory, then press Enter if
X is not displayed in the box.

Important! The Create Home Directory box must be checked in
order to successfully add the user. If this box is not checked, a
corruption may occur in the /etc/passwd file that causes the
computer to boot up in single user mode.

............................................................................................................................................................

12 Use the Tab to move to the Primary Group Name field, type dba or
users, and press Enter.

Important! In most cases, dba is entered. User IDs within the
users group may be restricted from performing certain functions.

Create a User ID through the SAM
Terminal-Based Program
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............................................................................................................................................................

13 In the Start-Up Program field, press Enter, and use the Tab to move
to /usr/bin/ksh, and press Enter.

Result:

The Start-Up Program field contains the selected entry.

............................................................................................................................................................

14 Optional: Complete the remaining fields, tab to Set Password
Options and press Enter.

Result:

The Password Options dialog box displays.

............................................................................................................................................................

15 Press Enter to display the list of password options, scroll to your
selection, press Enter, use the Tab to move to OK, then press Enter.

Result:

The Password Options dialog box closes.

............................................................................................................................................................

16 Use the Tab to move to OK and press Enter.

Result:

The Set User Password dialog box displays.

............................................................................................................................................................

17 Enter a password then press Enter.

Result:

A verification message displays.

............................................................................................................................................................

18 Re-enter a password, use the Tab to move to OK, then press Enter.

Result:

A message displays that the login has been added.

............................................................................................................................................................

19 To exit the Add a User Account form, use the Tab to move to the File
menu, highlight Exit then press Enter.

Create a User ID through the SAM
Terminal-Based Program
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Result:

The Accounts for Users and Groups form is displayed.

............................................................................................................................................................

20 To exit the Accounts for Users and Groups form, use the Tab move to
the File menu, highlight Exit SAM, then press Enter.

............................................................................................................................................................

21 At the prompt, type cat /etc/passwd | pg and view the display to
determine if permissions have been properly set for the created user
ID in the passwd file.

............................................................................................................................................................

22 At the prompt, type exit.

Result:

A logout root and telnet status message is displayed.

............................................................................................................................................................

23 For each user entered in the Login Name field in Step 10 of this task,
perform the “Add a User in the Application” (4-22) task to add the
user to the Navis™ Optical NMS application.

Important! If this new user ID is to be used for cut-through
access to an EMS, then the user ID must be added to the EMS
GUI. See “Set up a User ID for Cut-Through to Navis™ Optical
EMS” (4-21) for details.

Create a User ID through the SAM
Terminal-Based Program
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Assign User Privileges to a User on a Windows PC
....................................................................................................................................................................................................................................

Purpose This procedure is used to assign user privileges to a user on a PC
running Windows software.

Before you begin Be sure that the user ID has been created.

Permissions You must have system administrator privileges on the PC in order to
perform this task.

Task Complete these steps to assign user privileges to a user on a
Windows PC:
............................................................................................................................................................

1 On the Windows main window, click on the Start button in the task
bar.

Result:

A menu is displayed.

............................................................................................................................................................

2 Select Programs > Administrative Tools (Common) > User
Manager.

Result:

The User Manager window is displayed.

............................................................................................................................................................

3 From the User Manager window, select User > New User.

Result:

The New User window is displayed.

............................................................................................................................................................

4 Complete the required Username field and the optional Full Name
and Description fields.

............................................................................................................................................................

5 In the Password field, enter the password associated with the new
user ID.

Users and User Profiles
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............................................................................................................................................................

6 In the Confirm Password field, enter the same password.

............................................................................................................................................................

7 Optional: Click to remove the check in the User Must Change
Password at Next Logon box.

............................................................................................................................................................

8 Optional: Check the Password Never Expires box.

............................................................................................................................................................

9 Select the Groups button.

Result:

The Group Membership screen is displayed.

............................................................................................................................................................

10 On the Group Membership screen, view the Member of list for a
Users entry. If Users is not listed, highlight Users in the Not
Member of list and select the Add button.

Important! If an entry other than Users displays in the Member
of list, highlight the entry, then select the Remove button to
move the entry to the Not Member of list.

Result:

Users displays in the Member of list.

............................................................................................................................................................

11 On the Group Membership screen, select OK.

Result:

The Group Membership screen closes.

............................................................................................................................................................

12 On the New User screen, select OK.

Result:

The New User screen closes and the new user is listed on the
User Manager screen.

Assign User Privileges to a User on a
Windows PC
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Assign User Privileges to a User on a Windows 2000 PC
....................................................................................................................................................................................................................................

Purpose This procedure is used to assign user privileges to a user on a PC
running Windows 2000 software.

Before you begin Be sure that the user ID has been created.

Permissions You must have system administrator privileges on the PC in order to
perform this task.

Task Complete these steps to assign user privileges to a user on a
Windows 2000 PC:
............................................................................................................................................................

1 Log into a workstation as an administrator.

............................................................................................................................................................

2 In the task bar, click the Start button, and then select Settings >
Control Panel.

Result:

The Control Panel form displays.

............................................................................................................................................................

3 Double click the Users and Passwords icon.

Result:

The Users and Passwords form displays.

............................................................................................................................................................

4 Click the Add button.

Result:

The Add New User form displays.

............................................................................................................................................................

5 Complete the User name, Full name, and Description fields, and
then click the Next button.

Result:

The Add New User form displays the password fields.

Users and User Profiles
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............................................................................................................................................................

6 Complete the Password and Confirm Password fields, and then
click the Next button.

Result:

The Add New User form displays access selections.

............................................................................................................................................................

7 Click Standard user (or other required level of access), and then
click the Finish button.

Result:

The user is added.

Assign User Privileges to a User on a
Windows 2000 PC
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Assign System Administrator Privileges to an Administrator on
a Windows PC
....................................................................................................................................................................................................................................

Purpose This procedure is used to assign system administrator privileges to a
user on a Windows PC.

Before you begin Be sure that the user ID has been created.

Permissions You must be authorized to perform this task.

Tasks Complete these steps to create a system administrator login and
assign system administrator privileges on a Windows PC.
............................................................................................................................................................

1 On the Windows main window, click on the Start button in the task
bar.

Result:

A menu is displayed.

............................................................................................................................................................

2 Select Programs > Administrative Tools (Common) > User
Manager.

Result:

The User Manager window is displayed.

............................................................................................................................................................

3 From the User Manager window, select User > New User.

Result:

The New User window is displayed.

............................................................................................................................................................

4 Complete the required Username field and the optional Full Name
and Description fields.

............................................................................................................................................................

5 In the Password field, enter the password associated with the new
user ID.

............................................................................................................................................................

6 In the Confirm Password field, enter the same password.
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............................................................................................................................................................

7 Uncheck User Must Change Password at Next Logon box.

............................................................................................................................................................

8 Check the Password Never Expires box.

............................................................................................................................................................

9 Select the Groups button.

Result:

The Group Membership screen is displayed.

............................................................................................................................................................

10 On the Group Membership screen, view the Member of list for an
Administrators entry. If Administrators is not listed, highlight
Administrators in the Not Member of list and select the Add button.

Important! If an entry other than Administrators displays in
the Member of list, highlight the entry then select the Remove
button to move the entry to the Not Member of list.

Result:

Administrators displays in the Member of list.

............................................................................................................................................................

11 On the Group Membership screen, select OK.

Result:

The Group Membership screen closes.

............................................................................................................................................................

12 On the New User screen, select OK.

Result:

The New User screen closes and the new user is listed on the
User Manager screen.

Assign System Administrator Privileges to
an Administrator on a Windows PC
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Add a User on an HP Server
....................................................................................................................................................................................................................................

Note There is no need to add any new users on the HP servers. Any
necessary User IDs should have already been loaded with the
software.
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Set up a User ID for Cut-Through to Navis™ Optical EMS
....................................................................................................................................................................................................................................

Purpose In earlier Navis™ Optical EMS releases (pre-Release 4.2), a default
itm user ID was hardcoded into the interface to support Navis™

Optical NMS cut-through connections to Navis™ Optical EMS. For
Navis™ Optical EMS Release 4.2 and greater, a cut-through user ID
(other than the default itm user ID) may be created and used for
Navis™ Optical NMS to Navis™ Optical EMS cut-through
connections.

Once the Navis™ Optical EMS cut-through user ID is created, it can
be used in a cut-through session to apply geographic domain
restrictions to ITM-SC or Navis™ Optical EMS, such as restricting
network elements that a user is allowed to view.

This procedure is used to set up a user ID (other than the default itm
user ID) for cut-through to Navis™ Optical EMS Release 4.2 and later
releases.

Task Use the following steps to add a cut-through user ID to Navis™

Optical EMS:
............................................................................................................................................................

1 Add a cut-through user ID to Navis™ Optical EMS. (See the Navis™

Optical EMS Administration Guide for details.)

............................................................................................................................................................

2 Enable the user option in the Secure Access Gateway for Enterprises
(SAGE) feature. See the Secure Access Gateway for Enterprises
(SAGE) Administration Guide.

Users and User Profiles

....................................................................................................................................................................................................................................

365-309-264R7.0
Issue 1, July 2002

Lucent Technologies 4 - 2 1

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Add a User in the Application
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a Regular User, Service Domain User,
or Geographic Domain user to the Navis™ Optical NMS application.

Before you begin The user ID must first be created using the SAM program. See
“Create a User ID through the SAM GUI-Based Program” (4-6) and
“Create a User ID through the SAM Terminal-Based Program” (4-10)
for details.

Permissions You must be authorized to perform this task.

Related information If a Geographic Domain User is being added, refer to “Add Users or
Network Elements to a Geographic Domain” (5-13) to continue with
the administration process for this user.

Task Complete these steps to add a Regular User, Service Domain
User, or Geographic Domain user to Navis™ Optical NMS:
............................................................................................................................................................

1 Start Navis™ Optical NMS. See “Section I: Start the Navis™ Optical
NMS Application on the Servers” (3-5) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Users > Add.

Result:

The Add User form displays.

............................................................................................................................................................

3 In the User ID field, enter a user ID.

............................................................................................................................................................

4 In the Description field (if desired, this field is optional), enter a
description to be associated with the user ID.

............................................................................................................................................................

5 In the Profile field, select a user profile from the drop-down list.
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If a user profile is not selected, the user is automatically assigned
Initial Profile.

Result:

The selected profile is displayed and the tasks associated with
the profile selection are displayed in the Assigned Tasks area
of the window.

............................................................................................................................................................

6 In the User Type field, select one of the following:

• If the user is not to be added to the Service Domain user list or
to the Geographic Domain user list, select Regular User.

• If the user is to be added to the Service Domain user list, select
Service Domain User.

• If the user is to be added to the Geographic Domain user list,
select Geo Domain User.

............................................................................................................................................................

7 Click Apply.

Result:

A message displays at the bottom of the Add User form
indicating that the user is added.

............................................................................................................................................................

8 Click OK.

Result:

The Add User form closes.

Add a User in the Application Users and User Profiles
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Modify a User in the Application
....................................................................................................................................................................................................................................

Purpose This procedure is used to modify user ID information.

Permissions You must be authorized to perform this task.

Task Complete these steps to modify a user:
............................................................................................................................................................

1 Start Navis™ Optical NMS. See “Section I: Start the Navis™ Optical
NMS Application on the Servers” (3-5) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Users > Display/Modify.

Result:

The List of Users form displays.

............................................................................................................................................................

3 Highlight the user ID to be modified.

............................................................................................................................................................

4 From the Actions menu, select Modify User.

Result:

The Modify User form displays.

............................................................................................................................................................

5 Change the Description, Profile, or User Type parameters as desired.

............................................................................................................................................................

6 Click Apply.

Result:

A message displays at the bottom of the Modify User form
which states that the parameters for the selected user are
modified.

............................................................................................................................................................

7 Click OK.
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Result:

The Modify User form closes.

............................................................................................................................................................

8 From the List of Users form, select File > Close.

Result:

The List of Users form closes.
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Delete a User in the Application
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a Regular User, Service Domain
User, or Geographic Domain user.

Permissions You must be authorized to perform this task.

Complete these steps to delete a user:
............................................................................................................................................................

1 Start Navis™ Optical NMS. See “Section I: Start the Navis™ Optical
NMS Application on the Servers” (3-5) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Users > Display/Modify.

Result:

The List of Users form displays.

............................................................................................................................................................

3 Highlight the user ID to be deleted.

............................................................................................................................................................

4 From the Actions menu, select Delete User.

Result:

A confirmation box displays and asks if you really want to
delete this user.

............................................................................................................................................................

5 Click Yes.

Result:

The user ID is deleted.

............................................................................................................................................................

6 Select File > Close.

Result:

The List of Users form closes.
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Add a User Profile in the Application
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a user profile.

Permissions You must be authorized to perform this task.

Task Complete these steps to add a user profile:
............................................................................................................................................................

1 Start Navis™ Optical NMS. See “Section I: Start the Navis™ Optical
NMS Application on the Servers” (3-5) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Profiles > Add.

Result:

The Add Profile form is displayed.

............................................................................................................................................................

3 In the Profile Name field, enter a name for the user profile (up to 30
characters).

............................................................................................................................................................

4 Add tasks to the user profile by moving them from the Available
Tasks list to the Selected Tasks list.

............................................................................................................................................................

5 Click Apply.

Result:

The user profile is added and is now available for assignment to
users.

............................................................................................................................................................

6 Click OK.

Result:

The Add Profile form closes.
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Modify a User Profile in the Application
....................................................................................................................................................................................................................................

Purpose This procedure is used to modify a user profile.

Permissions You must be authorized to perform this task.

Task Complete these steps to modify a user profile:
............................................................................................................................................................

1 Start Navis™ Optical NMS. See “Section I: Start the Navis™ Optical
NMS Application on the Servers” (3-5) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Profiles > Modify.

Result:

The Modify Profile form displays.

............................................................................................................................................................

3 In the Profile Name field, select the user profile to be modified from
the drop-down list.

Result:

The selected and available tasks for the user profile are
displayed.

............................................................................................................................................................

4 Do one of the following:

• Add tasks to the user profile by moving them from the Available
Tasks list to the Selected Tasks list.

• Remove tasks from the user profile by moving them from the
Selected Tasks list to the Available Tasks list.

............................................................................................................................................................

5 Click Apply.

Result:

The user profile is modified.

Users and User Profiles

....................................................................................................................................................................................................................................

4 - 2 8 Lucent Technologies 365-309-264R7.0
Issue 1, July 2002



............................................................................................................................................................

6 Click OK.

Result:

The Modify Profile form closes.
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Delete a User Profile in the Application
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a user profile.

Permissions You must be authorized to perform this task.

Task Complete these steps to delete a user profile:
............................................................................................................................................................

1 Start Navis™ Optical NMS. See “Section I: Start the Navis™ Optical
NMS Application on the Servers” (3-5) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments> Profiles > Delete.

Result:

The Delete Profile form displays.

............................................................................................................................................................

3 In the Profile Name field, select the name of the user profile to be
deleted from the drop-down list.

............................................................................................................................................................

4 Click Apply.

Result:

A confirmation box displays and asks if you really want to
delete this profile.

............................................................................................................................................................

5 Click Yes.

Result:

The user profile is deleted.

............................................................................................................................................................

6 Click Close.

Result:

The Delete Profile form closes.
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Add a User to a SAGE Workstation
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a user to a SAGE workstation.

Task Complete these steps to add a user to a SAGE client workstation:
............................................................................................................................................................

1 Log into the SAGE client workstation as system administrator.

............................................................................................................................................................

2 Click on the IWS icon.

Result:

The IWS HOME PAGE form is displayed.

............................................................................................................................................................

3 Click on the NMS icon.

Result:

The Navis™ Optical NMS Network Map is displayed.

............................................................................................................................................................

4 Select Administration > Security Assignments > Users > Add.

Result:

The Add User form is displayed.

............................................................................................................................................................

5 In the User ID field, type sawg and then click OK.

............................................................................................................................................................

6 In the Description field (if desired, this field is optional), enter a
description to be associated with the user ID.

............................................................................................................................................................

7 In the Profile field’s drop-down list, select Combined Profile.

Result:

The selected profile is displayed and the tasks associated with
the profile selection are displayed in the Assigned Tasks area
of the window.
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............................................................................................................................................................

8 In the User Type field, select one of the following:

• If the user is not to be added to the Service Domain user list or
to the Geographic Domain user list, select Regular User.

• If the user is to be added to the Service Domain user list, select
Service Domain User.

• If the user is to be added to the Geographic Domain user list,
select Geo Domain User.

............................................................................................................................................................

9 Click Apply.

Important! If a specific geographic domain is required for the
new User ID, refer to Chapter 5 in this document.

Result:

A message displays at the bottom of the Add User form
indicating that the user is added to the SAGE workstation.

............................................................................................................................................................

10 Click OK.

Result:

The Add User form closes.

............................................................................................................................................................

11 Type the user ID in the User ID field and click OK.

Important! If a specific geographic domain is required for the
new User ID, refer to Chapter 5 in this document.

Result:

The user ID is added to the SAGE workstation.
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Delete a User from a SAGE Workstation
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a user from a SAGE workstation.

Task Complete these steps to delete a user from a SAGE desktop:
............................................................................................................................................................

1 Log into the SAGE workstation as system administrator and then
bring up the Navis™ Optical NMS Network Map.

Result:

The Navis™ Optical NMS Network Map is displayed.

............................................................................................................................................................

2 On the Network Map, select Administration > Security
Assignments > Users > Display/Modify.

Result:

The List of Users form displays.

............................................................................................................................................................

3 Highlight the user ID to be deleted.

............................................................................................................................................................

4 From the Actions menu, select Delete User.

Result:

A confirmation box displays and asks if you really want to
delete this user.

............................................................................................................................................................

5 Click Yes.

Result:

The user ID is deleted.

............................................................................................................................................................

6 Select File > Close.

Result:

The List of Users form closes.
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5 Geographic Domain Partitioning

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides the conceptual information needed to
comprehend the administration of the Geographic Domain Partitioning
feature and the related tasks that are needed to administer and
maintain the feature.
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Geographic Domain Partitioning Concepts
....................................................................................................................................................................................................................................

Definition Geographic Domain Partitioning, which is an optional feature
provided with the Navis™ Optical NMS application, enables
administrators to assign users access to specific geographic domains
and to group network elements into domains that are under the control
of these Lucent optical management systems:

• Navis™ Optical NMS

• Navis™ Optical EMS

• ITM-SC

The Geographic Domain
form

The Geographic Domain form facilitates geographic domain
partitioning by permitting a user who has the proper security
privileges—such as a Navis™ Optical NMS privileged user—to control
the assignment of network elements and users to domains.

Users with correct privileges can view a list of:

• all users

• users who have access to a particular geographic domain

• users who are not assigned to any geographic domain

• users who are assigned to geographic domains

• users who have access to a particular network element

• all network elements

• network elements that are assigned to a particular geographic
domain

• network elements that are not assigned to any geographic domain

• network elements are assigned to geographic domains

• all geographic domains

Feature installation When Geographic Domain Partitioning is installed on a particular
system, the wording Geographic Domain appears on the Domain
Administration menu. If Geographic Domain Partitioning is not
installed on a particular system, the wording Geographic Domain is
grayed out on the Domain Administration menu.

Geographic Domain Partitioning
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During installation, the Geographic Domain Partitioning feature can
be configured with either of the following options:

• view ALL option

• restricted user option

The ability to view network elements and links depends on the
readall DBP variable, which is configured during installation. Refer to
the important note in Three types of users later in this section.

Getting started The network elements and users to be partitioned must first exist in
the Navis™ Optical NMS database before they can be assigned to any
domain. Network elements must be added in the standard fashion
before using the Geographic Domain Partitioning feature.

Feature particulars and
restrictions

The following are the particulars and restrictions of the Geographic
Domain Partitioning feature:

• The feature creates some default geographic domains that cannot
be deleted, such as the ITM-SC controller domain and the ALL
domain. Although they cannot be deleted, default geographic
domains can be modified and users can be added to them.

• A network element can only be assigned to one geographic
domain.

• Users can only access all network elements within an assigned
geographic domain. A user can be assigned to one or more
geographic domains; however, a network element can only be
assigned to one geographic domain.

• Multiple logins are permitted. A single user can have more than
one login (user ID). Each login can have access to different
domains only if the login is permitted access to those domains.
This access permits the user to have greater coverage during
out-of-hours or to have weekend privileges using one login and
more restricted access during normal working hours by using a
second login. These associations are accomplished by use of the
Add User form.
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Three types of users Geographic domain partitioning recognizes three types of users with
associated permissions:

• The Geographic Domain Admin User is generally a Navis™

Optical NMS system administrator with superuser privileges who
has permission to:

- access all features and forms

- create geographic domains

- assign users to geographic domains

- view all network elements and links in the network

• The Geographic Inter-Domain User is a user who is assigned to
more than one geographic domain by the system administrator.
The Inter-Domain user has permission to:

- control assigned network elements in multiple geographic
domains

- view only the network elements and links within the user’s
assigned geographic domains, if this user is a restricted
geographic domain user. A user with the View All option
sees all, but can only perform operations on nodes assigned
in his or her geographic domain. The View All option also
displays all Shared Risk Groups.

• The Geographic Domain User has permission to:

- control assigned network elements in the geographic
domain, if the user is a restricted geographic domain user

- provision network element ports
Note: To implement a circuit that crosses geographic
domains, the geographic domain user must implement that
portion of the circuit that is in his or her geographical
domain. The user then must refer the work item to another
work group or to a user who has access to the remaining
network elements of the other domain(s).

- view only the network elements and links within the user’s
assigned geographic domain, if the user is a restricted
geographic domain user

Important! The ability to view network elements and links depends
on the setup of the DBP variable readall at installation. If this
variable is selected, the geographic domain users and/or the
geographic inter-domain users can view network elements; however,
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these users can only perform operations on network elements assigned
to the particular geographic domain.

Assigning users to a
geographic domain

Only users with the user type Geo Domain User can access the
Geographic Domain forms.

Specific users can then be assigned access to specific domains. This is
done by the Admin User who selects the User Type when the user is
added to the Navis™ Optical NMS system.

The network elements and users must first exist in the controller
database before they can be assigned to any domain.

For a user to appear on the Geographic Domain Administration form,
the user must exist in the database with a login.

Note: None of the geographic domain user types can add a service
domain.

Security permissions A person with proper security permissions can create, delete, modify,
or associate network elements, domains, and users.
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Add a Geographic Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a geographic domain.

Before you begin Geographic domain administration procedures can only be performed
by those with the appropriate security privileges.

Network elements or users must be assigned to a geographic domain
or the domain will not be created. If you assign either network
elements or users, the domain will be created and you can assign or
delete more users or network elements at a later time.

Important! Some geographic domains are created by default and
cannot be deleted (for example, the ITM-SC controller domain
and the ALL domain). Geographic domains created by default
can be modified. You can add users to them.

Task Complete these steps to add a geographic domain:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Add.

Result:

The Geographical Domain Add form is displayed.

............................................................................................................................................................

2 In the Domain field, enter a name for the new geographic domain.

..........................................................................................................................................................

3
IF THEN

You want to add users to
the geographic domain.

Select the Users tab.

You want to add network
elements to the geographic
domain.

Select the NEs tab.

............................................................................................................................................................

4 Highlight the user or network element that is to be added to the
domain.

Geographic Domain Partitioning
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............................................................................................................................................................

5 Select Add to add the highlighted selection.

............................................................................................................................................................

6 Select OK.

Result:

The domain is created and its selected users or network
elements are assigned to the new domain. An Attention form
confirms that the geographic domain has been added.

............................................................................................................................................................

7 Select OK.

Result:

The Attention form closes.
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Display a Geographic Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to list a geographic domain and its assigned
users and network elements.

Permissions Geographic domain administration procedures can only be performed
by those with the appropriate security privileges. You must be
authorized to perform this task.

Task Complete these steps to display a geographic domain and its
assigned users and network elements:
............................................................................................................................................................

1 Start Navis™ Optical NMS. See “Section I: Start the Navis™ Optical
NMS Application on the Servers” (3-5) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify.

Result:

The Geographical Domain Administration form displays.

............................................................................................................................................................

3 Select the Domains radio button.

Result:

A list of domains display in the Domains area of the form.

............................................................................................................................................................

4 Select a listed domain.

Result:

The assigned users and network elements associated with the
domain are displayed.

Geographic Domain Partitioning
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Display Network Elements Assigned to Geographic Domains
....................................................................................................................................................................................................................................

Purpose This procedure is used to display network elements assigned to
geographic domains and their assigned users.

Permissions Geographic domain administration procedures can only be performed
by those with the appropriate security privileges. You must be
authorized to perform this task.

Task Complete these steps to display network elements, their
geographic domains and assigned users:
............................................................................................................................................................

1 Start Navis™ Optical NMS. See “Section I: Start the Navis™ Optical
NMS Application on the Servers” (3-5) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify.

Result:

The Geographical Domain Administration form displays.

............................................................................................................................................................

3 Select the Assigned NEs radio button.

Result:

A list of users display in the Assigned NEs area of the form.

............................................................................................................................................................

4 Select a listed network element.

Result:

The geographic domains and assigned users are displayed.
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Modify a Geographic Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to modify a geographic domain, which
includes adding users and/or network elements to the geographic
domain and deleting users and/or network elements from the
geographic domain.

Task Complete these steps to modify a geographic domain:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify.

Result:

The Geographical Domain Administration form is displayed.

............................................................................................................................................................

2 In the top field, select the Domains radio button.

Result:

The Domains list is populated.

............................................................................................................................................................

3 In the Domains list, select a domain.

............................................................................................................................................................

4 Select Actions > Modify Domain.

Result:

The Geographical Domain Modify form is displayed.

............................................................................................................................................................

5 To modify the users that are assigned to the domain, select the Users
tab.

To modify the network elements that are assigned to the domain,
select the NEs tab.

............................................................................................................................................................

6 Highlight the user or network element that is to be added or deleted
from the domain.
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............................................................................................................................................................

7 Select the appropriate arrow button to add or delete the highlighted
selection.

............................................................................................................................................................

8 Select Apply.

Result:

The selected network elements or users are assigned to or
deleted from the domain.

............................................................................................................................................................

9 Select OK.

Result:

The Geographical Domain Modify form closes.

............................................................................................................................................................

10 Select File > Close.

Result:

The Geographical Domain Administration form closes.
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Delete a Geographic Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a domain from geographic domain
partitioning.

Task Complete these steps to delete a domain from geographic domain
partitioning:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Delete.

Result:

The Geographical Domain Delete form is displayed.

............................................................................................................................................................

2 In the Domain field, select a geographic domain from the drop-down
list.

............................................................................................................................................................

3 Select Apply.

Result:

A form displays for you to confirm that the geographic domain
should be deleted.

............................................................................................................................................................

4 Select Yes.

Result:

The confirmation form closes.

............................................................................................................................................................

5 Select Close.

Result:

The Geographical Domain Delete form closes.
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Add Users or Network Elements to a Geographic Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to add user(s) or network element(s) to a
geographic domain.

Before you begin When adding a user to a geographic domain, that user ID must first
be defined as a Geo Domain User in Navis™ Optical NMS. See the
“Add a User in the Application” (4-22) task for details.

Permissions Geographic domain administration procedures can only be performed
by those with the appropriate security privileges. You must be
authorized to perform this task.

Task Complete these steps to add a user or a network element to a
geographic domain:
............................................................................................................................................................

1 Start Navis™ Optical NMS. See “Section I: Start the Navis™ Optical
NMS Application on the Servers” (3-5) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify.

Result:

The Geographical Domain Administration form is displayed.

............................................................................................................................................................

3 Select the Domains radio button.

Result:

A list of domains are displayed in the Domains area of the
form.

............................................................................................................................................................

4 Under the Domains list, select a domain, then select Actions >
Modify Domain.

Result:

The Geographical Domain Modify form is displayed.
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............................................................................................................................................................

5 Do one of the following:

• To add user(s) to a geographic domain, click the User tab,
highlight user(s), then click the Add button.

• To add a network element to a geographic domain, click the NEs
tab, highlight network element(s), then click the Add button.

Result:

The selected user(s) or network element(s) are moved to the left
of the window.

............................................................................................................................................................

6 On the Geographical Domain Modify form, click OK.

Result:

The Geographic Domain Modify form closes.

Add Users or Network Elements to a
Geographic Domain
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Display Users Assigned to Geographic Domains
....................................................................................................................................................................................................................................

Purpose This procedure is used to display users assigned to geographic
domains and their assigned network elements.

Permissions Geographic domain administration procedures can only be performed
by those with the appropriate security privileges. You must be
authorized to perform this task.

Task Complete these steps to display assigned users, their geographic
domains, and assigned network elements:
............................................................................................................................................................

1 Start Navis™ Optical NMS. See “Section I: Start the Navis™ Optical
NMS Application on the Servers” (3-5) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify.

Result:

The Geographical Domain Administration form displays.

............................................................................................................................................................

3 Select the Assigned Users radio button.

Result:

A list of users display in the Assigned Users area of the form.

............................................................................................................................................................

4 Select the radio button that matches the type of user to be viewed.

• Both, which displays Domain and Inter-domain Users

• Domain, which displays Domain users only

• Inter-Domain, which displays users assigned to more than one
geographic domain

............................................................................................................................................................

5 Select a listed user.
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Result:

The domains and network elements associated with the user are
displayed.

Display Users Assigned to Geographic
Domains
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Display Users Assigned to a Network Element
....................................................................................................................................................................................................................................

Purpose This procedure is used to display users assigned to a network element.

Task Complete these steps to display all users who have access to a
particular network element:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify.

Result:

The Geographical Domain Administration form displays.

............................................................................................................................................................

2 In the top field, select the Assigned NEs radio button.

Result:

The Assigned NEs list is displayed.

............................................................................................................................................................

3 In the Assigned NEs list, select a network element.

Result:

The Assigned Users list displays, and all users who have access
to the selected network element are displayed.
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Display Network Elements Assigned to a User
....................................................................................................................................................................................................................................

Purpose This procedure is used to display the network elements assigned to a
user.

Task Complete these steps to display the network elements that a
specific user can access:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify.

Result:

The Geographical Domain Administration form displays.

............................................................................................................................................................

2 In the top field, select the Assigned Users radio button.

Result:

The Assigned Users list is displayed.

............................................................................................................................................................

3 Select the radio button that matches the type of user:

• Both, which displays Domain and Inter-domain Users

• Domain, which displays Domain users only

• Inter-Domain, which displays users assigned to more than one
geographic domain

............................................................................................................................................................

4 Select the desired user.

Result:

The Assigned NEs list displays all the network elements to
which the selected user has access via the selected domain.
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Delete Users or Network Elements from a Geographic Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete user(s) or network element(s) from a
geographic domain.

Permissions Geographic domain administration procedures can only be performed
by those with the appropriate security privileges. You must be
authorized to perform this task.

Task Complete these steps to delete user(s) or network element(s) from
a geographic domain:
............................................................................................................................................................

1 Start Navis™ Optical NMS. See “Section I: Start the Navis™ Optical
NMS Application on the Servers” (3-5) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Geographical Domain > Display/Modify.

Result:

The Geographical Domain Administration form displays.

............................................................................................................................................................

3 Select the Domains radio button.

Result:

A list of domains display in the Domains area of the form.

............................................................................................................................................................

4 Under the Domains list, select a domain, then select Actions >
Modify Domain.

Result:

The Geographical Domain Modify form is displayed.

............................................................................................................................................................

5 To remove user(s) from a geographic domain, click the User tab,
highlight user(s), then click the Remove button.
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To remove a network element from a geographic domain, click the
NEs tab, highlight network element(s), then click the Remove button.

Result:

The selected user(s) or network element(s) are moved to the
right of the window.

............................................................................................................................................................

6 On the Geographical Domain Modify form, click OK.

Result:

The Geographic Domain Modify form closes.

Delete Users or Network Elements from a
Geographic Domain
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6 Service Domain Partitioning

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides the conceptual information needed to
comprehend the administration of the Service Domain Partitioning
feature and the related tasks that are needed to administer and
maintain the feature.
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Service Domain Concepts
....................................................................................................................................................................................................................................

Definition Service Domain Partitioning is an optional administrative feature that
enables an administrator to partition trails, channels, ports, and Virtual
Concatenation Groups (VCGs) and their end ports, which are referred
to as PTPs, into domains and to assign specific users access to
particular domains.

Trails, channels, ports, and
VCGs

In the Navis™ Optical NMS application, a trail is an end-to-end
connection that consists of cross-connects and channels. It is a logical
entity.

A VCG is a logical entity that consists of a group of member VC-n
trails. A VCG, its PTPs, and any number of VC-n trails can belong to
the same service domain. Through the Virtual Private Network (VPN)
feature, system administrators can restrict a user’s ability to assign
channels. This restriction is made during the creation of the service
domain.

Service domain modes Service domains are created in one of the following modes:

• Dedicated mode, in which the user can group channels, trails,
ports, and VCGs into service domains. As a result, the user can
assign channels and assign ports for trail provisioning or assign
trails, for example, to monitor fault and performance.

• Shared mode, in which the VPN feature is implemented and
channel assignment is not permitted. The user can only group
trails, ports, and VCGs into service domains, assign ports for trail
provisioning purposes, or assign trails for monitoring purposes.

The selection of either mode is explained in the “Add a Service
Domain” (6-5) task.

Getting started Channels and users must first exist in the controller database before
they can be assigned to any domain.
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Feature particulars and
restrictions

The following particulars and restrictions apply to the Shared mode of
the Service Domain Partitioning feature:

• A service domain user cannot belong to a geographic domain nor
can the service domain user belong to more than one service
domain.

• An empty service domain does not contain any users, ports, or
trails.

• A geographic domain user cannot be added to a service domain.

• Both a trail and a port can only belong to one service domain.

Two types of users Service Domain Partitioning recognizes two types of users:

• A service domain administrator can create, modify, delete, and
use a service domain. This user is generally an Navis™ Optical
NMS system administrator who has superuser privileges.

• A service domain user is a user who can access and use the
service domain forms. A service domain user cannot be a
geographic domain user. A user may only be assigned to one
service domain and generally cannot belong to more than one
service domain. If a user must be assigned to additional service
domains, the user must be assigned additional user IDs. However,
the user can only operate in the service domain that he or she is
currently logged into by the user ID.

Service Domain forms Service domain administration is accomplished through several service
domain administration forms, which are accessed from the Network
Map Administration menu. The service domain forms do not create
users or network elements. Only a service domain administrator can
create, delete, or modify a domain.
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Add a Service Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a service domain.

Before you begin Service domain administration procedures can only be performed by
those with the appropriate security privileges.

Task Important! Channels, circuits, or users must be assigned to
create the domain.

Complete these steps to add a service domain:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Add.

Result:

The Service Domain Add box is displayed.

............................................................................................................................................................

2 In the Service Domain Name field, enter a name for the service
domain.

............................................................................................................................................................

3 In the Service Domain Mode field, select Shared (default) or
Dedicated.

............................................................................................................................................................

4 Select the OK button.

Result:

An Attention form confirms that the service domain has been
added.

............................................................................................................................................................

5 Select OK.

Result:

The Attention form closes.
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Delete a Service Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a service domain.

Before you begin Service domain administration procedures can only be performed by
those with the appropriate security privileges.

Before deleting a service domain, be sure that:

• all ports, trails, and users have been unassigned from the service
domain

• if the service mode is dedicated, all channels assigned to the
domain have been unassigned from the service domain

Task Complete these steps to delete a service domain:
............................................................................................................................................................

1 Select Administration > Domain Partitioning > Service Domain >
Delete.

Result:

The Service Domain Delete form is displayed.

............................................................................................................................................................

2 In the Service Domain Name field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select Apply.

Result:

A form is displayed to confirm that the service domain should
be deleted.

............................................................................................................................................................

4 Select Yes.

Result:

The confirmation form closes.

............................................................................................................................................................

5 Select Close.
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Result:

The Service Domain Delete form closes.
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Display Trails Assigned to a Service Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to list trails that are assigned to a service
domain.

Task Complete these steps to list trails that are assigned to a service
domain:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Assignments.

Result:

The Service Domain Query form is displayed.

............................................................................................................................................................

2 In the Service Domain Name field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select the Trails tab.

............................................................................................................................................................

4 Optional: Complete the A Node and Z Node fields.

Important! To view A Node and Z Node values, select the A
Node or Z Node button to display a selection box. Next, select
the Find button, select the value from the displayed list and
select OK.

............................................................................................................................................................

5 Select a trail type from the drop-down list.

............................................................................................................................................................

6 Select OK.

Result:

The Service Domain Display/Modify Trails form displays and
lists the trails assigned to the service domain.
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Display Channels Assigned to a Service Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to display the channels assigned to a service
domain.

Task Complete these steps to list the channels assigned to a service
domain:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Assignments.

Result:

The Service Domain Query form is displayed.

............................................................................................................................................................

2 In the Service Domain Name field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select the Channels tab.

............................................................................................................................................................

4 Optional: Complete the A Node and Z Node fields.

Important! To view A Node and Z Node values, select the A
Node or Z Node button to display a Selection box. Next, select
the Find button, select the value from the displayed list and
select OK.

............................................................................................................................................................

5 Select a trail type from the drop-down list.

............................................................................................................................................................

6 Select a channel type from the drop-down list.

............................................................................................................................................................

7 Select OK.

Result:

If the Service Domain mode value is Dedicated, the Service
Domain Display/Modify Channels form displays and lists the
channels assigned to the service domain.
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Display Ports Assigned to a Service Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to display ports that are assigned to a service
domain.

Task Complete these steps to display ports that are assigned to a
service domain:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Assignments.

Result:

The Service Domain Query form is displayed.

............................................................................................................................................................

2 In the Service Domain Name field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select the Ports tab.

............................................................................................................................................................

4 Optional: Complete the Node field.

Important! Existing node values may be viewed by selecting the
Node button.

............................................................................................................................................................

5 Select the Rate value from the drop-down list.

............................................................................................................................................................

6 Select OK.

Result:

The Service Domain Display/Modify Ports form displays and
lists the ports assigned to the service domain.
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Display VCGs Assigned to a Service Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to display the Virtual Concatenation Groups
(VCGs) that are assigned to a service domain.

Task Complete these steps to display the VCGs that are assigned to a
service domain:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Assignments.

Result:

The Service Domain Query form is displayed.

............................................................................................................................................................

2 In the Service Domain Name field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select the VCGs tab.

............................................................................................................................................................

4 Optional: Complete the A Node and Z Node fields.

Important! To view A Node and Z Node values, select the A
Node or Z Node button to display a selection box. Next, select
the Find button, select the value from the displayed list and
select OK.

............................................................................................................................................................

5 Select a VCG from the drop-down list.

............................................................................................................................................................

6 Select OK.

Result:

The Service Domain Display/Modify VCG form closes.
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Modify the Trails Assigned to a Service Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to modify the trails assigned to a service
domain.

Before you begin Service domain administration procedures can only be performed by
those with the appropriate security privileges.

Task Complete these steps to modify the trails assigned to a service
domain:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Assignments.

Result:

The Service Domain Query form is displayed.

............................................................................................................................................................

2 In the Service Domain Name field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select the Trails tab.

............................................................................................................................................................

4 Optional: Complete the A Node and Z Node fields.

Important! A Node and Z Node values may be viewed by
selecting the A Node or Z Node button to display a Selection
box. Next, select the Find button, select the value from the
displayed list and select OK.

............................................................................................................................................................

5 Select a trail type from the drop-down list.

............................................................................................................................................................

6 Select OK.

Result:

The Service Domain Display/Modify form displays and lists the
trails assigned to the service domain.

Service Domain Partitioning
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............................................................................................................................................................

7 Continue with one of the following:

• Add trails to the service domain by moving them from the Non
Member Trails list to the Member Trails list.

• Delete trails from the service domain by moving them from the
Member Trails list to the Non Member Trails list.

............................................................................................................................................................

8 Select Apply.

Result:

The trails assigned to the service domain are modified. The Non
Member Trails and Member Trails lists redisplay and show the
modifications.

............................................................................................................................................................

9 Select OK.

Result:

The Service Domain Display/Modify Trails form closes.

Modify the Trails Assigned to a Service
Domain
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Modify the Channels Assigned to a Service Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to modify the channels assigned to a service
domain.

Before you begin Service domain administration procedures can only be performed by
those with the appropriate security privileges.

Task Complete these steps to modify the channels assigned to a service
domain:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Assignments.

Result:

The Service Domain Query form is displayed.

............................................................................................................................................................

2 In the Service Domain Name field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select the Channels tab.

............................................................................................................................................................

4 Optional: Complete the A Node and Z Node fields.

Important! A Node and Z Node values may be viewed by
selecting the A Node or Z Node button to display a Selection
box. Next, select the Find button, select the value from the
displayed list and select OK.

............................................................................................................................................................

5 Continue with one of the following:

• Add channels to the service domain by moving them from the
Non Member Channels list to the Member Channels list.

• Delete channels from the service domain by moving them from
the Member Channels list to the Non Member Channels list.

Important! Channels will not display if Shared was selected for the
Service Domain Mode (when this service domain was added).
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............................................................................................................................................................

6 Select Apply.

Result:

The channels assigned to the service domain are modified. The
Non Member Channels and Member lists redisplay and show
the modifications.

............................................................................................................................................................

7 Select OK.

Result:

The Service Domain Display/Modify Channels form closes.

Modify the Channels Assigned to a Service
Domain
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Modify the Ports Assigned to a Service Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to modify the ports assigned to a service
domain.

Before you begin Service domain administration procedures can only be performed by
those with the appropriate security privileges.

Task Complete these steps to modify the ports assigned to a service
domain:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Assignments.

Result:

The Service Domain Query form is displayed.

............................................................................................................................................................

2 In the Service Domain Name field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select the Ports tab.

............................................................................................................................................................

4 Complete the Node field.

Important! Existing node values can be viewed by selecting the
Node button.

............................................................................................................................................................

5 Select the Rate value from the drop-down list.

............................................................................................................................................................

6 Select OK.

Result:

The Service Domain Display/Modify Ports form displays and
lists the ports assigned to the service domain.
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............................................................................................................................................................

7 Continue with one of the following:

• Add ports to the service domain by moving them from the Non
Member Ports list to the Member Ports list.

• Delete ports from the service domain by moving them from the
Member Ports list to the Non Member Ports list.

............................................................................................................................................................

8 Select Apply.

Result:

The ports assigned to the service domain are modified. The Non
Member Ports and Member Ports lists redisplay and show the
modifications.

............................................................................................................................................................

9 Select OK.

Result:

The Service Domain Display/Modify Ports form closes.
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Modify the VCGs Assigned to a Service Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to modify the Virtual Concatenation Groups
(VCGs) assigned to a service domain.

Before you begin Service domain administration procedures can only be performed by
those with the appropriate security privileges.

Task Complete these steps to modify the VCGs assigned to a service
domain:
............................................................................................................................................................

1 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Assignments.

Result:

The Service Domain Query form is displayed.

............................................................................................................................................................

2 In the Service Domain Name field, select the domain name from the
drop-down list.

............................................................................................................................................................

3 Select the VCGs tab.

Result:

The VCGs form appears.

............................................................................................................................................................

4 Optional: Complete the A Node and Z Node fields.

Important! A Node and Z Node values may be viewed by
selecting the A Node or Z Node button to display a Selection
box. Next, select the Find button, select the value from the
displayed list and select OK.

............................................................................................................................................................

5 Use the right and left arrows to move the VCGs to/from the Member
VCGs and Non-Member VCG fields.

............................................................................................................................................................

6 Select Apply.

Service Domain Partitioning
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Result:

The VCGs assigned to the service domain are modified. The
Non Member VCGs and Member VCGs lists redisplay and
show the modifications.

............................................................................................................................................................

7 Select OK.

Result:

The Service Domain Display/Modify VCGs form closes.

Modify the VCGs Assigned to a Service
Domain

Service Domain Partitioning

....................................................................................................................................................................................................................................

365-309-264R7.0
Issue 1, July 2002

Lucent Technologies 6 - 1 9

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Add Users to a Service Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a user or users to a service domain.

Permissions Service domain administration procedures can only be performed by
those with the appropriate security privileges. You must be authorized
to perform this task.

Important! When adding a user to a service domain, that user ID
must first be defined as a Service Domain User in Navis™

Optical NMS. See the “Add a User in the Application” (4-22)
task.

Task Complete these steps to add users to a service domain:
............................................................................................................................................................

1 Start Navis™ Optical NMS. See “Section I: Start the Navis™ Optical
NMS Application on the Servers” (3-5) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Users.

Result:

The Service Domain Display/Modify Users form is displayed.

............................................................................................................................................................

3 In the Service Domain Name field, select a service domain name.

Result:

The users assigned to that service domain display in the
Members box and users not assigned to the service domain
display in the Non-Members box.

............................................................................................................................................................

4 To add user(s) to the Members box, highlight user(s) in the
Non-Members box and click the left arrow button.

Result:

The selected user(s) are moved to Members box.

Service Domain Partitioning
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............................................................................................................................................................

5 On the Service Domain Display/Modify form, click OK.

Result:

The Service Domain Display/Modify form closes.
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Display Service Domain Users
....................................................................................................................................................................................................................................

Purpose This procedure is used to display members assigned to a service
domain.

Permissions Service domain administration procedures can only be performed by
those with the appropriate security privileges. You must be authorized
to perform this task.

Task Complete these steps to display service domain users:
............................................................................................................................................................

1 Start Navis™ Optical NMS. See “Section I: Start the Navis™ Optical
NMS Application on the Servers” (3-5) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify Users.

Result:

The Service Domain Display/Modify Users form displays.

............................................................................................................................................................

3 From the Service Domain Name field, select a service domain.

Result:

The users assigned to the selected domain are listed in the left
box, and the users not assigned to the domain display in the
right box, if applicable.
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Delete Users from a Service Domain
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a user or users from a service
domain.

Permissions Service domain administration procedures can only be performed by
those with the appropriate security privileges. You must be authorized
to perform this task.

Task Complete these steps to delete user(s) from a service domain:
............................................................................................................................................................

1 Start Navis™ Optical NMS. See “Section I: Start the Navis™ Optical
NMS Application on the Servers” (3-5) for details.

Result:

The Network Map displays.

............................................................................................................................................................

2 On the Network Map, select Administration > Domain Partitioning
> Service Domain > Display/Modify > Users.

Result:

The Service Domain Display/Modify Users form is displayed.

............................................................................................................................................................

3 In the Service Domain Name field, select a service domain name.

Result:

The users assigned to that service domain display in the
Members box and users not assigned to the service domain
display in the Non-Members box.

............................................................................................................................................................

4 To delete user(s) from the Members box, highlight user(s) in the
Members box and click the right arrow button.

Result:

The selected user(s) are moved to Non-Members box.

............................................................................................................................................................

5 On the Service Domain Display/Modify form, click OK.
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Result:

The Service Domain Display/Modify form closes.
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7 Provisioning Administration

Overview
....................................................................................................................................................................................................................................

Purpose This chapter contains topology and provisioning tasks performed to
administer Navis™ Optical NMS.
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Section I: Aggregates

Overview
....................................................................................................................................................................................................................................

Purpose An aggregate is a collection of one or more network elements
collapsed into a single node displayed on the Network Map. An
aggregate can contain other aggregates.

This section discusses the provisioning tasks associated with
aggregates as they relate to managing the topology of the Navis™

Optical NMS Network Map.
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Add an Aggregate
....................................................................................................................................................................................................................................

Purpose This procedure is used to add an aggregate to the Navis™ Optical
NMS Network Map.

Task Complete the following task to add an aggregate to the Navis™

Optical NMS Network Map.
............................................................................................................................................................

1 On the Network Map, select Administration > Aggregate > Add.

Result:

The Aggregate Add form is displayed.

............................................................................................................................................................

2 In the Area ID field, click the down arrow and select an area ID.

............................................................................................................................................................

3 In the Aggregate ID field, enter a 1 to 20 character name for the
Aggregate ID.

............................................................................................................................................................

4 In the Acronym field, enter a 1 to 4 character name for the Aggregate
Acronym.

............................................................................................................................................................

5 From the Non-Member List, select the network element or elements
you want to add to the aggregate.

Important! To select more than one network element, press the
Control key. The number of network elements that can be
selected at one time is unlimited.

............................................................................................................................................................

6 Click the right arrow to move the network elements appearing in the
Non-Member list to the Members list.

Result:

The selected network elements appear within the Members list.

............................................................................................................................................................

7 Click Apply.
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Result:

A confirmation window is displayed.

............................................................................................................................................................

8 Click OK.

Result:

You are returned to the Aggregate Add form.

............................................................................................................................................................

9 Click OK.

Result:

The Aggregate is added to the Network Map. A corresponding
network element is displayed at the top left-hand side of the
Network Map.

Section I: Aggregates
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Delete an Aggregate
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete an aggregate from the Navis™ Optical
NMS Network Map.

Task Complete the following task to delete an aggregate from the
Navis™ Optical NMS Network Map.
............................................................................................................................................................

1 From the Network Map, select Administration> Aggregate > Delete.

Result:

The Aggregate Delete form is displayed.

............................................................................................................................................................

2 In the Area ID field, click the down arrow and select an area ID.

............................................................................................................................................................

3 Click the Aggregate ID to be deleted.

............................................................................................................................................................

4 Click Apply.

Result:

A confirmation window is displayed.

............................................................................................................................................................

5 Click OK.

Result:

The Aggregate Add form is displayed.

............................................................................................................................................................

6 Click OK.

Result:

The aggregate is deleted and is no longer displayed on the
Network Map.
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Add a Member to an Aggregate
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a network element as a member to an
existing aggregate. (A member can be defined as a network element,
which constitute aggregates.)

Important! There is not a limit on the number of members that
may reside in an aggregate.

Task Complete the following task to add a member to an existing
aggregate.
............................................................................................................................................................

1 On the Network Map, select Administration > Aggregate >
Display/Modify.

Result:

The Aggregate Add form appears.

............................................................................................................................................................

2 In the Area ID field, click the down arrow and select an area ID.

............................................................................................................................................................

3 In the Aggregate ID pull-down menu, left-click the aggregate to be
modified.

Result:

The members of the aggregate are displayed in the Members
column.

............................................................................................................................................................

4 In the Non-members column, left-click the network element to be
added to the aggregate.

Result:

The network element is highlighted.

............................................................................................................................................................

5 Click the left-pointing arrow.

Result:

The network element is moved to the Members column.

Section I: Aggregates Provisioning Administration

....................................................................................................................................................................................................................................

365-309-264R7.0
Issue 1, July 2002

Lucent Technologies 7 - 7



............................................................................................................................................................

6 Click Apply.

Result:

A confirmation window is displayed.

............................................................................................................................................................

7 Click OK.

Result:

The Aggregate Add form is displayed.

............................................................................................................................................................

8 Click Close.

Result:

The form closes and the network element becomes a new
member of the aggregate.

Section I: Aggregates
Add a Member to an Aggregate

Provisioning Administration

....................................................................................................................................................................................................................................

7 - 8 Lucent Technologies 365-309-264R7.0
Issue 1, July 2002

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Remove a Member of an Aggregate
....................................................................................................................................................................................................................................

Purpose This procedure is used to remove a member from an existing
aggregate. (A member can be defined as a network element, which
constitutes an aggregate.)

Before you begin Before removing a member from an aggregate, note the following
items:

• The aggregate must have at least one member.

• The last aggregate member cannot be deleted without deleting the
aggregate itself.

Task Complete the following task to remove a member from an
existing aggregate.
............................................................................................................................................................

1 From the Network Map, select Administration> Aggregate >
Display/Modify.

Result:

The Aggregate Modify window appears.

............................................................................................................................................................

2 In the Aggregate ID menu, left-click the aggregate to be modified.

Result:

The members of the aggregate are displayed in the Members
column.

............................................................................................................................................................

3 In the Members column, left-click the network element to be deleted
from the aggregate.

Result:

The network element becomes highlighted.

............................................................................................................................................................

4 Click the right-pointing arrow.

Result:

The network element is moved to the Non-members column.
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............................................................................................................................................................

5 Click Apply.

Result:

A confirmation window is displayed.

............................................................................................................................................................

6 Click OK.

Result:

The Aggregate Add form is displayed.

............................................................................................................................................................

7 Click Close.

Result:

The form closes. The member is removed from the aggregate.
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Specify an Acronym for an Aggregate
....................................................................................................................................................................................................................................

Purpose This procedure is used to specify an on-screen acronym for an
aggregate, which is the title that is formed from the initial letters or
parts of the full name of the aggregate.

Task Complete the following task to modify an aggregate’s on-screen
acronym.
............................................................................................................................................................

1 From the Network Map, select Administration > Aggregate > Add.

Result:

The Aggregate Add window appears.

............................................................................................................................................................

2 In the Aggregate ID pull-down menu, select the aggregate whose
acronym you wish to specify.

Result:

The members of the aggregate are displayed in the Members
column.

............................................................................................................................................................

3 Select Acronym and press the Backspace key.

Result:

The Aggregate List form is displayed.

............................................................................................................................................................

4 Enter the new acronym.

............................................................................................................................................................

5 Click Apply.

............................................................................................................................................................

6 Click OK.

Result:

The on-screen acronym updates automatically.

Section I: Aggregates Provisioning Administration

....................................................................................................................................................................................................................................

365-309-264R7.0
Issue 1, July 2002

Lucent Technologies 7 - 1 1

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Section II: Areas

Overview
....................................................................................................................................................................................................................................

Purpose This section describes areas and describes the tasks related to areas.

Background Navis™ Optical NMS managed networks can be subdivided into
smaller, manageable networks called areas. When the network is
subdivided into areas containing a limited set of network
elements/aggregates and associated links, the potential to overcrowd
the display is reduced and system performance is improved because
the subsystems exchange less information.

Areas may be a set of network elements and/or aggregates:

• that are dedicated to a subscriber

• which are or are not connected

• in a remote location or building

Areas cannot reside within other areas.

Users can choose to view only the areas they are interested in, which
reduces the potential to overcrowd the display and improves system
performance because the subsystems exchange less information.

Only a system administrator can create areas.

Definition: area An area is a collection of network elements, aggregates, and their
associated links. An area is displayed as an icon on the Area Panel of
the Network Map. An area can be expanded, which causes the
Expansion Panel to appear on the Network Map and display all of the
nodes, aggregates, and links in the area.

The number of network elements that can be included in an area is
unlimited, however we recommend a limit of 300 network elements in
an area to avoid a cluttered display and performance problems.
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Add an Area
....................................................................................................................................................................................................................................

Purpose This procedure is used to add an area.

Permissions You must be authorized to perform this task.

Related information For instructions on how to add members to the area that is being
created with this task, see the following task, “Modify an Area” (7-14)
.

Task Complete these steps to add an area.
............................................................................................................................................................

1 On the Network Map, select Administration > Area > Add.

Result:

The Area Create form is displayed.

............................................................................................................................................................

2 In the Area ID field, enter a name for the area.

............................................................................................................................................................

3 Select OK.

Result:

The area is added. Note that an area icon displays in the top left
side of the Area Panel on the Network Map. An entry for the
new area appears in the Network Tree Panel on the Network
Map.
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Modify an Area
....................................................................................................................................................................................................................................

Purpose This procedure is used to modify an area.

Permissions You must be authorized to perform this task.

Task Complete these steps to modify an area:
............................................................................................................................................................

1 On the Network Map, select Administration > Area >
Display/Modify.

Result:

The Area Modify form is displayed.

............................................................................................................................................................

2 In the Area ID field, select the area from the drop-down list.

Result:

Non-members of the area display in the Non-Members list, and
members of the area display in the Members list.

............................................................................................................................................................

3 Add nodes to the area by moving them from the Non-Members list to
the Members list.

Delete nodes from the area by moving them from the Members list to
the Non-Members list.

............................................................................................................................................................

4 Select Apply.

Result:

The area is modified. The Non-Members and Members lists
redisplay and show the modifications.

............................................................................................................................................................

5 Select Close.

Result:

The Area Modify form closes.
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Delete an Area
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete an area.

Permissions You must be authorized to perform this task.

Task Complete these steps to delete an area:
............................................................................................................................................................

1 On the Network Map, select Administration > Area > Delete.

Result:

The Area Delete form is displayed.

............................................................................................................................................................

2 In the Area ID field, click the down arrow to select the area ID from
the drop down menu.

............................................................................................................................................................

3 Click OK.

Result:

The area is deleted. The area icon is deleted from the Area
Panel on the Network Map. The entry for the area disappears
from the Network Tree Panel on the Network Map.
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Section III: User Defined Area Map

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to add, display/modify, or delete user
defined area maps. These maps allow a specific user to define which
network elements to display on the screen within a submap. (See
“Section IV: User Defined Submap” (7-20).)

Contents
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Add a User Defined Area Map
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a user defined area map.

Permissions You must be authorized to perform this task.

Task Complete these steps to add a user defined area map.
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined Area
Map > Add.

Result:

The Add User Defined Area Map form is displayed.

............................................................................................................................................................

2 In the User Defined Area Map Name field, enter 1 to 20 characters
for the name of the user defined map.

............................................................................................................................................................

3 To add member(s) to the new area map, select one or more entries
from the Non-Members list, then click the left arrow.

Important! You can optionally complete the Filters field to
lessen the number of listed entries.

Result:

The selection(s) are moved to the Members list.

............................................................................................................................................................

4 Select OK.

Result:

The new user defined area map is added and the Add User
Defined Area Map form closes.
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Display/Modify a User Defined Area Map
....................................................................................................................................................................................................................................

Purpose This procedure is used to display/modify a user defined area map.

Permissions You must be authorized to perform this task.

Task Complete these steps to display/modify a user defined area map:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined Area
Map > Display/Modify.

Result:

The Modify User Defined Area Map form is displayed.

............................................................................................................................................................

2 In the User Defined Area Map Name field, select the map to be
displayed/modified.

Result:

The selected information displays.

............................................................................................................................................................

3 Do one of the following:

• Make no changes and proceed to the next step.

• Add member(s) to the area map by selecting one or more entries
from the Non-Members list, then click the left arrow button.

• Remove member(s) from the area map by selecting one or more
entries from the Members list, then click the right arrow button.

............................................................................................................................................................

4 Select OK.

Result:

The area map is modified if changes were made.
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Delete a User Defined Area Map
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a user-defined area map.

Permissions You must be authorized to perform this task.

Task Complete these steps to delete a user defined area map:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined Area
Map > Delete.

Result:

The Delete User Defined Area Map form is displayed.

............................................................................................................................................................

2 In the User Defined Area Map Name field, select a map name from
the drop-down menu.

Result:

The selected information displays.

............................................................................................................................................................

3 Select OK.

Result:

The user defined area map is deleted.
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Section IV: User Defined Submap

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to add, display/modify, or delete user
defined submaps. A submap allows a specific user to define which
areas to display on the screen. (See also “Section II: Areas” (7-12)
and “Section III: User Defined Area Map” (7-16).)

Contents
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Delete a User Defined Submap 7-23
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Add a User Defined Submap
....................................................................................................................................................................................................................................

Purpose This procedure is used to add a user defined submap.

Permissions You must be authorized to perform this task.

Task Complete these steps to add a user defined submap.
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined
Submap > Add.

Result:

The Add User Defined Submap form is displayed.

............................................................................................................................................................

2 In the User Defined Submap Name field, enter a name for the user
defined submap.

............................................................................................................................................................

3 To add member(s) to the new submap, select one or more entries from
the Non-Members list, then click the left arrow button.

Important! You can optionally complete the Filters field to
lessen the number of listed entries.

Result:

The selection(s) are moved to the Members list.

............................................................................................................................................................

4 Select OK.

Result:

The new user defined submap is added and the Add User
Defined Submap form closes.
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Display/Modify a User Defined Submap
....................................................................................................................................................................................................................................

Purpose This procedure is used to display/modify a user defined submap.

Permissions You must be authorized to perform this task.

Task Complete these steps to display/modify a user defined submap:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined
Submap > Display/Modify.

Result:

The Modify User Defined Submap form is displayed.

............................................................................................................................................................

2 In the User Defined Submap Name field, select the submap to be
displayed/modified.

Result:

The selected information displays.

............................................................................................................................................................

3 Do one of the following:

• Make no changes and proceed to the next step.

• Add member(s) to the submap by selecting one or more entries
from the Non-Members list, then click the left arrow button.

• Remove member(s) from the submap by selecting one or more
entries from the Members list, then click the right arrow button.

............................................................................................................................................................

4 Select OK.

Result:

The submap is modified if changes were made.
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Delete a User Defined Submap
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a user-defined submap.

Permissions You must be authorized to perform this task.

Task Complete these steps to delete a user defined submap:
............................................................................................................................................................

1 On the Network Map, select Administration > User Defined
Submap > Delete.

Result:

The Delete User Defined Submap form is displayed.

............................................................................................................................................................

2 In the User Defined Submap Name field, select a map name from
the drop-down menu.

Result:

The selected information displays.

............................................................................................................................................................

3 Select OK.

Result:

The user defined submap is deleted.
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Section V: Scheduled Entities

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the administration of scheduled entities.

Definition: Scheduled
entity

A scheduled entity is a provisioning assignment for a facility, path, or
circuit that has been designated to occur at a future date and time. All
assignments, with the exception of digital links, can be scheduled.

Contents
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Delete a Scheduled Entity 7-26

Modify a Scheduled Entity 7-27

Filter the Display of Scheduled Entities on the
Scheduled List

7-28

View Successful/Failed Scheduled Entities Through
the Scheduled History List

7-30
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View a List of Scheduled Entities
....................................................................................................................................................................................................................................

Purpose This procedure is used to view a list of scheduled entities, such as a
list of VC4s that have been scheduled for assignment or a list of
scheduled facilities.

Before you begin The active form must be the Network Map.

Task Complete these steps to view a list of scheduled entities.
............................................................................................................................................................

1 On the Network Map, select Administration > Scheduled List.

Result:

The Scheduled List Query Box is displayed.

............................................................................................................................................................

2 Enter the Scheduled Entity.

............................................................................................................................................................

3 Enter the Schedule Type from the menu.

............................................................................................................................................................

4 Select OK.

Result:

The Scheduled List form appears and displays the queried
information.
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Delete a Scheduled Entity
....................................................................................................................................................................................................................................

Purpose This procedure is used to delete a scheduled entity.

Task Complete these steps to delete a scheduled entity.
............................................................................................................................................................

1 On the Network Map, select Administration > Scheduled List.

Result:

The Scheduled List Query Box is displayed.

............................................................................................................................................................

2 Enter an existing Scheduled Entity.

............................................................................................................................................................

3 Enter a Schedule Type from the menu.

............................................................................................................................................................

4 Select OK.

Result:

The Scheduled List form is displayed with the queried
information.

............................................................................................................................................................

5 Select Actions > Delete.

Result:

A confirmation box is displayed which prompts the user to
confirm the delete request.

............................................................................................................................................................

6 Select OK.

Result:

The selected scheduled entity is deleted.
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Modify a Scheduled Entity
....................................................................................................................................................................................................................................

Purpose This procedure is used to modify a scheduled entity.

Task Complete these steps to modify a scheduled entity.
............................................................................................................................................................

1 On the Network Map, select Administration > Scheduled List.

Result:

The Scheduled List Query Box is displayed.

............................................................................................................................................................

2 Enter an existing Scheduled Entity.

............................................................................................................................................................

3 Enter the Schedule Type from the menu.

............................................................................................................................................................

4 Select OK.

Result:

The Scheduled List form is displayed with the queried
information.

............................................................................................................................................................

5 Select Actions > Modify.

Result:

A popup form is displayed for the selected entity.

............................................................................................................................................................

6 Change the Start Date, Start Time, or both.

............................................................................................................................................................

7 Select OK.

Result:

The selected scheduled entity is modified.
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Filter the Display of Scheduled Entities on the Scheduled List
....................................................................................................................................................................................................................................

Purpose This procedure is used to filter the display of the scheduled entities on
the Scheduled List.

Task Complete these steps to filter the display of the scheduled entities
on the Scheduled List.
............................................................................................................................................................

1 On the Network Map, select Administration > Scheduled List.

Result:

The Scheduled List Query Box is displayed.

............................................................................................................................................................

2 Enter a Scheduled Entity.

............................................................................................................................................................

3 Select OK.

Result:

The Scheduled List form is displayed with the queried
information.

............................................................................................................................................................

4 Select the Scheduled Entity.

............................................................................................................................................................

5 Select View > Filter/Sort.

Result:

The Scheduled List Sort/Filter form is displayed.

............................................................................................................................................................

6 Select the Filter tab.

Result:

The Filter fields are displayed.

............................................................................................................................................................

7 In the Filter 1, Filter 2, and Filter 3 fields, select a field from the
drop-down menu, then enter a value to the right of your selection.
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............................................................................................................................................................

WARNING
When the Date or Time fields are selected, enter the From
and To date values in the appropriate fields.

8 Select OK.

Result:

The filtered entities are displayed on the Scheduled List form.
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View Successful/Failed Scheduled Entities Through the
Scheduled History List
....................................................................................................................................................................................................................................

Purpose This procedure is used to query for a historical list of scheduled
entities that were successfully completed or that failed during
reinstatement.

Task Complete these steps to query for a historical list of
successful/failed scheduled entities.
............................................................................................................................................................

1 On the Network Map, select Administration > Scheduled History
List.

Result:

The Scheduled History List Query Box is displayed.

............................................................................................................................................................

2 Enter a Scheduled Entity.

............................................................................................................................................................

3 Enter a Schedule Type from the menu.

............................................................................................................................................................

4 Select OK.

Result:

The Scheduled History List form is displayed with the queried
information.
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8 Reliability and Service Recovery

Overview
....................................................................................................................................................................................................................................

Purpose This chapter contains tasks performed to insure the reliability of
Navis™ Optical NMS. It also contains system recovery tasks to use if
Navis™ Optical NMS becomes unavailable, a routine maintenance
task, and tasks associated with redundancy configurations.
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Section I: Perform Backups

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to perform various types of backups.

Regular backups The system can be set to perform daily backups. The time for the
daily backups is set in the cron file. For information on how to edit
the cron file, see Chapter 3, “System Administration”.

Host database backup Two types of backup are available to HP server systems:

• Hot backup

• Cold backup

Hot backups occur when the system is up and running (hot). Cold
backups occur when the Navis™ Optical NMS is shut down (cold).
The hot backup takes longer to complete than the cold backup, but the
hot backup can be initiated while the Navis™ Optical NMS application
is running. The application must be stopped before a cold backup can
be initialized.

Hot backup The system automatically backs up the database on Sunday, Tuesday,
Wednesday, Thursday, and Friday at 2:00 a.m. if a tape is present in
the tape drive. A customer may alter the run frequency of hot backups
by changing the run time in the cron file.

The system also performs a hot backup to machines in simplified
geographic redundancy configurations. See “Simplified and full
geographic redundancy configurations” (8-18) within this chapter for
details.

The system is required to be at run level 4 for hot backup.

No operator action is required during the hot backup, which takes
from 60 to 180 minutes to complete, depending on the size of the
database. The default database backup retention is 5 days (5
tapes/rotation).

Important! It is recommended that you maintain backup tape in
the standby HP 9000 server.
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Cold backup A cold backup is the most accurate type of backup.

Operator action is required during the cold backup procedure. The
system is required to be set at run level 3 for cold backup. The system
must be down to run cold backups. It is recommended that cold
backups are run every week, however it is up to the customer to
determine run frequency.

Contents
Perform a Hot Backup 8-5

Perform a Cold Backup 8-6
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Perform a Hot Backup
....................................................................................................................................................................................................................................

Purpose A hot backup occurs daily as the result of an entry in the cron file.
This backup occurs when the system is up and running.

The following describes how to manually run a hot backup at a time
other than when it is scheduled to run in cron.

Task Complete these steps to perform a hot backup.
............................................................................................................................................................

1 Using the system console, log into the system as root.

............................................................................................................................................................

2 Remove the daily backup tape and insert the hot backup tape into the
tape drive.

Important! Wait until the lights on the tape drive stop flashing.

............................................................................................................................................................

3 Enter /bin/ksh /usr/dacscan/bin/hot_backup.

Result:

The hot backup begins. It takes 60 to 180 minutes to complete.
The # prompt is issued to the system console once the backup is
completed.

............................................................................................................................................................

4 Remove the hot backup tape.

............................................................................................................................................................

5 Label the tape hot backup and add the:

• current date

• host server name

............................................................................................................................................................

6 Store the tape in a safe place.

Result:

The hot backup is complete.

............................................................................................................................................................

7 Insert the daily backup tape into the tape drive.
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Perform a Cold Backup
....................................................................................................................................................................................................................................

Purpose A cold backup occurs when the NMS is shutdown (cold). This task
should be completed once a month.

Task Complete these steps to perform a cold backup.
............................................................................................................................................................

1 Using the system console, log into the system as root.

............................................................................................................................................................

2 At the prompt, type init 3 to stop the Navis™ Optical NMS
application.

Reference:

For instructions, see the section “Stop the Navis™ Optical NMS
Application on a Specific Server using SAM” (3-28), in Chapter
3, “System Administration”.

............................................................................................................................................................

3 Log in to the Navis™ Optical NMS server as root.

............................................................................................................................................................

4 Remove the daily backup tape and insert the cold backup tape into
the tape drive.

............................................................................................................................................................

5 Wait until the lights on the tape drive stop flashing.

............................................................................................................................................................

6 Enter /bin/ksh /usr/dacscan/bin/cold_backup.

Result:

The cold backup begins. It takes approximately 40 minutes to
complete. The # prompt is issued to the system console once the
backup is completed.

............................................................................................................................................................

7 Remove the cold backup tape.

............................................................................................................................................................

8 Label the tape cold backup and add the current date and host server
name.
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............................................................................................................................................................

9 Store the tape in a safe place.

............................................................................................................................................................

10 Insert the daily backup tape into the tape drive.

Result:

The backup is complete.

............................................................................................................................................................

11 At the prompt, enter shutdown -ry 0 to reboot the host server to
clean up UNIX system files.

Result:

The host server shuts down and restarts, which takes
approximately 10 minutes. The prompt redisplays once the
process is completed.

............................................................................................................................................................

12 Log into the system as root.

............................................................................................................................................................

13 At the prompt, enter init 4 to start the Navis™ Optical NMS
application.

Result:

The application is started.

............................................................................................................................................................

14 Optional: Enter top to display the status of the start process. Press the
Ctrl and c keys to exit the display.
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Section II: Perform Recoveries

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to perform various types of recoveries.

Contents
Recovering Hot or Cold Backups 8-9
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Recovering Hot or Cold Backups
....................................................................................................................................................................................................................................

Introduction Two types of recovery are available:

• Recovering a hot backup

• Recovering a cold backup

Recovering a Hot Backup Hot backups are recovered using the hot_recover script. The Navis™

Optical NMS application must be shut down to perform this
procedure.

Recovering a Cold Backup Cold backups are recovered using the cold_recover script. The Navis™

Optical NMS application must be shut down to perform this
procedure.

Recovering the database
to a different server

The database can be recovered onto a different server after a hot
backup is completed.

Assumptions

• Both systems have network connectivity to all workstations,
external servers, and network elements. This connectivity
establishes a disaster recovery site.

• The systems have been installed with an identical release of the
Navis™ Optical NMS application, including identical environment
variable settings.

• The systems have both been licensed for identical features and
network elements.

• The system administrators at both sites are synchronizing the
following files:

- /etc/passwd

- /etc/hosts

- /usr/dacscan/oam/config_data/cm/ccpm/ccpconfig (all
references to hostnames except those that contain the local
hostname)

- users accounts (use the HP-UX system administration tool,
SAM).
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Perform a Hot Backup Recovery
....................................................................................................................................................................................................................................

Purpose Use this procedure to perform a hot backup recovery.

Before You Begin Be sure that you have the hot backup tape containing the:

• current date

• host server name

Task Complete these steps to perform a hot backup recovery.
............................................................................................................................................................

1 Using the system console, log into the system as root.

............................................................................................................................................................

2 At the prompt, type init 3 to stop the Navis™ Optical NMS
application.

Reference:

For instructions, see the section “Stop the Navis™ Optical NMS
Application on a Specific Server using SAM” (3-28), in Chapter
3, “System Administration”.

............................................................................................................................................................

3 Insert the hot backup tape into the tape drive.

............................................................................................................................................................

4 Wait until the lights on the tape drive stop flashing.

............................................................................................................................................................

5 At the prompt, enter su - dacscan.

............................................................................................................................................................

6 At the prompt, enter /bin/ksh /usr/dacscan/bin/hot_recover.

Result:

The hot backup recovery begins, which takes approximately 90
minutes. The # prompt is issued to the system console once the
hot backup recovery is completed.

............................................................................................................................................................

7 Remove the tape.
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............................................................................................................................................................

8 Label the tape with the current date, and store the tape in a safe place.

Result:

The hot backup recovery is complete.

............................................................................................................................................................

9 At the prompt, enter init 4 to start the Navis™ Optical NMS
application.

Result:

The application is started.
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Perform a Cold Backup Recovery
....................................................................................................................................................................................................................................

Purpose Use this procedure to perform a cold backup recovery.

Before You Begin Be sure that you have the cold backup tape containing the:

• current date

• host server name

Task Complete these steps to perform cold backup recovery.
............................................................................................................................................................

1 Using the system console, log into the system as root.

............................................................................................................................................................

2 At the prompt, type init 3 to stop the Navis™ Optical NMS
application.

Reference:

For instructions, see the section “Stop the Navis™ Optical NMS
Application on a Specific Server using SAM” (3-28), in Chapter
3, “System Administration”.

............................................................................................................................................................

3 Insert a tape with a valid cold backup into the tape drive.

............................................................................................................................................................

4 Wait until the lights on the tape drive stop flashing.

............................................................................................................................................................

5 At the prompt, enter su - dacscan.

............................................................................................................................................................

6 Enter /bin/ksh /usr/dacscan/bin/cold_recover.

Result:

A prompt appears and asks for the date of the backup tape.

............................................................................................................................................................

7 Enter YYYYMMDD (or YYMMDD for older tapes).

Important! The date entered must match the date on the backup
tape.
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Result:

The cold backup recovery begins, which takes approximately 90
minutes. The # prompt is issued to the system console once the
backup is completed.

............................................................................................................................................................

8 Remove the tape.

............................................................................................................................................................

9 Label the tape with the current date, and store the tape in a safe place.

Result:

The cold backup recovery is complete.

............................................................................................................................................................

10 At the prompt, enter init 4 to start the Navis™ Optical NMS
application.

Result:

The application is started.
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Recover the Database to a Different Server
....................................................................................................................................................................................................................................

Purpose This procedure is used to recover the database to a different server.
This task can be used for system upgrades, or when it is necessary to
analyze data when trouble clearing.

Before You Begin This task can only be performed after a hot backup has been
completed. In addition:

• Create a hot backup tape at the site which has the source
database, using the “Perform a Hot Backup” (8-5) task.

• Ensure that the destination system is at run level 3. Refer to “init
Command for Changing Run Levels” (C-2).

• Recover the hot backup tape at the destination site, using the
“Perform a Hot Backup Recovery” (8-10) task.

• On each workstation ensure that:

- the hostnames/IP addresses for both Navis™ Optical NMS
systems (source and destination) are in /etc/hosts

- the hostnames for both Navis™ Optical NMS systems
(source and destination) are present in /.rhosts

- the hostnames for both Navis™ Optical NMS systems
(source and destination) are present in
/home/dacscan/.rhosts

Task Complete these steps to recover the database to a different server:
............................................................................................................................................................

1 Using the system console, log in as dacscan on the Navis™ Optical
NMS server.

............................................................................................................................................................

2 Enter ksh /usr/dacscan/bin/local.sh.

Result:

This script resets the “active controller” field in the database
with the name of the new hostname.
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............................................................................................................................................................

3 Refer to ITM-SC or Navis™ Optical EMS documentation for
procedures to enable the EMS to accept connection requests from the
new Navis™ Optical NMS host.

............................................................................................................................................................

4 For any network elements that require knowledge of the connecting
manager, refer to the appropriate documentation for procedures to
enable connections.

............................................................................................................................................................

5 For each user on each workstation, reset the name of the Navis™

Optical NMS to which the user should connect.

............................................................................................................................................................

6 Enter the command init 4 to bring the system to run level 4.

Result:

The Navis™ Optical NMS application is started.

Section II: Perform Recoveries
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Section III: Delete History

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the delete history tool.

Contents
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About this Tool
....................................................................................................................................................................................................................................

Background Whenever a circuit is rearranged, the data from the previous circuit is
retained in the Navis™ Optical NMS database. A circuit that has been
rearranged several times accumulates a large amount of history
information. The Delete History script retains only the necessary
historical data associated with each circuit, and deletes all unnecessary
historical data from the database.

The Delete History script consists of two parts:

• A script that automatically runs once, when upgrading the
database to a new version. If you need to refer to any circuits
listed in the history that are not the most recent non-RS
(restoration), non-RI (reinstatement) circuits, you should print out
these circuits before upgrading the database. The Delete History
script will delete these circuits from the history during the
upgrade.

• A daily script execution that runs immediately following each
successful daily backup.
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Section IV: Redundancy

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the redundancy configurations available to
support Navis™ Optical NMS and Element Management System
(EMS) failures, which include local redundancy and simplified and
full geographic redundancy.

Geographic redundancy
configurations

Geographic redundancy configurations provide site protection by
maintaining a primary and a standby server in separate locations and
ensuring that the two servers are far enough apart so that natural
disasters or adverse weather conditions cannot affect the servers at the
same time.

There are two types of geographic redundancy: simplified and full.
Both consist of a primary Navis™ Optical NMS server connected to a
standby Navis™ Optical NMS server.

Simplified and full
geographic redundancy

configurations

Simplified and full geographic redundancy configurations differ in the
frequency in which updates occur to the standby server’s database.
For example, for simplified geographic redundancy, data is transmitted
from the primary server to the standby server during the hot backup
process. Full geographic redundancy updates the standby server’s
database every 30 minutes through Navis™ Optical NMS’s geographic
redundancy software which manipulates Oracle files to perform the
regular updates. If there is a failure, no more than 30 minutes of
operations should be lost.

Note that there may be user activity on the standby server in the
simplified geographic redundancy configuration however no user
activity is permitted on this server in the full redundancy
configuration.

Full geographic
redundancy switchovers

When a failure occurs to Navis™ Optical NMS servers, the full
geographic redundancy process protects availability through its
switchover process. Similarly, EMS geographic redundancy
switchovers protect the availability of EMS servers. For both
scenarios, procedures are available to address how to maintain Navis™

Optical NMS-EMS connectivity.
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Navis™ Optical NMS
geographic redundancy

commands

Several Navis™ Optical NMS geographic redundancy commands are
used to either set up the standby database, or reinitialize the primary
database. These commands are:

• InitializeStandby.sh creates a standby database on a standby
machine and completes a Full Geographic Redundancy
environment between the primary and standby machines.

• GR_Oracle.sh performs common functions related to the Oracle
database, which includes how to retrieve system date, how to
revoke or grant privileges, and how to retrieve information of
Oracle files or archive logs.

• OnlineStandby.sh runs on the standby database only in the
event of a disaster, at which time it activates the standby
database.

• SwitchOver.sh performs switchover or switchback between
primary and standby databases.

• AlterStandby.sh synchronizes primary and standby databases or
takes a data file off-line on a standby database after physical
structure of primary database was altered.

• CleanGRARCH.sh cleans the geographic redundancy archive file
system.

Navis™ Optical NMS local
redundancy switchover

The standby server has a pulse process that monitors the heartbeat of
the primary server. These processes can be started and stopped
manually. The pulse process resides on the standby server. This
process is used to determine whether the primary server is alive. The
heartbeat process resides on the primary server. This process is used
as a detection mechanism to initiate automatic switchover for Navis™

Optical NMS local redundancy configurations.

Local redundancy
configuration switches to

the standby server

The local redundancy configuration is supported by HP’s
MC/ServiceGuard paradigm in which the primary and standby servers
are connected to the same database. In this paradigm, the primary and
the standby systems are treated as a cluster, and applications are
bundled into packages, which can be launched on either machine in
the cluster. When one machine in a cluster detects the loss of
heartbeat from the other machine, the cluster is reformed without the
failed machine. Any packages run on the failed machine are migrated
to, and restarted on, the remaining machine. For applications that can
take advantage of distributed computing, this solution allows the full
resources of both machines to be utilized.

Section IV: Redundancy
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The incorporation of MC/ServiceGuard results in a local redundancy
configuration with distinct Switchover/UX-like characteristics, namely
a primary and a standby system. The entire application—with all its
assets, is bundled as a single package and configured to run in a
single instance. The MC/ServiceGuard configuration offers some
failover performance over the Switchover/UX configuration, because a
reboot is no longer required as part of the switchover.

Automatic and manual
switchovers

Automatic switchovers occur when there is a link loss or when there
is a failure of an association between a primary server and a network
element. Manual switchovers occur when a user manually initializes a
switchover to a standby server. Navis™ Optical NMS geographic
redundancy configurations require manual switchover processing,
while its local redundancy configurations feature automatic
switchover.

Navis™ Optical NMS supports manual switchovers for the ITM-SC
EMS and manual and automatic switchovers in Navis™ Optical EMS.
(See “EMS Switchovers” (8-22) for details). The support is designed
to assure maximum availability of Navis™ Optical NMS while
minimizing the downtime of the subtending EMS population, where
several switchovers can be expected. While local redundancy
switchovers are always automatic, the EMS geographic redundancy
switchover process occurs manually only in the earlier releases of
Navis™ Optical EMS (for example, R5.0) while Navis™ Optical EMS
R5.1 supports both manual and automatic switchovers.

For example, in Navis™ Optical EMS releases earlier than R5.1, a
command is entered to initiate switchover. Newer releases of Navis™

Optical EMS (Release 5.1 and beyond), manual switchovers are
handled through a Cluster Administrator GUI, which may be set up to
support manual or automatic switchovers.

Navis™ Optical EMS
Cluster Administration GUI

The Navis™ Optical EMS Cluster Administration GUI contains two
icons to support local and remote servers. When a failure occurs, an
’X’ displays on the failed server’s icon, which is displayed in Navis™

Optical EMS. The ’X’ clears once communication is re-established to
the server.

In order to provide an instant status to Navis™ Optical NMS
personnel, it is recommended that the GUI is placed on a convenient
workstation at the Navis™ Optical NMS work center.

Section IV: Redundancy
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Supporting EMS/Navis™

Optical NMS server failures
When failures occur to the Navis™ Optical EMS and ITM-SC EMS
servers, they are automatically resolved through redundancy software
intervention methods in place or they must be resolved manually
through EMS system administrator intervention.

Manual intervention varies by EMS server type, release number, and
redundancy type. It also differs depending upon whether the failure
occurs on the EMS side or the Navis™ Optical NMS side.

The following tasks define the steps that need to be performed by
Navis™ Optical NMS system administrators after any switchover
occurs to an EMS server.

Contents
EMS Switchovers 8-22

Restart Navis™ Optical NMS Communication with
EMS Servers

8-25

Restart Navis™ Optical NMS Communication with
Navis™ Optical EMS Local Redundancy Servers

8-26

Restart Navis™ Optical NMS’s Communication with
Navis™ Optical EMS Geographic Redundancy
Servers

8-27

Restart Navis™ Optical NMS’s Communication with
ITM-SC servers

8-28

Switch the Roles of the Servers (Simplified or Full
Geographic Redundancy Configuration)

8-29
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EMS Switchovers
....................................................................................................................................................................................................................................

Navis™ Optical EMS
switchover behavior (for
geographic redundancy

configurations)

During the initial installation of the complex containing Navis™

Optical EMS servers in a geographic redundancy configuration, the
add.controller command is entered twice in Navis™ Optical NMS.
More specifically, the command is entered one time per Navis™

Optical EMS server.

Before a switchover occurs, the Navis™ Optical EMS primary and
standby servers in a geographic redundancy configuration display on
the Navis™ Optical NMS Network Controller Map as two green icons.

The two servers are distinguished by their adjacent ″Controller Name”
labels.

Assuming that Server A in this configuration is Active and Server B
is in Standby mode, when Navis™ Optical EMS Server A fails, its
icon turns to magenta while Server B’s icon remains green. Once the
Navis™ Optical EMS switchover occurs, about 7 minutes elapse
between Server A’s failure and Server B’s new status. When Server A
is repaired by the Navis™ Optical EMS staff, Server A’s icon becomes
green again, and two green icons display on the Navis™ Optical NMS
Network Controller Map.

At this point, there is no Navis™ Optical NMS manual
re-synchronization action required. Note that when the switchover
occurred, Navis™ Optical NMS had interrupted communications to
Navis™ Optical EMS Server A, however it held the orders during the
7 minute time frame and then resumed communication with Navis™

Optical EMS Server B.

Navis™ Optical EMS
switchover behavior (for

local redundancy
configurations)

In Navis™ Optical EMS local redundancy configurations, the Navis™

Optical EMS MC/ServiceGuard cluster is assigned an arbitrary
designation name, such as <C_arbitrary_designation_name> which
serves as a Package IP address.

During the initial installation of Navis™ Optical EMS servers in a
local redundancy configuration, the add.controller command must
be used to uniquely support the Package IP address representing the
cluster.

The actual Navis™ Optical EMS primary and standby servers within
the cluster (for example, Server A and Server B) are designated in the
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/etc/hosts file of the Navis™ Optical NMS server with their
fully-qualified name, such as <servername>.<full_name>.com.

Before a switchover occurs, the Navis™ Optical EMS cluster in a local
redundancy configuration displays on the Navis™ Optical NMS
Network Controller Map as one green icon.

Assuming that Server A in this configuration is Active and Server B
is in Standby mode, when Navis™ Optical EMS Server A fails, the
icon turns to magenta for 3 to 5 minutes, after which the Navis™

Optical EMS local redundancy switchover occurs. Once switchover is
complete, the icon turns back to green and Navis™ Optical NMS
operation continues as usual with Navis™ Optical EMS Server B as
Active.

At this point, there is no Navis™ Optical NMS manual
re-synchronization action required. Note that when the switchover
occurred, Navis™ Optical NMS had interrupted communications to
Navis™ Optical EMS Server A, however it held the orders during the
3-5 minute time frame and then resumed communication with Navis™

Optical EMS Server B.

ITM-SC switchover
behavior

When ITM-SC servers experience a failure, the icons (in the
geographic redundancy configuration) representing the failed machine
changes its color.

On the Network Controller Map, the failed server’s icon changes from
green to magenta. This indicates that Navis™ Optical NMS has lost
communications with the failed machine. Navis™ Optical NMS
attempts to regain communication with the failed machine.

When the failed ITM-SC machine does not recover, switchover
processing occurs in the background on the ITM-SC side to change
the standby machine to the primary machine. The switchover occurs
either automatically (through software intervention) or manually by
the ITM-SC network operator. Once switchover is complete, the icon
turns back to green and Navis™ Optical NMS operation continues as
usual with the alternate ITM-SC server in Active state.
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Detecting EMS
switchovers

While the icon(s) changes colors on the Network Controller Map
when EMS switchovers occur, it may not be clear as to exactly when
the EMS switchovers occur. The restoration is automatic, yet there
may be critical provisioning that must be re-sent because orders were
placed in pending state during the switchover. A notification process is
in place for newer releases of Navis™ Optical EMS through the
Cluster Administration GUI. This process notifies Navis™ Optical
NMS administrators (by a call, page, or email message), that a
switchover has occurred.

Since the notification process is not in effect for ITM-SC switchovers
or in prior releases of Navis™ Optical EMS, it is important to contact
the network operator(s) responsible for the EMS in question if it is
unclear as to which server is primary.
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Restart Navis™ Optical NMS Communication with EMS Servers
....................................................................................................................................................................................................................................

Restart Navis™ Optical
NMS communication with

EMS servers

When icons representing EMS servers appear magenta for an extended
period of time, use one of the following tasks to initiate
communication to the EMS servers.

• To restart communication to Navis™ Optical EMS servers in a
local redundancy configuration, see “Restart Navis™ Optical
NMS Communication with Navis™ Optical EMS Local
Redundancy Servers” (8-26).

• To restart communication to Navis™ Optical EMS servers in a
geographic redundancy configuration, see “Restart Navis™

Optical NMS’s Communication with Navis™ Optical EMS
Geographic Redundancy Servers” (8-27).

• To restart communication to ITM-SC servers, see “Restart
Navis™ Optical NMS’s Communication with ITM-SC servers”
(8-28).

For additional information, see the Database Maintenance chapter in
the Navis™ Optical EMS Administration Guide or the Geographic
Redundancy chapter of the ITM-SC Release 7.0 Administration
Guide.
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Restart Navis™ Optical NMS Communication with Navis™

Optical EMS Local Redundancy Servers
....................................................................................................................................................................................................................................

Purpose This procedure is used to restart Navis™ Optical NMS communication
with Navis™ Optical EMS servers residing in a local redundancy
configuration. This task would be performed if the color of the icon
representing the Navis™ Optical EMS cluster does not change from
magenta to green after 5 minutes.

Task Use the following steps to restart communication to Navis™

Optical EMS local redundancy servers.
............................................................................................................................................................

1 On the Network Map, select File > Open Network Controller Map.

Result:

The Network Controller Map displays.

............................................................................................................................................................

2 Select the icon representing the Navis™ Optical EMS cluster
configuration, click the left mouse button, and select Session > Start
Communication.

Result:

A dialog box containing the following text displays: START
SESSION COMMAND SENT FOR FRAME:<ems_ name>.

............................................................................................................................................................

3 On the dialog box, click OK.

Result:

Communication should start.

............................................................................................................................................................

4 If communication does not start, contact the network operator(s)
responsible for the Navis™ Optical EMS local redundancy servers.
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Restart Navis™ Optical NMS’s Communication with Navis™

Optical EMS Geographic Redundancy Servers
....................................................................................................................................................................................................................................

Purpose This procedure is used to restart Navis™ Optical NMS’s ability to
communicate with Navis™ Optical EMS servers residing in a
geographic redundancy configuration. This task would be performed if
the color of the icon representing a Navis™ Optical EMS server does
not change from magenta to green after 7 to 15 minutes.

Task Use the following steps to restart Navis™ Optical NMS’s ability
to communicate with Navis™ Optical EMS geographic redundancy
servers.
............................................................................................................................................................

1 On the Network Map, select File > Open Network Controller Map.

Result:

The Network Controller Map displays.

............................................................................................................................................................

2 Select the icon representing the Navis™ Optical EMS geographic
redundancy configuration, click the left mouse button, and select
Session > Start Communication.

Result:

A dialog box containing the following text displays: START
SESSION COMMAND SENT FOR FRAME:<ems_ name>

............................................................................................................................................................

3 On the dialog box, click OK.

Result:

Communication should restart.

............................................................................................................................................................

4 If communication does not restart, contact the network operator(s)
responsible for the Navis™ Optical EMS geographic redundancy
servers.
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Restart Navis™ Optical NMS’s Communication with ITM-SC
servers
....................................................................................................................................................................................................................................

Purpose This procedure is used to restart Navis™ Optical NMS’s ability to
communicate with ITM-SC servers residing in a geographic
redundancy configuration. This task would be performed if the color
of the icon representing the ITM-SC server does not change from
magenta to green after several minutes.

Task Use the following steps to restart Navis™ Optical NMS’s ability
to communicate with ITM-SC servers.
............................................................................................................................................................

1 On the Network Map, select File > Open Network Controller Map.

Result:

The icons representing the ITM-SC servers should display.

............................................................................................................................................................

2 Select the icon representing the ITM-SC server, click the left mouse
button, and select Session > Start Communication.

Result:

A dialog box containing the following text displays: START
SESSION COMMAND SENT FOR FRAME:<ems_ name>

............................................................................................................................................................

3 On the dialog box, click OK.

Result:

Communication should restart.

............................................................................................................................................................

4 If communication does not restart, contact the network operator(s)
responsible for the ITM-SC servers.
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Switch the Roles of the Servers (Simplified or Full Geographic
Redundancy Configuration)
....................................................................................................................................................................................................................................

Purpose This procedure is used to switch the roles of the HP servers (primary
becomes standby and standby becomes primary) when using the
simplified or full geographic redundancy configuration. This task is
performed, for example, when service is required to the primary
server.

Task Perform the step below to switch the roles of the servers.
............................................................................................................................................................

1 Log into the standby server as dacscan.

............................................................................................................................................................

2 Enter /usr/dacscan/bin/Switchover.sh.

Result:

The roles of the servers are switched. (Primary becomes standby
and standby becomes primary.)
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Section V: Geographic Redundancy Configuration

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to perform a task to support servers
residing in a geographic redundancy configuration.

Contents
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NMS Application

8-31

Reliability and Service Recovery

....................................................................................................................................................................................................................................

8 - 3 0 Lucent Technologies 365-309-264R7.0
Issue 1, July 2002



View Which Server is Running the Navis™ Optical NMS
Application
....................................................................................................................................................................................................................................

Purpose This procedure is used to view which server is running the Navis™

Optical NMS application on an HP server configured for geographic
redundancy.

Task Complete these steps to view which server is running the
application:
............................................................................................................................................................

1 Do one of the following:

• Enter cat /install/GR.role

• On the Network Controller Map, locate the labeled Navis™

Optical NMS icon.
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Section VI: Routine Maintenance

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to perform a routine maintenance task to
support single servers.

Contents
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Clear Single Server Buffers
....................................................................................................................................................................................................................................

Purpose This task is used periodically to clear the buffers on single servers
only.

Task Complete these steps to clear single server buffers.
............................................................................................................................................................

1 Log into the single server as root.

............................................................................................................................................................

2 At the prompt, enter init 3.

Result:

Navis™ Optical NMS application is stopped.

............................................................................................................................................................

3 At the prompt, enter who -r.

Result:

A message displays indicating the current run level and when
the machine was last rebooted, such as

run-level 3 Dec 30 11:26 3 0 S.
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9 Off-Line Tools

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes off-line script tools provided with Navis™

Optical NMS. It also contains tasks associated with off-line tools.

Contents
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9-10
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9-19
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9-23
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Tools

9-27
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9-29
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9-35
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Delete an ITM-SC Controlled Network Element
from a Digital Link using REMOVENODE

9-40

Delete a Navis™ Optical EMS-Controlled Network
Element from a Digital Link Using
REMOVENODE

9-43
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Section I: Auto-Discovery Tool

Overview
....................................................................................................................................................................................................................................

Purpose The Auto-Discovery Tool is a UNIX script that is used off-line from
Navis™ Optical NMS in two instances:

• When new customers with an existing live network (not yet or
already managed by an element management system), wish to
migrate their network management to Navis™ Optical NMS.

• When existing Navis™ Optical NMS customers who already have
part of their network managed by Navis™ Optical NMS, wish to
move another part of their network under Navis™ Optical NMS
management.

The Auto-Discovery tool performs two different tasks, which users
can combine or run singly:

• Discover the network’s connection layout based on input files.
The Auto-Discovery tool uses input files provided by the EMS to
locate (discover) the connection’s layout and will only discover
connections defined by the data provided by the EMS. If the file
defines only one part of a connection, a manual merging may be
later needed to connect the connection’s different sections.
The Auto-Discovery tool performs connection discovery in two
phases. In the first phase, it discovers VC-4 layer connections; in
the second phase, it discovers low-order connections. The tool
can discover VC4-4c and AU3 connections during the first or
second phases.

• Provision the discovered connections into Navis™ Optical NMS.
For each discovered assignable path, the tool can automatically
provision a circuit to ride exactly on the path.

Initially, the Auto-Discovery tool is run to discover and provision
paths. It is then run to provision the circuits riding on top of the
discovered paths. The tool discovers the VC-4 and structured
connections in the same run. When the combo option is set, the tool
achieves discovery of the lower order connections and their circuits in
the same run.

This tool is used for a large number of circuits. If there are only a few
circuits to be discovered, the In-effect order may be used.
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Prerequisites Before using this tool:

1. All digital links belonging to the migrated or discovered network
must first be (manually) provisioned in the Navis™ Optical NMS
before the Auto-Discovery tool can be run.

2. Two input files, a port file and a cross connect file must be
extracted from each EMS. These extractions are provided by
running a script file in the EMS. See “Data import interface”
(9-7) for details.

Using the tool The tasks that use this tool are provided after this description.

Restrictions The following restrictions apply to the Auto-Discovery tool:

• Users must run the tool while the Navis™ Optical NMS host is
running.

• While the tool is running, do not continue operational and
provisioning procedures through Navis™ Optical NMS as it will
slow down the tool’s performance. Auto-Discovery tool could fail
if the user tries to access the same resources as the tool.

• Commands are not sent to the network element level.

• Several instances of the tool cannot run simultaneously.

• It is possible to run the tool to discover several levels of
connections. It is not, however, possible to discover high-order
(VC-4) and low-order connections within the same run.

• The connections discovered by the tool may already have some
alarms raised or may be affected by a server failure.

• Input files describe the subnetwork involved in the
auto-discovery. The tool supports filtering of these input files.

• Users attempting to merge connections after path discovery may
have to first delete the circuit before being able to merge the
path.

Supported network
elements and connection

types

For a complete list of supported network elements and connection
types (circuits, combos, and paths), see the Navis™ Optical NMS
Provisioning Guide for details.
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Unsupported connection
types

The following connections are not supported by the Auto-Discovery
tool:

• loopback on Navis™ Optical NMS DACS

• one-way or broadcast connections

• single-node connection—that is, a connection where
A_NE=Z_NE

• the discovery of connections running through or ending on a
black box

Parameters The Auto-Discovery tool supports command line parameters and
prompt options. If a user specifies a command line parameter, the tool
prompts the user to confirm the parameters. If the user does not
specify any parameter, the auto discovery tool prompts the user to
confirm each of the following parameters:

• Input file names (default or new).

• WAIT_TIME (default or new) is the waiting period (in seconds)
between two connection provisioning commands sent to Navis™

Optical NMS from the Auto-Discovery tool. It prevents Navis™

Optical NMS from being congested by a burst of provisioning
commands. The default is 20 seconds.

• Network element models (when a model file is used). The user
input file specifying models is located at /tmp/modelslist.

• Network elements file (if a network element file is used). By
default, the user input file specifying the list of network elements
is located at /tmp/nes_list. Note: ITM-SC does not support the
Network elements file option.

• Element management system files (if used). The default location
for the EMS files used by the tool are located at /tmp/ems.port
(for the port file) and /tmp/ems.xc (for the cross-connect file).

Log files The Auto-Discovery tool generates three log files to track discovered
and provisioned connections. The three log files are:

• /tmp/auto_disc/auto_disc.log

• /tmp/auto_disc/end2end.log

• /tmp/auto_disc/send_g2.log
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Discovered connections logs

When the Auto-Discovery tool discovers a connection, it is logged to
/tmp/auto_disc/newckts. Each record consists of one line, and each
line consists of A_NE:Z_NE:type:id:ckt_id. Paths and combos are
written to a flat file located at /tmp/auto_disc/path_G2.line and
circuits are written to /tmp/auto_disc/ckt_G2.line.

The creation of a log file does not indicate that a connection has been
successfully provisioned. The connection may be left in a pending
state in Navis™ Optical NMSNavis™ Optical NMS if an error occurred
during provisioning. It is possible to reapply the pending connections
through Navis™ Optical NMS.

Provisioned connections logs

When a discovered connection is provisioned in Navis™ Optical NMS,
it is logged to the file /tmp/auto_disc/provckts. Each record consists
of one line. Each line consists of A_NE:Z_NE:type:id:ckt_id.

When a discovered connection is provision in Navis™ Optical NMS, it
is also logged in a specific format to be used as an input for the
connection renaming tool. Only one port is logged for each
provisioned connection. The file is located at
/tmp/auto_disc/renameckts.

Error Log Files

The Auto Discovery tool stores any errors in a log file located at
/tmp/auto_disc/circuit.err. In addition to data validation errors, the
tool also logs any layout inconsistencies and unsupported connection
configurations.

Tool files The following files affect the use of the auto-discovery and
connection renaming tool:

• Network element model file

• Network element file

• Rate file

The Network element model file

The model file restricts the domain of the Auto-Discovery tool. The
Auto-Discovery tool only discovers the connections that run through
network elements whose models are specified within this file.

For a complete list of models, see the Navis™ Optical NMS
Provisioning Guide for details.
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The Network Element file

The network element file restricts the domain of Auto-Discovery tool.
The Auto-Discovery tool will only discover the connections that run
through the network elements specified by this file. Please refer to the
Navis™ Optical NMS Provisioning Guide for details.

The Rate file

The rate file restricts the connection types discoverable by the
Auto-Discovery tool. The following rates are allowed in the file:

• VC4-64c

• VC-16c

• VC4-4c

• VC4

• AU3

• VC3

• VC2

• VC12

Data import interface The Auto Discovery tool’s data import interface allows for the
importation of data from an element management system to a network
management system.

The data import interface consists of two files: a cross-connect file
and a port file. The EMS extraction tool extracts from the EMS
database all the ports and cross-connects supported by the
Auto-Discovery tool and save them into these two files.

For each EMS, the interface is applicable to any network element type
that supports at least one signal rate supported by the Auto-Discovery
tool. For a complete list of ITM-SC and Navis™ Optical EMS network
elements, see the Navis™ Optical NMS Provisioning Guide for
details.

The Cross-Connect file

The cross-connect file contains the supported rates for the
cross-connects. The file is applicable to the following rates:

• VC4-64c

• VC4-16c

• VC4-4c

• VC4
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• AU3 (high-order VC-3)

• VC3 (low-order VC-3)

• VC-2

• VC-12

Depending on the network elements, the fixed cross-connect may or
may not be part of the interface. For the WaveStar® ADM 4/1
STM-4, the fixed line to line AU4 cross-connects are part of the
interface. For the WaveStar® ADM 16/1 and Phase ADMs and TMs,
the fixed low-order cross-connect is not part of the interface when a
VC-4 trail terminates on a tributary card. VC-3/VC-12 fixed
cross-connects in the VC-4 are not returned.

For a protected cross-connect (SNCP), the protected port is mapped in
the toport parameter and the protecting port is mapped into the newto
port.

Table 9-1 Cross-Connect File Field Descriptions

Field Description

Field 1 EMS ID

Field 2 network element ID

Field 3 fromport address

Field 4 fromport physical type, for example, S16, S4,
S1, S0, C1, C3, DS3, DS1

Field 5 toport address

Field 6 toport physical type

Field 7 newto address

Field 8 newto physical type

Field 9 cross-connect type (P for Protected, T for
Unprotected)

Field 10 rate (VC-12/VC-2/VC-3/AU3/VC-4/VC4-4c/
VC4-16c/VC4-64c)
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The Port file

The port file contains the rates supported by the interface for ports.
The interface is applicable to the following rates:

• V4 (155 Mb/s or 140 Mb/s)

• VC-4 (140 Mb or VC-4 substructured)

• C3 (34 Mb)

• DS3 (45 Mb)

• C1 (2 Mb)

• DS1 (1.5 Mb)

• OC192/48/12/3 and EC1

For the low-order rates (all rates except VC-4), each port record
corresponds to a SDH TTP port on a PDH interface card. The port
information also includes information about the related PDH CTP
port, when applicable.

Note: The OC192/48/12/3 is for LambdaUnite™ MSS; EC1 is used for
WaveStar® BandWidth Manager only.

Table 9-2 Port File Field Descriptions

Field Description

Field 1 Network element identifier (TID) of EMS

Field 2 TID of network element

Field 3 Port address

Field 4 Physical Type

Field 5 param1

Field 6 param2

Field 7 pti_t

Field 8 pti_e

Field 9 pti_mode

Field 10 rate (C1, C3, DS3, DS1, VC4)
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Add or Migrate Networks to Navis™ Optical NMS Management
using the Auto-Discovery Tool
....................................................................................................................................................................................................................................

Purpose Use this task to add or migrate networks to Navis™ Optical NMS
management.

The auto-discovery tool is an off-line UNIX script that is used in two
instances:

• When new customers who already have an existing live network
(not yet or already EMS managed) wish to migrate their network
management to Navis™ Optical NMS.

• When existing Navis™ Optical NMS customers, who already
have a part of their network managed by Navis™ Optical NMS,
wish to include another part of a live network under Navis™

Optical NMS management.

Before you begin Before using the auto-discovery tool, note the following items:

• One or more element managed systems already manage the
network elements the auto-discovery tool will discover.

• At anytime, use [-h] to access screen help.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Use the following procedure to either migrate an existing live
network to Navis™ Optical NMS management or to add another
part of a live network already under Navis™ Optical NMS
management to a Navis™ Optical NMS-managed network.
............................................................................................................................................................

1 Run the EMS extraction tool, to extract the VC-4 data from each of
the EMS databases, and export the data to the EMS disk. Refer to the
ITM-SC documentation for instructions on this step.

............................................................................................................................................................

2 Copy the EMS files onto the Navis™ Optical NMS disk.

............................................................................................................................................................

3 Merge the EMS files into two files (the port and cross-connect files).

............................................................................................................................................................

4 Log in as dacscan.

Section I: Auto-Discovery Tool Off-Line Tools

....................................................................................................................................................................................................................................

9 - 1 0 Lucent Technologies 365-309-264R7.0
Issue 1, July 2002



............................................................................................................................................................

5 Enter /usr/dacscan/toolbin/auto_disc to discover the VC-4
connections and provision them into the NMS database using the
EMS data.

Result:

The system sends IE commands to the element management
system to verify the cross-connect and end ports used by the
discovered connections.

............................................................................................................................................................

6 Specify the tool parameters, the WAIT_TIME variable and filenames.
See “Specify Auto-Discovery Tool Parameters” (9-12) for details.

............................................................................................................................................................

7 Run the EMS extraction tool to extract the low-order data from the
EMS database and export it to the EMS disk.

............................................................................................................................................................

8 Copy the EMS files on to the Navis™ Optical NMS disk.

............................................................................................................................................................

9 Enter /usr/dacscan/toolbin/auto_disc to discover the low-order
connections and provision them in the NMS database using the EMS
data.

Important! When the combo option is installed, this can be
achieved in one run of the tool. When the combo option is not
set, this has to be achieved in at least two steps. The tool is first
run to discover and provision the paths. The tool is then run to
provision the circuits riding on top of the discovered paths.

Result:

IE commands are sent to the EMS to verify the cross-connect
and endports used by the discovered connections. The network
is then added or migrated to Navis™ Optical NMS management.
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Specify Auto-Discovery Tool Parameters
....................................................................................................................................................................................................................................

Purpose Use this task to specify auto-discovery tool parameters.

The auto-discovery tool uses user-provided input files to discover a
connection’s layout. The tool will only discover connections defined
by the data provided by the element management system. If the file
only defines one part of a connection, a manual merging may be
necessary to connect the connection’s different sections.

Task Use the following procedure to specify and confirm the
parameters used by the auto-discovery tool during operation.
............................................................................................................................................................

1 Log in as dacscan.

............................................................................................................................................................

2 Enter /usr/dacscan/toolbin/auto_disc. The auto-discovery tool
then prompts you to confirm the following parameters:

• If Function [-f y/d/p] is set to y (Navis™ Optical NMS), the tool
discovers connections and provisions them in the Navis™ Optical
NMS.
If it is set to d, the tool discovers connections, but does not
provision them.
If it is set to p, the tool provisions the already discovered
connections.

• Trail Type [-t path/ckt] specifies the connection type to discover.
It must be set to path (default) if combo was set as an
installation.

• If Send EMS [-s y/n] is set to y (default), it checks provisioned
connections against the element management system databases. If
it is set to n, the connections are not checked.

• Rate [-r VC-2/VC-3/VC-12/VC-4/VC4-4c/VC4-16c/VC4-64c]
causes the tool to only discover and provision the connections for
the list of rates given in the parameter. VC-4 cannot be selected
if a low-order rate (C3, C1, DS1, DS3) is selected. The default is
VC-12.
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• Domain [-m no/model/nes] restricts the domain of the connection
discovery process by filtering the EMS data with a list of
network element types (model) or a list of network elements
(nes). If set to no (default), the tool discovers all connections
described in the input files without restriction, ignoring the
existing model and network element files.

• Rate [-r VC-2/VC-3/VC-12/VC-4/VC4-4c/VC4-16c/VC4-64c]
Help [-h] displays user help information.

............................................................................................................................................................

3 Confirm the WAIT_TIME variable.

Result:

The complete command line will discover the VC-4 connections
and provision them into the Navis™ Optical NMS database using
the element management system data.
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Section II: Change Network Element ID Tool

Overview
....................................................................................................................................................................................................................................

Purpose When a name change occurs to an existing network element ID, the
change must be reflected in each application through which it is
managed.

This section describes how to change the identification of an existing
network element using the Change Network Element ID tool.

Change Network Element
ID script

Network Element IDs are changed in applications as a result of
running a change network element ID script. This script is first run at
the EMS-level to support name changes to ITM-SC or the Navis™

Optical EMS controlled network elements. After the script completes,
a change script is run at the Navis™ Optical NMS-level to support
network element name changes in the Navis™ Optical NMS
application. The final step is to run the script at the Navis™ PM -
MRP level.

Different change network element ID scripts are used in the ITM-SC,
the Navis™ Optical EMS, the Navis™ Optical NMS, and the Navis™

PM - MRP applications. The tasks included in this section capture
how each script is run.

Impact to other
applications

When Navis™ Optical NMS network elements are managed by the
Navis™ PM - MRP, the final step is to run the tool in the Navis™ PM
- MRP application.

Source File The first step of this process is to create a source file containing the
requested changes. This source file can be used by each script to
change ITM-SC or the Navis™ Optical EMS controlled network
element names.

Limitations Users should keep in mind the following limitations when renaming
an existing network element:

• The system does not perform any alphabetic ordering after the
network element name change.

• Subnet ID, Aggregate ID, and Controller Name changes are not
supported.
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• The system does not update any Kanji-related tables. This
limitation is only relevant for Japanese customers.

• For the changed name to be displayed, the user must restart the
user interface.

• If a network element is deleted, has its name changed, or its
Office identification does not have an associated TID name, it
remains on the Location Reference Table.

• The performance monitoring start time is lost after a
Management Information Base (MIB) download. Thus, any
required information from a network element’s performance
monitoring report must be obtained before its name is changed.

Contents
Change a TID using the CIT 9-16

Change Network Element Names in the Navis™

Optical EMS and in the Navis™ Optical NMS
9-19

Change Network Element Names in Navis™ Optical
EMS and Navis™ Optical NMS

9-23
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Change a TID using the CIT
....................................................................................................................................................................................................................................

Purpose This task describes how to change an network element target identifier
(TID) on a craft interface terminal (CIT).

Important! This must be done before the scripts are run.

Before you begin Consider the following:

• The user must ensure the uniqueness of the new network element
name.

• Changing a network element’s name should first be done in the
EMS that controls the network element. It is recommended that
users perform an EMS on-line archive before changing the
network element’s name.

• When renaming a network element, users must abide by a strict
naming convention. The new network element name should not
include a backslash character because it may not be supported.

Task Perform the following steps to change the target identifier of an
existing network element on the CIT:
............................................................................................................................................................

1 Log into the CIT of the network element.

............................................................................................................................................................

2 Right click on NE > Graphical (OSI) > <network element name>
and OK.

Result:

The System Type Selection dialog box is displayed.

............................................................................................................................................................

3 Select a network element from the list.

Result:

The NE Login Dialog box is displayed.

............................................................................................................................................................

4 Enter the login and password, and click OK.

Result:

A process dialog box is displayed, followed by a legal notice.
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............................................................................................................................................................

5 Click OK.

Result:

A form is displayed.

............................................................................................................................................................

6 Select Administration > Set TID and click OK.

Result:

A form is displayed.

............................................................................................................................................................

7 Select Fault > Enter/Exit Maintenance Condition > Enter
Maintenance Condition and click Yes.

Result:

A red, maintenance box is displayed at the lower right of the
form.

............................................................................................................................................................

8 Select Administration > Set TID and click OK and change the TID.

Important! The new network element name should not include a
backslash character because it may not be supported.

Result:

A form is displayed.

............................................................................................................................................................

9 Select Fault > Enter/Exit Maintenance Condition > Exit
Maintenance Condition and click Exit.

Result:

The WaveStar® CIT Confirmation dialog box is displayed.

............................................................................................................................................................

10 Click Yes.

Result:

The TID name change process is initiated. It is important to wait
for the change to be processed, which takes about 25 minutes,
before proceeding to the next step.
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............................................................................................................................................................

11 To verify the change, log into the CIT of the network element, enter
the password, and click OK. Refer to steps 1 through 4 for details.

............................................................................................................................................................

12 In the toolbar, select Update.

Result:

The new TID is displayed.
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Change Network Element Names in the Navis™ Optical EMS
and in the Navis™ Optical NMS
....................................................................................................................................................................................................................................

Purpose This task describes how to change existing network element identifiers
on the Navis™ Optical EMS using the change network element
identifier tool.

Processing Order After an existing network element TID is changed, this tool’s change
script is first run on an Navis™ Optical EMS server and then a script
is run on theNavis™ Optical NMS host server. This task contains the
commands to run the script on both servers.

If the Navis™ Optical NMS is being managed by a northbound
interface, such as Navis™ Optical PM - MRP, then the final step is to
run the tool in that application.

Before you begin Before changing the name of an existing network element, consider
the following items:

• Be sure that the name change has been made. See “Change a
TID using the CIT” (9-16) for details.

• Shut down the Navis™ Optical EMS before running the off-line
script. The user will not be able to communicate with the Navis™

Optical EMS at this time.

• Navis™ Optical NMS will only update the new name in the
Circuit IDs that are in M.1400 format. For Circuit IDs with
FREE FORMAT, it is the user’s responsibility to update the
Circuit IDs (using the Graphical Layout Parameters form).

• The Navis™ Optical NMS will not dynamically update any
current screen with the new network element ID name. From the
Network Map, the user must select File > Query Again to
display the new name.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Important! Because the Navis™ Optical EMS portion of this
script may change, please refer to the Navis™ Optical EMS user
documentation for updated information on how to run this script
on the Navis™ Optical EMS system.
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Perform the following steps to change the identification of an
existing network element. The steps used in the first part of this
task apply to the Navis™ Optical EMS host server while the
remaining steps apply to the Navis™ Optical NMS host server.
............................................................................................................................................................

1 From the Network Controller Map, right click the Navis™ Optical
EMS and Navis™ Optical NMS icons and then select Session > Stop
Communication.

Result:

Communication is disabled on the Navis™ Optical EMS and the
Navis™ Optical NMS.

............................................................................................................................................................

2 Log into the Navis™ Optical EMS host as ems and enter the password.

Result:

The user is logged into the Navis™ Optical EMS host.

............................................................................................................................................................

3 Use a text editor to create a file that contains the old and new
network element names.

Important! The new network element name should not include a
backslash character because it may not be supported. Be sure that
the created file contains one line each, in old_name|new_name
format separated with a | (pipe) character. A return must separate
each line.

............................................................................................................................................................

4 Use ftp to copy the created file to the Navis™ Optical NMS host
server.

Important! If the script must be run on the Navis™ Optical PM -
MRP, copy the file to the Navis™ Optical PM - MRP server also.

............................................................................................................................................................

5 At the prompt, enter tidchange -f <created_filename> -du -y .

Result:

The Navis™ Optical EMS is stopped and the renaming tool runs
on the Navis™ Optical EMS host server. Upon completion, the
Navis™ Optical EMS is brought back up.
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The remaining process may now begin on the Navis™ Optical
NMS host server.

............................................................................................................................................................

6 Log in to the Navis™ Optical NMS host server as dacscan.

............................................................................................................................................................

7 At the prompt, enter cd /usr/dacscan/toolbin.

Result:

The prompt resides at the directory in which the change_neid
tool is located.

............................................................................................................................................................

8 Retrieve the Navis™ Optical NMS node_mapping data file then type
mv node_mapping nms_snms_node.

Result:

The file is renamed tonms_snms_node. Note that the last line
of the nms_snms_node file must not contain a return (step 6).
The filename nms_snms_node is only recommended; any
filename can be used.

............................................................................................................................................................

9 At the prompt enter ./change_neid nms_snms_node.

............................................................................................................................................................

10 If a prompt is displayed, enter ./change_neid nms_snms_node.

Important! A prompt is only displayed if
CKTFMT=AZTYPEID:FREE

Result:

The renaming tool runs; completes its name change process;
then, the Navis™ Optical PM - MRP host server comes back up.
The process takes about 45 minutes.

............................................................................................................................................................

11 If the rename script has run on all affected systems, then, from the
Network Controller Map, right click the Navis™ Optical EMS and the
Navis™ Optical NMS icons and select Session > Start
Communication.

If communication must be started on the Navis™ Optical PM - MRP,
then select its icon and Session > Start Communication.
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Result:

Communication is now enabled on the Navis™ Optical EMS and
the Navis™ Optical NMS; and optionally, the Navis™ Optical
PM - MRP.

............................................................................................................................................................

12 Refresh the Navis™ Optical NMS GUI and synchronize its database
with the Navis™ Optical EMS host server.

............................................................................................................................................................

13 If the Navis™ Optical NMS is being managed by a northbound
interface, such as the Navis™ Optical PM - MRP, then run the script
on the Navis™ Optical PM - MRP. See the related Change Network
Element ID Tool task in the Navis™ Optical Provisioning Manager -
Multi-Regional Provisioning Administration Guide.

Result:

Communication is enabled on ITM-SC, the Navis™ Optical
EMS, and the Navis™ Optical NMS.
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Change Network Element Names in Navis™ Optical EMS and
Navis™ Optical NMS
....................................................................................................................................................................................................................................

Purpose This task describes how to change existing network element identifiers
on the Navis™ Optical EMS using the change network element
identifier tool.

Processing Order This change script is first run on the Navis™ Optical EMS host server
and then a script is run on theNavis™ Optical NMS host server. This
task contains the commands to run the script on both servers.

Before you begin Before changing the name of an existing network element, consider
the following items:

• Be sure that the name change has been made. See “Change a
TID using the CIT” (9-16) for details.

• Shut down the Navis™ Optical EMS before running the off-line
script. The Navis™ Optical NMS user will not be able to
communicate with the Navis™ Optical EMS at this time.

• Navis™ Optical NMS will only update the new name in the
Circuit IDs that are in M.1400 format. For Circuit IDs with
FREE FORMAT, it is the user’s responsibility to update the
Circuit IDs (using the Graphical Layout Parameters form).

• The Navis™ Optical NMS will not dynamically update any
current screen with the new network element ID name. From the
Network Map, the user must select File > Query Again to
display the new name.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Important! Because the Navis™ Optical EMS portion of this
script may change, please refer to the Navis™ Optical EMS user
documentation for updated information on how to run this script
on the Navis™ Optical EMS system.

Perform the following steps to change the identification of an
existing network element. The steps used in the first part of this
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task apply to the Navis™ Optical EMS host server while the
remaining steps apply to the Navis™ Optical NMS host server.
............................................................................................................................................................

1 From the Network Controller Map, right click the ITM-SC, Navis™

Optical NMS, and Navis™ Optical NMS icons then select Session >
Stop Communication.

Result:

Communication is disabled on ITM-SC, Navis™ Optical NMS,
and Navis™ Optical NMS.

............................................................................................................................................................

2 Log into the Navis™ Optical EMS host as ems and enter the password.

Result:

The user is logged into the Navis™ Optical EMS host.

............................................................................................................................................................

3 Use a text editor to create a file that contains the old and new
network element names.

Important! The new network element name should not include a
backslash character because it may not be supported.

Be sure that the file contains one line each, in old_name|new_name
format separated with a | (pipe) character. A carriage return must
separate each line.

............................................................................................................................................................

4 Use ftp to copy the created file to the Navis™ Optical NMS host
server.

............................................................................................................................................................

5 At the prompt, enter tidchange -f <created_filename> -du-y

Result:

The Navis™ Optical EMS is stopped and the renaming tool runs
on the Navis™ Optical EMS host server. Upon completion, the
Navis™ Optical EMS is brought back up.

The renaming process may now begin on the Navis™ Optical
NMS server.
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............................................................................................................................................................

6 While the Navis™ Optical NMS server is still down, log into the
Navis™ Optical NMS host as dacscan.

............................................................................................................................................................

7 At the prompt, enter cd /usr/dacscan/toolbin

Result:

The prompt resides at the directory where the change_neid tool
is located.

............................................................................................................................................................

8 Retrieve the Navis™ Optical EMS node_mapping data file then type
mv node_mapping tms_snms_node.

Result:

The file is renamed to tms_snms_node.

The last line of the tms_snms_node file must not contain a carriage
return. (See Step 3.)

tms_snms_node is only a recommended filename. Any filename can
be used.

............................................................................................................................................................

9 At the prompt, enter

./change_neid tms_snms_node

............................................................................................................................................................

10 If a prompt, enter Y.

Important! A prompt only displays when
CKTFMT=AZTYPEID:FREE.

Result:

The renaming tool runs, completes its name change process,
then the Navis™ Optical NMS host server comes back up. The
process takes about 45 minutes.

............................................................................................................................................................

11 If the rename script has run on all affected systems, then enter the
following:

Section II: Change Network Element ID
Tool
Change Network Element Names in Navis™

Optical EMS and Navis™ Optical NMS

Off-Line Tools

....................................................................................................................................................................................................................................

365-309-264R7.0
Issue 1, July 2002

Lucent Technologies 9 - 2 5



From the Network Controller Map, right click the ITM-SC, Navis™

Optical EMS, and Navis™ Optical NMS icons then select Session >
Start Communication.

Result:

Communication is enabled on ITM-SC, the Navis™ Optical
EMS, and the Navis™ Optical NMS.

............................................................................................................................................................

12 Restart the Navis™ Optical NMS GUI and synchronize its database
with the Navis™ Optical EMS server.
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Section III: INSERTNODE and REMOVENODE Tools

Overview
....................................................................................................................................................................................................................................

Purpose This section contains information on the INSERTNODE and
REMOVENODE tools which are UNIX scripts that allow users to
insert and remove network elements from Navis™ Optical NMS. These
tools automatically update the Navis™ Optical NMS database.

This tool uses cross-connect and port files when inserting a node;
there is no file needed when removing a node.

Features The INSERTNODE and REMOVENODE tools provide the following
features:

• Updates Navis™ Optical NMS configuration locally. It will not
send any commands to the element management system.

• Digital links can be part of a path-switched ring or a
line-switched ring.

• Supports MSP digital link and Optical Multiplex Section (OMS)
with OMS Protection (OMSP).

• Handles the updates of one-way, two-way, and broadcast
paths/circuits.

• Handles fault management reconciliation.

• Supports combo circuits that are handled the same as VC-N
paths.

• Handles path trace parameters, PTI and PT mismatch detection
mode.

• Supports the removal of a black box from a physical link.

• Supports inserting a node into a digital link. Supports all types of
digital links (from STM-0 to STM-64).

• Supports inserting a node into an OMS and optical link.

• Supports removing a node from two digital links. All types of
digital links (from STM-0 to STM-64) are supported.

• Supports removing a node from 2 OMS and 2 Optical Layer
(OL).

• Supports black box removal.

Off-Line Tools
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Supported network
elements

For a complete list of supported ITM-SC and Navis™ Optical EMS
network elements, see the Navis™ Optical NMS Provisioning Guide
for details.

Supported physical link
types

The tool supports the following physical type links:

For inserting a node:

• Optical Multiplex Section

• Optical Link

For removing a node:

• Optical Multiplex section

• Optical Layer

Contents
Insert an ITM-SC Controlled Network Element into
a Digital Link using INSERTNODE

9-29

Insert a Navis™ Optical EMS-Controlled Network
Element into a Digital Link using INSERTNODE

9-35
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9-40
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REMOVENODE

9-43
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Insert an ITM-SC Controlled Network Element into a Digital
Link using INSERTNODE
....................................................................................................................................................................................................................................

Purpose This procedure is used to insert an ITM-SC controlled network
element into a digital link using the INSERTNODE tool. Upon
completion, the task generates a cross connect and port file to update
the Navis™ Optical NMS database.

Before you begin Before you insert an ITM-SC controlled network element into a
digital link, consider the following items:

• The network element to be inserted in the Navis™ Optical NMS
database must be correctly installed in the network and must
already known by Navis™ Optical NMS—that is, it must display
on the Navis™ Optical NMS Network Map, which occurs when
all ports are provisioned and all cross-connections are made on
the EMS that the Navis™ Optical NMS application is managing.

• When inserting a node, the network element has to be
pre-provisioned—all ports must be provisioned and
cross-connections must be made as needed to provide services.

• This task can be used before or after the fibers are physically
reconnected to insert or remove a node. If the tool is used before
reconnecting the fibers and the process succeeds, the
reconnection of the fiber minimizes the risk of interrupting any
logical paths that the physical layer carries.

• The EMS provides a file with port provisioning and
cross-connection status. This file should be created just before the
tool is executed. The user must transfer this file to the server
running the Navis™ Optical NMS application and must specify
the full path at the beginning of the task.

• If the EMS reports more cross-connections than are needed, an
error has not occurred. These cross-connections are displayed in
the Uncorrelated Cross Connect form after the user does a
database synchronization.

• The user has to provide the connection ID for those connections
that have to be merged or replaced by two new ones.

• The physical link where the node is inserted or removed should
be in the in-effect state. The digital link to be updated should not
contain any scheduled paths.
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• Preplan paths should not be associated with any path carried by
the physical link to be updated.

• Performance Monitoring (PM) data collection on the physical
links should be stopped prior to execution of this task. When
inserting a node, PM data collection should be stopped on the
VC-4 substructured paths, terminating on the inserted node;
however, PM on the path going through the inserted node does
not have to be stopped.

• The regenerators or amplifiers with an Optical Multiplex Section
(OMS) must be removed from the digital links before running
this tool. After the task is completed, the user must return the
regenerators/amplifiers to the new physical links.

• The Navis™ Optical NMS user interface might not reflect the
correct configuration at the run time of the tool. While the tool is
executing, the user should not modify/delete existing paths that
ride on the digital link where the tool is being run. The user
interface should be down when the tool is run. If the user
interface is not down, the user must refresh the Network Map
and any open forms.

• Time slot or frequency interchange do not exist in the
cross-connections on the inserted/removed node. The EMS does
not report cross-connections with timeslot or frequency
interchange. The EMS also does not report SNCP
cross-connections in the inserted/removed node.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Complete these steps to insert an ITM-SC controlled node into a
digital link using the INSERTNODE tool.
............................................................................................................................................................

1 Log into the ITM-SC host as i2kadmin.

Result:

The ITM-SC host will request a password.

............................................................................................................................................................

2 Enter the ITM-SC password for the i2kadmin login.

Result:

The user is logged into the ITM-SC host.
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............................................................................................................................................................

3 At the prompt, enter the following command lines:

. itmsc_setup

db_ian_wrapper <node_name> <A EID> <Z EID>

Result:

db_ian_wrapper is executed and two files are generated
containing cross connect and tributary information in the
following format:
/home/i2kadmin/db_sc_xc_ddmmyyyy_hhmm

/home/i2kadmin/db_sc_pp_ddmmyyyy_hhmm

............................................................................................................................................................

4 Use ftp or rcp to get these two files to the Navis™ Optical NMS host
/usr/dacscan/data then record the path name on the Navis™ Optical
NMS host.

............................................................................................................................................................

5 Log into the Navis™ Optical NMS host as root.

Result:

A password is requested.

............................................................................................................................................................

6 Enter the password for the root login.

Result:

The user is logged into the into the Navis™ Optical NMS host as
root.

............................................................................................................................................................

7 At the prompt, enter cd /usr/dacscan/data.

............................................................................................................................................................

8 At the prompt, enter the following command lines:

chmod 777 db_sc_xc_ddmmyyyy hhmm

chmod 777 db_sc_pp_ddmmyyyy hhmm

............................................................................................................................................................

9 At the prompt, enter the following:

su - dacscan
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cd /usr/dacscan/bin

Result:

The user changes to dacscan and the prompt displays in the
requested directory.

............................................................................................................................................................

10 At the prompt, enter INSERTNODE.

Result:

The INSERTNODE tool is initiated.

............................................................................................................................................................

11 At the CLO/Order Number prompt, enter the value of the digital link
where the new node will be inserted.

............................................................................................................................................................

12 At the Network Element Name prompt, enter the name of the network
element that will be inserted.

............................................................................................................................................................

13 At the PORT ADDRESS to original A prompt, enter the service port
address (in NMS-Port Address-format) that will connect to the original
digital link’s A location.

............................................................................................................................................................

14 At the PORT ADDRESS to original Z prompt, enter the service port
address (in NMS-Port Address-format) that will connect to the original
digital link’s Z location.

............................................................................................................................................................

15 At the Digital Link 1 CKT ID prompt, enter the circuit ID for the
first new digital link.

Result:

This terminations on this link are the original digital link A
location on the <new_node_name>.

............................................................................................................................................................

16 At the Digital Link 2 CKT ID prompt, enter the circuit ID for the
second new digital link.
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Result:

The terminations this link are the original digital link Z location
on the <new_node_name>.

............................................................................................................................................................

17 At the EMS Port Provision File prompt, enter the full path name
of the EMS port provisioning file.

............................................................................................................................................................

18 At the EMS Cross Connect File prompt, enter the full path name of
the EMS cross connect file.

............................................................................................................................................................

19 At the Is this all correct prompt, enter Y or N then continue with
one of the following options to determine if a CAC/CLO (CCL) data
file should be generated.

..........................................................................................................................................................

20 IF THEN

Do you want to Purge

the CCL Data? displays
when the INSERTNODE
tool is running,

select N(o)
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IF THEN

an older version of Fault
Management (FM) is being
used in Navis™ Optical
NMS:

generate a CCL file with the following
steps.

• Log into the Navis™ Optical NMS
server as dacscan, then run the
$/usr/dacscan/toolbin/gen_ins_
ccl.sh tool.

• At the Do you want to Purge

the CCL data? prompt, select
Y(es) to create the
/dacscan/words/sc/db_nm_ccl_
<datemmyy_hourminute> file.

• ftp the file to the ITM-SC server
as i2kadmin where the network
element is managed and enter the
password.

• Enter the following:
. itmsc_setup
chmod 775 db_nm_ccl_datemmyy_
hourminute
db_nm_ccl_datemmyy_
hourminute
During the import of the CCL file,
the ITM-SC application will be
stopped/started, so management
will be temporarily lost of all
network elements managed by this
ITM-SC server.

Section III: INSERTNODE and
REMOVENODE Tools
Insert an ITM-SC Controlled Network
Element into a Digital Link using
INSERTNODE

Off-Line Tools

....................................................................................................................................................................................................................................

9 - 3 4 Lucent Technologies 365-309-264R7.0
Issue 1, July 2002

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Insert a Navis™ Optical EMS-Controlled Network Element into
a Digital Link using INSERTNODE
....................................................................................................................................................................................................................................

Purpose This procedure is used to insert a Navis™ Optical EMS-controlled
network element into a digital link using the INSERTNODE tool.
Upon completion, the task generates a cross connect and port file to
update the Navis™ Optical NMS database.

Before you begin Before you insert an Navis™ Optical EMS controlled network element
into a digital link, consider the following items.

• The network element to be inserted in the Navis™ Optical NMS
database must be correctly installed in the network and must
already known by Navis™ Optical NMS—that is, it must display
on the Navis™ Optical NMS Network Map, which occurs when
all ports are provisioned and all cross-connections are made on
the EMS that the Navis™ Optical NMS application is managing.
Important! A cross-connect sync must be done on the network
element prior to running the INSERTNODE tool.

• When inserting a node, the network element has to be
pre-provisioned—all ports must be provisioned and
cross-connections must be made as needed to provide services.

• This task can be used before or after the fibers are physically
reconnected to insert or remove a node. If the tool is used before
reconnecting the fibers and the process succeeds, the
reconnection of the fiber minimizes the risk of interrupting any
logical paths that the physical layer carries.

• The EMS provides a file with port provisioning and
cross-connection status. This file should be created just before the
tool is executed. A user must transfer this file to the server
running the Navis™ Optical NMS application and must specify
the full path at the beginning of the task.

• If the EMS reports more cross-connections than are needed, an
error has not occurred. These cross-connections are displayed in
the Uncorrelated Cross Connect form after the user does a
database synchronization.

• The user has to provide the connection ID for those connections
that have to be merged or replaced by two new ones.
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• The physical link where the node is inserted or removed should
be in the in-effect state. The digital link to be updated should not
contain any scheduled paths.

• There should not be preplan paths associated with any of the
paths carried by the physical link to be updated.

• Performance Monitoring (PM) data collection on the physical
links should be stopped prior to execution of this task. When
inserting a node, PM data collection should be stopped on the
VC-4 substructured paths, terminating on the inserted node;
however, PM on the path going through the inserted node does
not have to be stopped.

• The regenerators or amplifiers with an Optical Multiplex Section
(OMS) must be removed from the digital links before running
this tool. After the task is completed, the user must return the
regenerators/amplifiers to the new physical links.

• The Navis™ Optical NMS user interface might not reflect the
correct configuration at the run time of the tool. While the tool is
executing, the user should not modify/delete existing paths that
ride on the digital link where the tool is being run. The user
interface should be down when the tool is run. If the user
interface is not down, the user must refresh the Network Map
and any open forms.

• Time slot or frequency interchange do not exist in the
cross-connections on the inserted/removed node. The EMS does
not report cross-connections with timeslot or frequency
interchange. The EMS also does not report SNCP
cross-connections in the inserted/removed node.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Complete these steps to insert a Navis™ Optical EMS-controlled
node into a digital link using the INSERTNODE tool:
............................................................................................................................................................

1 Log into Navis™ Optical EMS as ems.

............................................................................................................................................................

2 At the prompt, enter

cd /ems/bin
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<node_path>

Result:

<node_path> is executed and the following two files are
generated:
/tmp/db_snms_xc_ddmmyyyy_hhmm

/tmp/db_snms_pp_ddmmyyyy_hhmm

............................................................................................................................................................

3 Use ftp or rcp to get these two files to the Navis™ Optical NMS host
/usr/dacscan/data then record the path name on the Navis™ Optical
NMS host.

............................................................................................................................................................

4 Via the Navis™ Optical NMS GUI, perform a cross-connect sync on
the network element that is to be inserted.

............................................................................................................................................................

5 Log into the Navis™ Optical NMS host machine as root and enter the
password.

............................................................................................................................................................

6 At the prompt, enter cd /usr/dacscan/data.

............................................................................................................................................................

7 At the prompt, enter the following command lines:

chmod 777 db_snms_xc_ddmmyyyy hhmm

chmod 777 db_snms_pp_ddmmyyyy hhmm

............................................................................................................................................................

8 At the prompt, enter su - dacscan.

Result:

The user is changed to dacscan.

............................................................................................................................................................

9 At the prompt, enter cd /usr/dacscan/bin.

Result:

The prompt displays in the requested directory.

............................................................................................................................................................

10 At the prompt, enter INSERTNODE.
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Result:

The INSERTNODE tool is initiated.

............................................................................................................................................................

11 At the CLO/Order Number prompt, enter the value of the digital link
where the new node will be inserted.

............................................................................................................................................................

12 At the Network Element Name prompt, enter the name of the network
element that will be inserted.

............................................................................................................................................................

13 At the PORT ADDRESS to original A prompt, enter the service port
address (in NMS-Port Address-format) that will connect to the original
digital link’s A location.

............................................................................................................................................................

14 At the PORT ADDRESS to original Z prompt, enter the service port
address (in NMS-Port Address-format) that will connect to the original
digital link Z location.

............................................................................................................................................................

15 At the Digital Link 1 CKT ID prompt, enter the circuit ID for the
first new digital link.

Result:

The terminations on this link are the original digital link A
location on the <new_node_name>.

............................................................................................................................................................

16 At the Digital Link 2 CKT ID prompt, enter the circuit ID for the
second new digital link.

Result:

The terminations on this link are the original digital link Z
location on the <new_node_name>.

............................................................................................................................................................

17 At the EMS Port Provision File prompt, enter the full path name
of the EMS port provisioning file.

............................................................................................................................................................

18 At the EMS Cross Connect File prompt, enter the full path name of
the EMS cross connect file.
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............................................................................................................................................................

19 At the Is this all correct prompt, enter Y or N.

Section III: INSERTNODE and
REMOVENODE Tools
Insert a Navis™ Optical EMS-Controlled
Network Element into a Digital Link using
INSERTNODE

Off-Line Tools

....................................................................................................................................................................................................................................

365-309-264R7.0
Issue 1, July 2002

Lucent Technologies 9 - 3 9

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Delete an ITM-SC Controlled Network Element from a Digital
Link using REMOVENODE
....................................................................................................................................................................................................................................

Purpose This procedure is used to remove an ITM-SC controlled network
element from a digital link using the REMOVENODE tool.

Before you begin Before you remove an ITM-SC controlled network element from a
digital link, consider the following items.

• This task can be used before or after the fibers are physically
reconnected to insert or remove a node. If the tool is used before
reconnecting the fibers and the process succeeds, the
reconnection of the fiber minimizes the risk of interrupting any
logical paths that the physical layer carries.

• The EMS provides a file with port provisioning and
cross-connection status. This file should be created just before the
tool is executed. A user must transfer this file to the server
running the Navis™ Optical NMS application and must specify
the full path at the beginning of the task.

• If the EMS reports more cross-connections than are needed, an
error has not occurred. These cross-connections are displayed in
the Uncorrelated Cross Connect form after the user does a
database synchronization.

• The user has to provide the connection ID for those connections
that have to be merged or replaced by two new ones.

• The physical link where the node is inserted or removed should
be in the in-effect state. The digital link to be updated should not
contain any scheduled paths.

• Preplan paths should not be associated with any paths carried by
the physical link to be updated.

• The regenerators or amplifiers with an Optical Multiplex Section
(OMS) must be removed from the digital links before running
this tool. After the task is completed, a user must return the
regenerators/amplifiers to the new physical links.
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• The Navis™ Optical NMS user interface may not reflect the
correct configuration at the run time of the tool. While the tool is
in progress, a user should refrain from modifying/deleting
existing paths that ride on the digital link where the tool is being
executed. It is recommended that the user interface should be
down when the tool is run. If not, a user has to refresh the
Network Map and any forms that are open.

• Time slot or frequency interchange do not exist in the
cross-connections on the inserted/removed node. The EMS does
not report cross-connections with timeslot or frequency
interchange. The EMS also does not report SNCP
cross-connections in the inserted/removed node.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Complete these steps to remove an ITM-SC controlled node from
a digital link.
............................................................................................................................................................

1 Log into the Navis™ Optical NMS server as dacscan.

............................................................................................................................................................

2 At the prompt, enter cd /usr/dacscan/bin then enter REMOVENODE.

Result:

The tool is initiated and a prompt displays.

............................................................................................................................................................

3 At the Network Element name prompt, enter the name of the
network that will be removed.

............................................................................................................................................................

4 At the first CLO/Order Number prompt, enter the value of the first
digital link from where the node will be removed.

............................................................................................................................................................

5 At the second CLO/Order Number prompt, enter the value of the
second digital link from where the node will be removed.

............................................................................................................................................................

6 Enter the CKT ID (All Fields of the Format) for the new digital link.
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............................................................................................................................................................

7 At the Is this all correct prompt, enter Y or N then continue with
one of the following options to determine if a CAC/CLO (CCL) data
file should be generated.

..........................................................................................................................................................

8 IF THEN

Do you want to Purge

the CCL Data? displays
when the REMOVENODE
tool is running:

select N(o)

an older version of Fault
Management (FM) is being
used in Navis™ Optical
NMS:

generate a CCL file with the following
steps.

• Log into the Navis™ Optical NMS
server as dacscan, then run the
$/usr/dacscan/toolbin/gen_rem_
ccl.sh tool.

• At the Do you want to Purge

the CCL data? prompt, select
Y(es) to create the
/dacscan/words/sc/db_nm_ccl_
<datemmyy_hourminute> file.

• ftp the file to the ITM-SC server
as i2kadmin where the network
element is managed and enter the
password.

• Enter the following:
. itmsc_setup
chmod 775 db_nm_ccl_datemmyy_
hourminute
db_import_ccl
db_nm_ccl_datemmyy_
hourminute
db_ian_wrapper
During the import of the CCL file,
the ITM-SC application will be
stopped/started, so management
will be temporarily lost of all
network elements managed by this
ITM-SC server.

Section III: INSERTNODE and
REMOVENODE Tools
Delete an ITM-SC Controlled Network
Element from a Digital Link using
REMOVENODE

Off-Line Tools

....................................................................................................................................................................................................................................

9 - 4 2 Lucent Technologies 365-309-264R7.0
Issue 1, July 2002

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Delete a Navis™ Optical EMS-Controlled Network Element
from a Digital Link Using REMOVENODE
....................................................................................................................................................................................................................................

Purpose Use this task to remove a Navis™ Optical EMS-controlled network
element from a digital link using the REMOVENODE tool.

Before you begin Before you remove a Navis™ Optical EMS network element from a
digital link, consider the following items.

• This task can be used before or after the fibers are physically
reconnected to insert or remove a node. If the tool is used before
reconnecting the fibers and the process succeeds, the
reconnection of the fiber minimizes the risk of interrupting any
logical paths that the physical layer carries.

• The EMS provides a file with port provisioning and
cross-connection status. This file should be created just before the
tool is executed. A user must transfer this file to the server
running the Navis™ Optical NMS application and must specify
the full path at the beginning of the task.

• If the EMS reports more cross-connections than are needed, an
error has not occurred. These cross-connections are displayed in
the Uncorrelated Cross Connect form after the user does a
database synchronization.

• The user has to provide the connection ID for those connections
that have to be merged or replaced by two new ones.

• The physical link where the node is inserted or removed should
be in the in-effect state. The digital link to be updated should not
contain any scheduled paths.

• Preplan paths should not be associated with any paths carried by
the physical link to be updated.

• The regenerators or amplifiers with an Optical Multiplex Section
(OMS) must be removed from the digital links before running
this tool. After the task is completed, a user must return the
regenerators/amplifiers to the new physical links.

Section III: INSERTNODE and
REMOVENODE Tools
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• The Navis™ Optical NMS user interface might not reflect the
correct configuration at the run time of the tool. While the tool is
executing, the user should not modify/delete existing paths that
ride on the digital link where the tool is being run. The user
interface should be down when the tool is run. If the user
interface is not down, the user must refresh the Network Map
and any open forms.

• Time slot or frequency interchange do not exist in the
cross-connections on the inserted/removed node. The EMS does
not report cross-connections with timeslot or frequency
interchange. The EMS also does not report SNCP
cross-connections in the inserted/removed node.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Complete these steps to remove an Navis™ Optical
EMS-controlled node from a digital link:
............................................................................................................................................................

1 Log into the Navis™ Optical NMS server as dacscan.

............................................................................................................................................................

2 At the prompt, enter cd /usr/dacscan/bin then enter REMOVENODE.

Result:

The tool is initiated and a prompt displays.

............................................................................................................................................................

3 At the Network Element name prompt, enter the name of the
network element that will be removed.

............................................................................................................................................................

4 At the first CLO/Order Number prompt, enter the value of the first
digital link from where the node will be removed.

............................................................................................................................................................

5 At the second CLO/Order Number prompt, enter the value of the
second digital link from where the node will be removed.

............................................................................................................................................................

6 Enter the CKT ID (All Fields of the Format) for the new digital link.

Section III: INSERTNODE and
REMOVENODE Tools
Delete a Navis™ Optical EMS-Controlled
Network Element from a Digital Link Using
REMOVENODE
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............................................................................................................................................................

7 At the Is this all correct prompt, enter Y or N.

Section III: INSERTNODE and
REMOVENODE Tools
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Network Element from a Digital Link Using
REMOVENODE
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Section IV: Network Element Reparenting Tool

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the reparenting process, which involves moving
network elements from one EMS to another EMS or transferring EMS
resources from one Navis™ Optical NMS to another Navis™ Optical
NMS.

Reparenting Tool This tool supports Network Element Reparenting, which is
reparenting network elements between two ITM-SCs or two Navis™

Optical EMSs and Navis™ Optical NMS Reparenting, or transferring
EMS resources from one Navis™ Optical NMS to another Navis™

Optical NMS. Both processes are covered in the following tasks.

Contents
Reparenting ITM-SC Controlled Network Elements 9-47

Reparenting Navis™ Optical EMS-Controlled
Network Elements

9-49

Reparenting Navis™ Optical NMS EMS Resources
to Another Navis™ Optical NMS

9-52
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Reparenting ITM-SC Controlled Network Elements
....................................................................................................................................................................................................................................

Purpose This section describes how to reparent ITM-SC controlled network
elements.

Before you begin Before you use this tool, be sure that:

• No provisioning or software download or upload activities are
occurring to the network elements involved in the reparenting
process.

• Pending circuits are not connected to target network element(s).

• Network element alarms are cleared from the ITM-SC.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Complete the following steps to run the reparenting tool.
............................................................................................................................................................

1 To verify that there are no pending circuits, at the Network Map,
select the target network element.

Result:

A menu displays.

............................................................................................................................................................

2 From the displayed menu, select NE Port Assignments.

Result:

The NE Assignments Query box form displays.

............................................................................................................................................................

3 Click the More button, then under Order Status, select Pending.

Result:

If pending circuits exist, a list displays.

..........................................................................................................................................................

4 IF THEN

pending circuits display, end this task.

pending circuits do not
display,

continue with the next step.

Section IV: Network Element Reparenting
Tool
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............................................................................................................................................................

5 After receiving a notification from ITM-SC that network elements
have been deleted from an old ITM-SC as a result of an ITM-SC
export tool run, login to the server as dacscan then enter cd
/usr/dacscan/toolbin.

............................................................................................................................................................

6 At the command line, type and include the location of the input file
containing information on each target network element and old and
new ITM-SC information.

Result:

The old ITM-SC data related to the target network elements is
changed to the new ITM-SC data in Navis™ Optical NMS.

............................................................................................................................................................

7 Before performing this step, be sure that:

• The online ITM-SC import tool is run to add target network
elements to the new ITM-SC.

• A message is sent from ITM-SC to notify Navis™ Optical NMS
that the network elements have been created.

• Alarms are sent to Navis™ Optical NMS.

In Navis™ Optical NMS, clear alarms associated with this process.
Refer to the Navis™ Optical NMS Maintenance Guide for details.

Section IV: Network Element Reparenting
Tool
Reparenting ITM-SC Controlled Network
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Off-Line Tools

....................................................................................................................................................................................................................................

9 - 4 8 Lucent Technologies 365-309-264R7.0
Issue 1, July 2002

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Reparenting Navis™ Optical EMS-Controlled Network Elements
....................................................................................................................................................................................................................................

Purpose This section describes how to reparent Navis™ Optical EMS-controlled
network elements.

Before you begin Before you use this tool, be sure that:

• provisioning or software download or upload activities are not
occurring in conjunction with the network elements involved in
the reparenting process

• pending circuits are not connected to target network element(s)

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Complete the following steps to run the reparenting tool:
............................................................................................................................................................

1 Log into the old Navis™ Optical EMS as ems.

............................................................................................................................................................

2 At the prompt, enter NEReparentSource <network_element_TID>.

Important! <network_element_TID> represents the TID of the
network element being reparented.

Result:

A tmp_<network_element_TID>.data file is created in
$TMFA_DATA_DIR.

............................................................................................................................................................

3 Repeat Step 2 for each network element to be reparented.

............................................................................................................................................................

4 Using the old Navis™ Optical EMS GUI, delete the network
element(s). See the Delete a Network Element task in the Navis™

Optical EMS Provisioning Guide for details.

Result:

Each network element(s) is deleted.

............................................................................................................................................................

5 Using ftp, send each tmp_<network_element_TID>.data file from
the old Navis™ Optical EMS to the new Navis™ Optical EMS.

Section IV: Network Element Reparenting
Tool
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Important! Be sure to retain the files in $TMFA_DATA_DIR.

............................................................................................................................................................

6 Physically move the network element connections from the old
Navis™ Optical EMS to the new Navis™ Optical EMS.

............................................................................................................................................................

7 Log into the new Navis™ Optical EMS as ems.

............................................................................................................................................................

8 On the new Navis™ Optical EMS, use the Navis™ Optical EMS GUI
to add the network element(s) and then wait for the Dynamic Network
Operation (DNO) to complete before proceeding to the next step. See
the Add a Network Element tasks in the Navis™ Optical EMS
Provisioning Guide for details.

Result:

The network elements are added.

............................................................................................................................................................

9 At the prompt, enter NEReparentTarget <network_element_TID>
for each network element that needs to be reparented.

Result:

A ne_snc_ids.dat file is created in $TMFA_DATA_DIR.

Note that only one ne_snc_ids.dat file is created, no matter how may
network elements are involved.

............................................................................................................................................................

10 Using ftp, send the ne_snc_ids.dat file from the new Navis™ Optical
EMS to the Navis™ Optical NMS host under the /tmp/reparent
directory.

Result:

The ne_snc_ids.dat file is sent to the Navis™ Optical NMS
host.

............................................................................................................................................................

11 On the Navis™ Optical NMS host in the /tmp/reparent directory,
create a one-line, ems_map.dat file in <OLD_Navis™ Optical
EMS_NAME>|<NEW_Navis™ Optical EMS_NAME> format.

Section IV: Network Element Reparenting
Tool
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Important! Note: The Navis™ Optical EMS names must be all
caps as they appear on the Network Controller Map and
separated by the | character, for example: TUNA|SHARK.

............................................................................................................................................................

12 Login to the Navis™ Optical NMS server as dacscan, then enter cd
/usr/dacscan/toolbin/reparent.

Result:

The user logs into the Navis™ Optical NMS server and the
prompt displays in the requested directory.

............................................................................................................................................................

13 At the prompt, enter

./reparent.ksh SNMS

Result:

The reparenting tool is initiated.

............................................................................................................................................................

14 From the Navis™ Optical NMS Controller Map, synchronize both
EMSs. See “Synchronize the Navis™ Optical NMS Database with an
EMS Database” (10-26).

Section IV: Network Element Reparenting
Tool
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Reparenting Navis™ Optical NMS EMS Resources to Another
Navis™ Optical NMS
....................................................................................................................................................................................................................................

Purpose This section describes how to reparent Navis™ Optical NMS EMS
resources to another Navis™ Optical NMS (that is, one EMS at a
time) using the reparenting tool.

Before you begin Before you use this tool, be sure that:

• the Navis™ Optical NMSs involved in this process are not
connected to any other northbound system.

• the ID of the EMS to be moved is unique.

• the target network elements are not involved in an ITM-SC
geographic redundancy switch.

• the EMS is not involved in an ITM-SC geographic redundancy.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Complete these steps to run the tool:
............................................................................................................................................................

1 IF THEN

there are circuits/digital
links that are connected
beyond the EMS domain,

disconnect them then proceed to the
next step.

there are not
circuits/digital links that
are connected beyond the
EMS domain,

proceed to the next step.

............................................................................................................................................................

2 Login to the server as dacscan then enter cd /usr/dacscan/toolbin.

............................................................................................................................................................

3 Run the export data tool to extract data from the current Navis™

Optical NMS to datafiles.

Result:

Data is stored to datafiles.

Section IV: Network Element Reparenting
Tool
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............................................................................................................................................................

4 Disconnect the old EMS (for example, ITM-SC) and its managed
network elements from the old Navis™ Optical NMS, then re-add the
EMS and its managed network elements to the target Navis™ Optical
NMS. (See “Add an ITM-SC” (10-15).)

............................................................................................................................................................

5 Run the import data tool.

Result:

Data is imported to the target Navis™ Optical NMS.

............................................................................................................................................................

6 Disconnect circuit orders. See the “Virtual Disconnect Tool
Description” (9-75) for details.

Result:

This cleans up circuit provisioning information that was stored
in the old Navis™ Optical NMS and is now successfully
transferred to the target Navis™ Optical NMS.

............................................................................................................................................................

7 Run the clean up tool.

Result:

This cleans up all remaining data that was stored in the old
Navis™ Optical NMS and is now successfully transferred to the
target Navis™ Optical NMS.

............................................................................................................................................................

8 Perform a database synchronization with the new Navis™ Optical
NMS and ITM-SC.

Result:

This is performed to ensure that data is consistent between the
new Navis™ Optical NMS and ITM-SC.

Section IV: Network Element Reparenting
Tool
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Section V: Upgrade WaveStar® OLS 400G to WaveStar® OLS
800G

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to upgrade WaveStar® OLS 400G network
elements to WaveStar® OLS 800G network elements to add more
circuit packs and increase their capacity. The script changes most
network elements having a release level lower than R5.0 to R5.0 with
the exception of WaveStar® OLS 400G R4.0 network elements, which
cannot be upgraded.

Note that WaveStar® OLS 400G R6.0 network elements will also not
change to R5.0 as a result of this script.
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Upgrade WaveStar® OLS 400G to WaveStar® OLS 800G
....................................................................................................................................................................................................................................

Purpose This task describes how to increase the capacity of an WaveStar®
OLS 400G network element by upgrading it to WaveStar® OLS
800G.

Before you begin Before you begin this upgrade, be sure that:

• the database has been backed up

• no provisioning activities involving the target WaveStar® OLS
400G network element(s) occur during the upgrade process.

• the upgrade is complete in Navis™ Optical EMS which may be
detected by Navis™ Optical NMS after receiving a second State
Change alarm from Navis™ Optical EMS.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Complete these steps to run the upgrade tool:
............................................................................................................................................................

1 After receiving an alarm notification from Navis™ Optical EMS that
the upgrade is complete, back up the Navis™ Optical NMS database.
See “Section I: Perform Backups” (8-3).

............................................................................................................................................................

2 Log into the server as dacscan then enter cd /usr/dacscan/toolbin.

............................................................................................................................................................

3 Open the log files then enter <network_element_identifier(s)> to run
the script.

Result:

The script either reads the entered TID(s) or a file containing a
list of WaveStar® OLS 400G TIDs to be upgraded to
WaveStar® OLS 800G. The script accepts entries for multiple
network elements residing under the same Navis™ Optical EMS
however the script must be run separately when network
elements reside under different Navis™ Optical EMSs.

Section V: Upgrade WaveStar® OLS 400G
to WaveStar® OLS 800G
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............................................................................................................................................................

4 Once the run is complete, select View > Network View Reset to
refresh the GUI and display the upgraded network elements.

............................................................................................................................................................

5 Synchronize Navis™ Optical NMS with Navis™ Optical EMS. See
“Synchronize the Navis™ Optical NMS Database with an EMS
Database” (10-26)

Section V: Upgrade WaveStar® OLS 400G
to WaveStar® OLS 800G
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Section VI: Upgrade WaveStar® OLS 400Gs from CMISE
Mode to TL1 Mode

Overview
....................................................................................................................................................................................................................................

Purpose WaveStar® OLS 400G R6.0 network elements use a TL1 mode
protocol. Earlier WaveStar® OLS 400G network elements used the
Common Management Information Service Element (CMISE) mode
protocol.

When WaveStar® OLS 400G network elements need to be upgraded
from an earlier release to R6.0, a script is run in Navis™ Optical
NMS.

Before running the script, WaveStar® OLS 400Gs must first be
upgraded to R6.0 in Navis™ Optical EMS. Note that the WaveStar®
OLS 400G R4.0 cannot be upgraded to R6.0.

Contents
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Use the CMISE to TL1 Upgrade Tool for WaveStar® OLS
400G
....................................................................................................................................................................................................................................

Purpose This task describes how to upgrade WaveStar® OLS 400G network
elements (R6.0 and beyond) in Navis™ Optical NMS.

Before you begin Before you use this tool, be sure that:

• the Navis™ Optical NMS database has been backed up.

• no provisioning activities involving the target WaveStar® OLS
400G network element(s) occur during the upgrade process.

• the Network Event Summary form has displayed a network
element software upgrade event to indicate that WaveStar® OLS
400G network element(s) have been upgraded from CMISE mode
to TL1 mode in Navis™ Optical EMS. See the “In Service
Upgrade of WaveStar® OLS 400G Software from Release 5.0 to
Release 6.0 TL1 Mode” task in the Navis™ Optical EMS
Provisioning Guide.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Complete these steps to run the upgrade tool:
............................................................................................................................................................

1 After the Network Event Summary form displays a network element
software upgrade event , backup the Navis™ Optical NMS database.
See “Section I: Perform Backups” (8-3).

............................................................................................................................................................

2 Log into the server as dacscan then enter cd /usr/dacscan/toolbin.

............................................................................................................................................................

3 Open the log files then enter <network_element_identifier(s)> to run
the script.

Result:

The script either reads the entered TID(s) or a file containing a
list of WaveStar® OLS 400G TIDs then upgrades the node type
from CMISE to TL1.

Section VI: Upgrade WaveStar® OLS
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Note that the script accepts entries for multiple network
elements residing under the same Navis™ Optical EMS however
the script must be run separately when network elements reside
under different Navis™ Optical EMSs.

............................................................................................................................................................

4 Once the run is complete, synchronize Navis™ Optical NMS with
Navis™ Optical EMS. See “Synchronize the Navis™ Optical NMS
Database with an EMS Database” (10-26)
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Section VII: Connection Renaming Tool

Overview
....................................................................................................................................................................................................................................

Purpose The Connection renaming tool is a UNIX script used to:

• Rename a large number of network connections using a list of
trail/circuit identifications (connection identifications) as input.

• Rename discovered network connections with a given naming
rule after a path discovery procedure.

Usable independently of the Auto-Discovery tool, the Connection
Renaming tool takes a user-provided input file, containing every trail
identification as a parameter, and retrieves the connections to which
the end ports belong and renames them with the trail identification.
The tool only renames the connections defined in the input file. If the
file provides at least one end port of a connection, the tool will
rename the related connection.

The tool is applicable to any in-effect SDH and PDH connection
provisioned in Navis™ Optical NMS.

Using the tool The tasks which utilize this tool are contained after this description.

Restrictions The following restrictions apply to the Connection Renaming tool:

• Not applicable to new network objects introduced with the
optical layer.

• Only applicable if the free format option for the trail/circuit ID is
set.

• Local to Navis™ Optical NMS. No commands will be sent to the
network elements level.

• Users must provide a file containing the end ports of the
connections they wish to rename.

• The trail identifications provided in the input file must be unique
in Navis™ Optical NMS.

• There is no consistency check when a file provides a
connection’s two end ports. If a user provides two different trail
ids for the two end ports, then the tool will rename the
connection with one of the two trail IDs without error.

Off-Line Tools
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• Several instances of the tool cannot be run simultaneously.

• Users must refresh screens to reflect new connection
identifications.

• Recommended that users only operate the tool while the Navis™

Optical NMS host is running.

Log files When the Connection Renaming tool successfully renames a
connection, it logs the renamed connection to
/tmp/auto_disc/rename_ckts. The file format is structured so each
record is a line. Each line consists of:

old_trail_id:new_trail_id

Error Log

The tool logs errors to /tmp/err_rename.log. Errors are logged to a
file for the following reasons:

• The data validation fails.

• The trail ID is not unique in Navis™ Optical NMS.

• The input file’s port does not have any related connection.

There is no error if the trail identification in the user input file is the
same as the current trail identification in the database.

Supported interfaces The Connection renaming tool supports the following interfaces:
ITM-SC and Navis™ Optical EMS.

Contents
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Renaming Tool
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Rename Network Connections with the Connection Renaming
Tool
....................................................................................................................................................................................................................................

Purpose Use this task to rename network connections using the connection
renaming tool.

The connection renaming tool is a UNIX script that is used to rename
large numbers of network connections using a list of connection or
trail identifications as input.

Before you begin Before using the connection renaming tool, consider the following
items:

• You must run the connection renaming tool while Navis™ Optical
NMS is running.

• Be sure that the circuits are set at the free format option.

• Although not recommended, it is possible to continue operation
procedures through the Navis™ Optical NMS interface while the
tool is running.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Complete these steps to rename network connections using the
Connection Renaming tool:
............................................................................................................................................................

1 Log in as dacscan.

............................................................................................................................................................

2 At the prompt, enter cd /tmp/auto_disc.

Result:

The directory is changed

............................................................................................................................................................

3 At the prompt, type ls and then view the display to confirm that the
input port file is listed in this directory.

Important! If <port_input_filename> is not listed, then it
must be created. The <port_input_filename> is a text file
consisting of a record set, with each record consisting of one

Section VII: Connection Renaming Tool Off-Line Tools
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line. Each line consists of a set of fields separated by | and
populated as follows:

• Field 1: TID of the network element.

• Field 2: Port address, using the EMS format.

• Field 3: Rate. (Values are C1, C3, D3, D1, C4, V12, V2,
AU3, V3, V4, V4-4c, V4-16c)

• Field 4: Trail ID, which is the new ID that the user is assigning
to the trail.

............................................................................................................................................................

4 At the prompt, type /usr/dacscan/toolbin/rename_ckt
/tmp/<port_input_filename>.

Result:

The connection renaming tool uses the port input file to specify
the trail ID of the connections to be renamed. The tool will, for
each record of the input file, identify the IE connection and
rename the Trail ID with the specified ID. It will then update
the trail ID within the Navis™ Optical NMS database.

............................................................................................................................................................

5 Verify the renamed connection at /tmp/auto_disc/rename_ckts.

Result:

The renamed connections should appear. Note that each record
consists of old_trail_id:new_trail:id.

Section VII: Connection Renaming Tool
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Section VIII: Bulk Link Provisioning Tool

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the bulk link provisioning tool, which is used
to perform a bulk transfer of topological links from provisioning
systems, such as the Physical Resource Manager, to Navis™ Optical
NMS. This off-line tool abstracts the topological links into a bulk
process then performs a bulk add of the links to Navis™ Optical NMS
as if they were added individually through the Navis™ Optical NMS
GUI.

About this tool Before running this tool, an input file is created which contains one
line per Navis™ Optical NMS link to be provisioned. The created file
is entered in the bulk link provisioning tool command and run with
one of the following options:

• -v, which performs a pre-provisioning run to validate the input
file without provisioning links. Depending on the results of the
validation, users may edit the input file and rerun this command
until the results predict that a clean run will occur.

• -p, which runs the bulk link provisioning command.

• -a, which takes the latest provisioning run and audits the Navis™

Optical NMS database against the input file.
When a link is detected in this run that is not In-Effect, this is
noted in the error file, link_audit.log which lists each suspect
input line along with one audit error message per error.
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Bulk Link Provisioning Tool Task
....................................................................................................................................................................................................................................

Purpose This section describes how to perform bulk link provisioning in
Navis™ Optical NMS.

Before you begin Consider the following before running the bulk link provisioning tool.

Important! This tool is expected to be run during off-hours to
avoid the impact that the process may have on system response.
If this is your first time running this tool, contact Lucent
Customer Support for assistance.

Task Complete the following steps to run the bulk link provisioning
tool:
............................................................................................................................................................

1 Log into the server as dacscan then enter cd /usr/dacscan/toolbin/
offline.

............................................................................................................................................................

2 In the /usr/dacscan/toolbin/offline directory, create an input file.

............................................................................................................................................................

3 In the input file, add one row of the following data, separated by the |
character for each Navis™ Optical NMS link to be provisioned.

• The full ’A’ network element identifier <aloc>.

• The full ’Z’ network element identifier <zloc>.

• The network element-level port address of the service link at the
A location.

• The network element-level port address of the service link at the
Z location.

• The coded rate of the link <link_type>.

• The free-format label for the circuit ID field <link_ID>.

• The coded Multiplex Section Protection (MSP) configuration.
Values are 1X1MSP, 1+MSP or none.

• The free-format label denoting the protecting link or none.

• The network element-level port address of the protecting link at
A_location or none.
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• The network element-level port address of the protecting link at
Z_location or none.

• The MSP protection group name for 1X1MSP or none.

• The type of MSP configuration: UNI, BI, NTT or none.

Note: If the row is being created for MSP links, the protecting link
and service link fields must be consistent for the sequential array of
fields. The row must also have the same A network element ID and Z
network element ID while conforming to the correct MSP port
groupings at either end. The protecting link and service link must also
have the same link ID.

............................................................................................................................................................

4 Save and close the file, then select one of the following options from
the next step.

..........................................................................................................................................................

5 IF THEN

You want to validate data
in the input file without
provisioning links,

enter net_entity NM_links -v

Result: All records in the data file
are validated and error messages are
logged to a file.

You want to provision a
group of In-Effect links,

enter net_entity NM_links -p

Result: A group of links are
provisioned.

You want to take the latest
provisioning run and audit
the Navis™ Optical NMS
database against the input
file,

enter net_entity NM_links -a

Result: The run is audited and any
non-In-Effect links are noted in the
link_audit.log error file.
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Section IX: Bulk Circuit Provisioning Tool

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the bulk circuit provisioning tool.
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Bulk Circuit Provisioning Tool Task
....................................................................................................................................................................................................................................

Purpose This task describes how to use the bulk circuit provisioning tool.

Before you begin Be sure to create a VC-12 from the Network Map first.

Important! If this is your first time using this tool, contact
Lucent Customer Support for assistance.

Task Complete the following steps to run the bulk circuit provisioning
tool.
............................................................................................................................................................

1 Using the Network Map, create a VC-12 and optionally create a
CEPT-1 on the VC-12. See the Add a Circuit tasks in the Navis™

Optical NMS Provisioning Guide.

............................................................................................................................................................

2 Log into the server as dacscan then enter cd /usr/dacscan/
toolbin.

............................................................................................................................................................

3 In the /usr/dacscan/toolbin directory, create a data_file file.

............................................................................................................................................................

4 Add the following information to data_file, then save and close the
file.

• Circuit ID <CKT_ID> of the created VC-12 circuit, e.g., HTN1
HTN2 VC12S.2000.

• Total number of VC-12 circuits to be created during the bulk
provisioning, e.g., 2

• External port address of the VC-12 at the A_location

• External port address of the VC-12 at the Z_location

• A to Z Path Trace ID (transmitting).

• Z to A Path Trace ID (receiving).
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• Y(es) or N(o) value to specify if a CEPT-1 should be created over
the VC-12.

• Y(es) or N(o) value to specify if alarms should be ignored during
the bulk provisioning.

For example, data_file’s contents may appear as follows:

HTN1 HTN2 VC12S.2000|2

S1/1/2/1/1-3|S1/1/2/1/1-3|0|0|N|Y

S1/1/4/1/1-3|S1/1/4/1/1-3|0|0|N|Y

The first line represents the circuit ID followed by the total number of
circuits to be created. The second and third lines contain the a frame,
z frame, A to Z and Z to A path trace IDs, and the assign CEPT-1 and
ignore alarm values.

............................................................................................................................................................

5 In the /usr/dacscan/toolbin/offline directory, create and save an
index file that contains the directory path of the data_file, e.g.,
/usr/dacscan/toolbin/offline/data_file.

............................................................................................................................................................

6 At the prompt, enter /usr/dacscan/toolbin/offline/net_entity
<indexfilename> -p

<indexfilename> is a file containing a list of all data files to be used
to perform the bulk circuit provisioning.

Result:

A prompt displays requesting a proxy host.

If you are not prompted to enter the proxy host, none of the
VC-12s will be added and an error message displays indicating
that there are other proxyproc processes on the system.

............................................................................................................................................................

7 At the prompt, enter the proxy host.

Result:

The script continues to run.
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Section X: ODO Tool

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to convert black boxes into individual
ODOs with an Off-line tool.
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ODO Tool Task
....................................................................................................................................................................................................................................

Purpose This procedure is used to convert black boxes into ODOs.

Important! This tool does an off-line change of the database, so
have a recent backup of the database as a means of undoing the
effects of this tool, if needed.

Before you begin Before running the tool, ensure that:

• Navis™ Optical NMS is not being used by any users.

• The nodes connected to the black boxes being converted into
ODOs are located in the same area as the black boxes in Navis™

Optical NMS.

Important! If this is your first time using this tool, contact Lucent
Customer Support for assistance.

Task Complete these steps to run the Navis™ Optical NMS ODO tool.
............................................................................................................................................................

1 Log into the server as dacscan.

............................................................................................................................................................

2 At the prompt, enter cd /usr/dacscan/toolbin.

Result:

The prompt resides in the appropriate directory.

............................................................................................................................................................

3 At the prompt, enter BB_ODO [-f filename] [-l logfile].

Result:

The ODO tool prompts the user for an action.

..........................................................................................................................................................

4 IF THEN

you want to extract the
black boxes,

proceed to Step Step 5 to continue.
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IF THEN

you want to convert the
Black Boxes in the ASCII
file to ODO elements

proceed to Step Step 6 to continue.

............................................................................................................................................................

5 Extract the black boxes and store them in an ASCII file. The default
filename is BB_ODO.txt. The default logfile is BB_ODO.log. The
user may override these defaults by supplying appropriate arguments.

Result:

A list of black box elements is created in the system.

............................................................................................................................................................

6 Convert the black boxes in the ASCII file to ODO elements.

Result:

The tool will name each ODO as ODO_CILLIKEY_running_

number, where CILLIKEY represents the node to which ODO is
connected. As each black box in the ASCII file is converted, the
tool:

• Checks the Navis™ Optical NMS database for the existing
blackbox.

• Verifies that the black box is connected to one or more real
network elements in the Navis™ Optical NMS database. If
more than one network element is connected, the tool will
convert the black box into individual ODOs for each
network element. Area/submap will be updated with ODOs.

• Preserves existing Link IDs and clients of the ODOs, when
the black box is converted into individual ODOs.

• Creates an aggregate in the Navis™ Optical NMS database
for the ODOs. The tool will name the aggregate with the
same name as the black box that is split. Area/submap will
be updated.
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• Produces a log file that contains the results of the
conversion tool and stores them. If a black box requested
by the tool does not exist in the database, a message
indicating black box name and error not found in NMS

DB will be stored in log file.

• Requests the host to update the GUI display upon
completing its operations.

If the tool fails to successfully convert a particular black box into an
ODO/aggregate, the tool will abandon the operation on this black box
and undo any partial changes in the conversion process. The tool will
create an entry for this failure in the tool error log file.
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Section XI: Provisioning Maintenance Tool

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the virtual disconnect tool.
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Virtual Disconnect Tool Description
....................................................................................................................................................................................................................................

Overview The virtual disconnect tool is used to clean up the Navis™ Optical
NMS database when facility, path, or circuit provisioning does not
proceed as planned.

When cross-connections are disconnected at the EMS or network
element level without notification to the Navis™ Optical NMS, the
record of the assignment in the Navis™ Optical NMS still exists.

The virtual disconnect tool is a means to clean up the Navis™ Optical
NMS database without sending commands to the EMS or to the
network elements.

This also might be required, for example, in the unlikely event that an
operator incorrectly assigned a circuit to a wrong black box location
when provisioning the circuit in Navis™ Optical NMS. The result of
this script is to cause change to the Navis™ Optical NMS database
without interacting with the network elements.

For the task used to perform this function, see the Perform a Virtual
Disconnect task in the Navis™ Optical NMS Provisioning Guide.
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Section XII: Provisioning Maintenance Support

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the disconnect order script and contains a task
on how to use this tool.
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The Disconnect Order Script
....................................................................................................................................................................................................................................

The disconnect order script is used to clean up the Navis™ Optical
NMS database when circuit provisioning does not proceed as planned.
Cleanup is sometimes needed because circuits can be disconnected at
the EMS or network element level without notification to the Navis™

Optical NMS, or circuits can be partially provisioned and need to be
cleaned up before a re-attempt is executed.

The disconnect order script provides a way to clean up the Navis™

Optical NMS database when circuits are disconnected at the EMS or
network element level, or when circuits are partially provisioned and
need to be cleaned up before a re-attempt is executed. For example,
this script would need to be run if an operator incorrectly assigned a
circuit to a wrong black box location when provisioning the circuit in
the Navis™ Optical NMS. This script changes the Navis™ Optical
NMS database without interacting with the network elements.
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Run the Disconnect Circuit Order Script
....................................................................................................................................................................................................................................

Purpose This procedure is used to run the disconnect order script, which is run
when a need exists to disconnect circuits.

Prerequisites Have a list of each circuit name to be disconnected.

You must have access to the following files:

• /usr/dacscan/data/discord.fmt

• /usr/dacscan/data/disc_order

• /usr/dacscan/toolbin/deleteorder

• /usr/dacscan/toolbin/get_disc.sh

• /usr/dacscan/toolbin/ug

Files can be transmitted electronically or are also available in a tape
and can be loaded via the patch.install program, which automatically
sets the correct permissions and ownership and installs the files into
the corresponding directories. If the files are transmitted electronically,
the permissions must be modified to 755 (-rwxr-xr-x), the ownership
needs to be modified to dacscan dba, and the files need to be
installed in directories.

Important! Circuits are not disconnected if a pending order is on
the stack or if lower order facilities are riding on it.

Task Complete these steps to run the disconnect circuit script:
............................................................................................................................................................

1 Log in to the server as dacscan.

............................................................................................................................................................

2 At the prompt, type cd /usr/dacscan/data.

Result:

The system puts you in the data directory.

............................................................................................................................................................

3 Create a file named disc_ckt and add the name of each circuit to be
disconnected.

............................................................................................................................................................

4 To run the script, type the following command line at the prompt:
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ksh /usr/dacscan/data/disc_order.sh.

Result:

Circuits that can be disconnected are saved in the
/usr/dacscan/data/disc_input file. Circuits that cannot be
disconnected are listed in the tmp/disc_order.err file.

............................................................................................................................................................

5 From the Network Map, view the graphical layout of the circuits.

............................................................................................................................................................

6 On the host server, type display_disc_log and view the display.

Result:

The disconnected circuits should not be displayed in the log file.

............................................................................................................................................................

7 To view the disconnected circuits, check the /dacscan/trace/
deleteorder.log file.

Result:

The disconnected circuits are displayed.
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10 EMS Management

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes tasks used to interact with subsystems in the
network.
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Section I: Interact with Navis™ Optical EMSs

Overview
....................................................................................................................................................................................................................................

Purpose This section describes how to administer the following Element
Management Systems (EMSs):

• ITM-SC

• Navis™ Optical EMS

Definition: EMS An EMS is a graphical user interface-based element manager used for
network management.

Definition: ITM-SC An ITM-SC is an application that provides services to the network
management system to enable it to set up end-to-end paths and to
monitor overall network behavior.

Definition: Navis™ Optical
EMS

Navis™ Optical EMS is a management system for the Navis™ product
family, providing Element Management Layer (EML) management
functions for Navis™ products. This system has configuration
management, fault management, performance management, and
security management functions.

Contents
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10-8
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10-13
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Set Up ITM-SC for a Cut-Through 10-18

Cut-Through to an EMS 10-23

Verify the Run Status of the Navis™ Optical EMS
Application on the HP Server

10-24
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10-25
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Synchronize the Navis™ Optical NMS Database
with an EMS Database

10-26

Refederate a Navis™ Optical EMS Server 10-28
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Add a New Navis™ Optical EMS
....................................................................................................................................................................................................................................

Purpose Use this task to add a new Navis™ Optical EMS on the Navis™

Optical NMS.

Important! The task below must be run for each Navis™ Optical
EMS to be added.

Before you begin Before you begin this task, collect the following information:

• system name

• Internet address

Task Perform the steps below to add a new Navis™ Optical EMS.
............................................................................................................................................................

1 Log in as root to the Navis™ Optical NMS host.

............................................................................................................................................................

2 At the prompt, enter ksh /usr/dacscan/bin/add.controller and
press Enter.

Result:

The following prompt is displayed along with a menu of all
possible controllers:

Which Controller do you want to add to this WS-NMS?

............................................................................................................................................................

3 At the prompt, enter 17, which is External SNMS (SDH Add/Drop
Multiplexer) and press Enter.

Result:

The following prompt is displayed:

What is the name of the SNMS?

............................................................................................................................................................

4 Enter the name of the Navis™ Optical EMS and press Enter.

Result:

You are prompted to confirm your entry.
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............................................................................................................................................................

5 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the IP address for the Navis™ Optical
EMS.

............................................................................................................................................................

6 Enter the IP address then press Enter.

Important! If the machine to be added is in a local redundancy
configuration, the Package IP address should be entered.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

7 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the Acronym.

............................................................................................................................................................

8 Enter the acronym using all CAPS. This entry is a unique identifier,
which should not be more than four characters long. Generally, the
first four characters of the Navis™ Optical EMS hostname are used.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

9 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

The original activity screen displays.
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............................................................................................................................................................

10 Continue with one of the following steps.

• If you have have additional Navis™ Optical EMSs to add, for
example, if a geographic redundancy configuration is in place,
repeat Step 4 through Step 9 to continue.

• If you do not have additional Navis™ Optical EMSs to add, go to
the next step.

............................................................................................................................................................

11 Enter quit to exit the script.

Result:

The script is exited.

............................................................................................................................................................

12 Using the system console, log in to the new EMS as root.
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Set Up a Cut-Through to Navis™ Optical EMS via the Navis™

Optical NMS Server
....................................................................................................................................................................................................................................

Purpose This procedure is used to establish a cut-through to the Navis™

Optical EMS application.

Related information The “Set Up a Cut-Through to Navis™ Optical EMS via the Navis™

Optical EMS Server” (10-13) procedure is used to complete the
cut-through.

Before you begin Be sure that:

• The Navis™ Optical EMS server is running when this task is
being performed.

• The Navis™ Optical EMS server has an entry in its host file so
the Navis™ Optical NMS server allows Orbix to communicate
successfully.

Important! To enable cut-through to a R4.2 Navis™ Optical EMS, the
Navis™ Optical NMS user invoking the cut-through must also exist on
the Navis™ Optical EMS. It is also essential that SAGE is enabled at
the Navis™ Optical EMS for the cut-through to work. For user
administration and enabling SAGE, refer to the relevant Navis™

Optical EMS documentation.

Task Perform the steps below to set up a Navis™ Optical EMS to
permit cut-through sessions to occur.
............................................................................................................................................................

1 Log in as root to the Navis™ Optical NMS host.

............................................................................................................................................................

2 At the prompt, enter who -r.

Result:

The current run-level displays.

..........................................................................................................................................................

3 IF THEN

the run-level value is 3 (or
less),

go to the next step.
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IF THEN

the run-level value is
greater than 3, and this is
a single server
configuration,

type init 3 and go to the next step.

the run-level value is
greater than 3, and this is
a geographic redundancy
configuration,

use the “Stop the Navis™ Optical NMS
Application on a Geographic
Redundancy Configuration” (3-21)
task.

the run-level value is
greater than 3, and this is
a local redundancy
configuration,

use the “Stop the Navis™ Optical NMS
Application on Local Redundancy
Configurations ” (3-26) task.

............................................................................................................................................................

4 At the prompt, enter ksh /usr/dacscan/bin/add.controller and
press Enter.

Result:

A list displays.

............................................................................................................................................................

5 At the prompt, enter 17 and press Enter.

Result:

The following prompt is displayed:

What is the name of the SNMS?

............................................................................................................................................................

6 Enter the name of the Navis™ Optical EMS then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

7 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the IP address for the Navis™ Optical
EMS.
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............................................................................................................................................................

8 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

9 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the Acronym.

............................................................................................................................................................

10 Enter the acronym using all capital letters only. Note that this entry is
a unique identifier, which should not be more than four characters
long. Generally, the first four characters of the Navis™ Optical EMS
hostname are used.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

11 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

The script is exited.

............................................................................................................................................................

12 At the prompt, enter /usr/dacscan/bin/AddEMS.sh to add any joint
Navis™ Optical EMS/Navis™ Optical NMS clients to the Navis™

Optical EMS server.

Result:

A menu displays.

............................................................................................................................................................

13 Select option 2 for the Navis™ Optical EMS server.
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............................................................................................................................................................

14 Continue with one of the following steps.

• For a local redundancy configuration using MC/ServiceGuard,
repeat Step 4 through Step 13 to continue.

• For configurations other than local redundancy, go to the next
step.

............................................................................................................................................................

15 At the Enter the Navis™ Optical EMS Server Name, then press

[return]:? prompt, enter the hostname of the Navis™ Optical EMS.

............................................................................................................................................................

16 At the Enter the Version of the Navis™ Optical EMS, then

press [return]: prompt, enter the Navis™ Optical EMS version.

Important! Press Return if this is not applicable.

............................................................................................................................................................

17 At the Are the WS-NMS GUI and Navis™ Optical EMS GUI

installed on the same desktop(y/n)? prompt, enter y if a joint
workstation is deployed or n if the Navis™ Optical NMS and Navis™

Optical EMS GUIs are running on separate machines.

............................................................................................................................................................

18 Continue with one of the following options.

• If n was selected in the last step, continue with Step 20.

• If y was selected in the last step, enter the IP address of the
Navis™ Optical NMS and Navis™ Optical EMS GUIs (when
prompted) then continue with the next step.

............................................................................................................................................................

19 Review the displayed prompt, then enter y if the information is
correct.

Result:

The original list displays
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............................................................................................................................................................

20 Continue with one of the following steps.

• For a local redundancy configuration using MC/ServiceGuard,
repeat Step 15 through Step 19 to continue.

• For configurations other than local redundancy, go to the next
step.

............................................................................................................................................................

21 Select quit from the displayed list.

............................................................................................................................................................

22 Start the Navis™ Optical NMS application with one of the following
options:

• For a single server configuration, use the “Start the Navis™

Optical NMS Application on a Single Server” (3-6) task.

• For a local redundancy configuration using MC/ServiceGuard,
use the “Start the Navis™ Optical NMS Application on a Local
Redundancy Configuration” (3-24) task.

• For a geographic redundancy configuration, use the “Start the
Navis™ Optical NMS Application on a Geographic Redundancy
Configuration” (3-20) task.

............................................................................................................................................................

23 At the prompt, enter who -r.

Result:

The run-level status displays.

............................................................................................................................................................

24 Use the “Set Up a Cut-Through to Navis™ Optical EMS via the
Navis™ Optical EMS Server” (10-13) procedure to continue to
configure the cut-through.

Section I: Interact with Navis™ Optical
EMSs
Set Up a Cut-Through to Navis™ Optical
EMS via the Navis™ Optical NMS Server

EMS Management

....................................................................................................................................................................................................................................

1 0 - 1 2 Lucent Technologies 365-309-264R7.0
Issue 1, July 2002

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Set Up a Cut-Through to Navis™ Optical EMS via the Navis™

Optical EMS Server
....................................................................................................................................................................................................................................

Purpose This procedure is used to set up a cut-through from the Navis™

Optical NMS to the Navis™ Optical EMS on the .Navis™ Optical
EMS server.

Before you begin The Communications Software Launcher (CSL) must be enabled on
the Navis™ Optical EMS host server.

In this procedure, you will be required to edit a file. To avoid losing
data, consider making a copy of this file before editing. If you choose
to copy this file, remember to delete it from the system when you are
finished editing.

When adding Navis™ Optical NMS users to the Navis™ Optical EMS
GUI, make sure all users, including sa are added.

Task Complete these steps to set up a cut-through from Navis™ Optical
NMS to Navis™ Optical EMS:
............................................................................................................................................................

1 Log on to the Navis™ Optical EMS server.

............................................................................................................................................................

2 Input the following command to change directories: cd /ems/etc.

............................................................................................................................................................

3 Use the vi editor to access the GUI_Server.cfg file: vi
GUI_Server.cfg.

............................................................................................................................................................

4 Once in the GUI_Server.cfg file, search for the string CSL_.

............................................................................................................................................................

5 Change CSL_ENABLE = 0 to CSL_ENABLE = 1.

............................................................................................................................................................

6 Save the changes made to the file and exit the vi editor.

............................................................................................................................................................

7 Copy the sncFint.cfg file from the desktop server.
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For example: c:/snmsR4.2/snc/fint/sncFint.cfg to
c:/jui/jnm/itm/southbound/snc/sncfint.

............................................................................................................................................................

8 To add Navis™ Optical NMS users (including sa) to the Navis™

Optical EMS GUI, from Navis™ Optical EMS Network Map navigate
from Administration -> Security -> User Provisioning -> Add.

............................................................................................................................................................

9 Enter the following information for each user who is to use the
cut-through:

Name is a 2 to 10 character string that represents the name of the
Navis™ Optical NMS user.

Alias is another, possibly abbreviated name, for the Navis™ Optical
NMS user.

Password is a 6 to 10 character string that must include at least two
alphabetical characters, at least one numeric character, and at least one
special character. These special characters are not permitted ( : , ;
).

Confirm Password is the 6 to 10 character string that was entered in
the Password field.

Login Type is ITM-NM.

Enter the default for all other fields.

............................................................................................................................................................

10 Click OK.

............................................................................................................................................................

11 Start traces by typing the following commands:

tracestrt -p tmf_notifsvr -s tmf_nci -t -5

tracestrt -p tmf_gateway -s tmf_nci -t -5

tracestrt -p SB_TL1Mgr -s SB_TL1Mgr -t -5
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Add an ITM-SC
....................................................................................................................................................................................................................................

Purpose Use this task to add an ITM-SC on the Navis™ Optical NMS.

Important! This task must be run for each ITM-SC to be added.
The number of ITM-SCs that may be added varies with the
Navis™ Optical NMSconfiguration installed. The limit for
ITM-SC is 20 subnetwork controllers. When the limit is reached,
an error message is displayed after the last step of the procedure
to inform the user that the EMS could not be added because it
exceeded the number allowed.

Before you begin Before you begin this task, collect the following information:

• system name for the ITM-SC to be added

• IP address for the ITM-SC to be added

Task Perform the steps below to add an ITM-SC.
............................................................................................................................................................

1 Log in as root to the Navis™ Optical NMS host.

............................................................................................................................................................

2 At the prompt, enter ksh /usr/dacscan/bin/add.controller and
press Enter.

Result:

A list displays.

............................................................................................................................................................

3 At the prompt, enter 8 and press Enter.

Result:

The following prompt is displayed:

What is the name of the ITM-SC?

............................................................................................................................................................

4 Enter the name of the ITM-SC then press Enter.

Result:

You are prompted to confirm your entry.
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............................................................................................................................................................

5 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the IP address for the ITM-SC.

............................................................................................................................................................

6 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

7 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the Acronym.

............................................................................................................................................................

8 Enter the acronym using all capital letters. Note that this entry is a
unique identifier, which should not be more than four characters long.
Generally, the first four characters of the ITM-SC hostname are used.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

9 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

The user, i2kadmin is created and you are prompted to enter a
new password for the new user ID.

............................................................................................................................................................

10 At the prompt, enter a password and then re-enter the same password
to continue.

Result:

The original activity screen displays.
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............................................................................................................................................................

11 Continue with one of the following steps.

• If you have have additional ITM-SCs to add, for example, if a
geographic redundancy configuration is in place, repeat Step 3
through Step 10 to continue.

• If you do not have additional ITM-SCs to add, proceed to the
next step.

............................................................................................................................................................

12 Using the system console, log in to the new EMS as root.

............................................................................................................................................................

13 Enter /opt/itm/sc/toolbox/bin/itmsc_set_itmnm_name to
configure the EMS to communicate with Navis™ Optical NMS.

Result:

The ITM-SC is added.
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Set Up ITM-SC for a Cut-Through
....................................................................................................................................................................................................................................

Purpose Use this task to configure ITM-SC for a cut-through.

Before you begin Before you begin this task, be sure that:

• the Navis™ Optical NMS and ITM-SC servers are fully installed.

• the ITM-SC server is running when this task is being performed.

• a user ID already exists with privileges that will permit
cut-through to the ITM-SC.

Task Perform the steps below to configure an ITM-SC for cut-through
purposes.
............................................................................................................................................................

1 Login as root to the Navis™ Optical NMS server.

............................................................................................................................................................

2 At the prompt, enter who -r.

Result:

The current run-level displays.

..........................................................................................................................................................

3 IF THEN

the run-level value is 3 (or
less),

proceed to the next step.

the run-level value is
greater than 3, and this is
a single server
configuration,

type init 3 and proceed to the next
step.

the run-level value is
greater than 3, and this is
a geographic redundancy
configuration,

use the “Stop the Navis™ Optical NMS
Application on a Geographic
Redundancy Configuration” (3-21)
task.

the run-level value is
greater than 3, and this is
a local redundancy
configuration,

use the “Stop the Navis™ Optical NMS
Application on Local Redundancy
Configurations” (3-26) task.
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............................................................................................................................................................

4 At the prompt, enter ksh /usr/dacscan/bin/add.controller and
press Enter.

Result:

A list displays.

............................................................................................................................................................

5 At the prompt, enter 8 and press Enter.

Result:

The following prompt is displayed:

Which type of EMS Controller do you want to cut-thru
from ITM-NM GUI?

............................................................................................................................................................

6 Enter the name of the ITM-SC to be added for cut-through support
then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

7 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the IP address for the ITM-SC.

............................................................................................................................................................

8 Enter the IP address then press Enter.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

9 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

You are prompted to enter the Acronym.
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............................................................................................................................................................

10 Enter the acronym using all CAPS. Note that this entry is a unique
identifier, which should not be more than four characters long.
Generally, the first four characters of the ITM-SC hostname are used.

Result:

You are prompted to confirm your entry.

............................................................................................................................................................

11 View the entry, then enter y if it is correct, or n if it is not correct,
and then enter the correct entry to continue.

Result:

The user, i2kadmin is created and you are prompted to enter a
new password for the new user ID.

............................................................................................................................................................

12 At the prompt, enter a password and then re-enter the same password
to continue.

Result:

The script completes then exits.

............................................................................................................................................................

13 Continue with one of the following steps.

• If an MC/ServiceGuard configuration is in place, repeat Step 4
through Step 12 to continue.

• If an MC/ServiceGuard configuration is not in place, proceed to
the next step.

............................................................................................................................................................

14 At the prompt, enter /usr/dacscan/bin/AddEMS.sh to configure the
desktop cut-through for the ITM-SC.

Result:

A menu displays.

............................................................................................................................................................

15 Select ITM-SC (SDH add/drop multiplexers).

............................................................................................................................................................

16 At the Enter the SC Server Name, then press [return]:?

prompt, enter the hostname of the Navis™ Optical EMS.
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............................................................................................................................................................

17 At the Enter the Version of the SC <ITM—SC Name>, then

press [return]: prompt, enter the Navis™ Optical EMS version.

Important! Press Return if this is not applicable.

............................................................................................................................................................

18 At the Are the WS-NMS GUI and SC GUI installed on the same

desktop (y/n)? prompt, enter y if a joint workstation is deployed or
n if the Navis™ Optical NMS and Navis™ Optical EMS GUIs are
running on separate machines.

............................................................................................................................................................

19 Continue with one of the following options.

• If n was selected in the last step, enter the IP address of the
Navis™ Optical NMS GUI, enter all if you want all Navis™

Optical NMS desktops to access the same pool of ITM-SC GUI
workstations, then enter the IP address of the ITM-SC GUI.

• If y was selected in the last step, enter the IP address of the
Navis™ Optical NMS and ITM-SC GUIs (when prompted).

............................................................................................................................................................

20 Review the displayed prompt, then enter y if the information is
correct.

Result:

The original list displays.

............................................................................................................................................................

21 Continue with one of the following steps.

• If an MC/ServiceGuard (local redundancy) configuration is in
place, repeat Step 14 through Step 20 to continue.

• If an MC/ServiceGuard configuration is not in place, proceed to
the next step.

............................................................................................................................................................

22 Select quit from the displayed list.
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............................................................................................................................................................

23 Start the Navis™ Optical NMS application with one of the following
options:

• If a single server configuration applies, use the “Start the Navis™

Optical NMS Application on a Single Server” (3-6) task.

• If an MC/ServiceGuard (local redundancy) configuration applies,
use the “Start the Navis™ Optical NMS Application on a Local
Redundancy Configuration” (3-24) task.

• If an geographic redundancy configuration applies, use the “Start
the Navis™ Optical NMS Application on a Geographic
Redundancy Configuration” (3-20) task.

............................................................................................................................................................

24 At the prompt, enter who -r.

Result:

The run-level status displays.
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Cut-Through to an EMS
....................................................................................................................................................................................................................................

Purpose Use this task to cut-through to ITM-SC or Navis™ Optical EMS using
the Navis™ Optical NMS.

Task Perform the step below to cut-through to ITM-SC or Navis™

Optical EMS EMSs.
............................................................................................................................................................

1 On the Network Map or the Network Controller Map, right-click on
an EMS, then select then select Session > Login to EMS.

Result:

A dialog box displays, indicating that the request is processing.
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Verify the Run Status of the Navis™ Optical EMS Application
on the HP Server
....................................................................................................................................................................................................................................

Purpose This task is used to verify the run status of the HP server running the
Navis™ Optical EMS application.

Task Use these steps to verify the run status of the Navis™ Optical
EMS application on the HP server.
............................................................................................................................................................

1 Log in into the HP server running the Navis™ Optical EMS
application as ems.

............................................................................................................................................................

2 At the prompt, enter appstat.

Result:

The system displays the current run level.

............................................................................................................................................................

3 If the system displays CURRENT RUN LEVEL IS: Running, no action
is needed.

If the system displays Can not connect to server and CURRENT

RUN LEVEL IS: SHUTDOWN, type up to bring the application up.
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Verify the Communication Status of the Navis™ Optical EMS
Application and a Network Element
....................................................................................................................................................................................................................................

Purpose This task is used to verify the communication status of the Navis™

Optical EMS application and a network element.

Task Use this task to verify the communication status of the Navis™

Optical EMS application and a network element:
............................................................................................................................................................

1 Log in into the HP server running the Navis™ Optical EMS
application as ems.

............................................................................................................................................................

2 At the prompt, enter cmtool -a.

Result:

The system displays a list of network elements.

............................................................................................................................................................

3 Examine the list of network elements to determine which network
elements on the list show a Link Status of Up. These network
elements are communicating with the Navis™ Optical EMS
application.
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Synchronize the Navis™ Optical NMS Database with an EMS
Database
....................................................................................................................................................................................................................................

Purpose This procedure is used to synchronize the Navis™ Optical NMS
database with an EMS database.

Task Complete the following task to synchronize the Navis™ Optical
NMS database with an EMS database.
............................................................................................................................................................

1 From the Network Map, select File -> Open Network Controller
Map.

Result:

The Network Controller Map is displayed.

............................................................................................................................................................

2 On the Network Controller Map, right-click the desired EMS node,
then select Node -> Session -> Start Database Synchronization.

Result:

The Database Download/Synchronization form is displayed and
its EMS ID field is pre-populated with the name of the EMS.

............................................................................................................................................................

3 From the Type field’s drop-down menu, select a synchronization type
then press Apply.

..........................................................................................................................................................

4 IF THEN

You select Alarm, an alarm synchronization occurs with
all the network elements under control
of this EMS.

You select Port, a port synchronization is initiated.

You select Switch, a switch synchronization is initiated.

You select All, a full frame synchronization process
occurs, including alarm, equipment,
switch, cross-connect, and protection
group synchronization.
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IF THEN

You select Cross Connect, a cross-connections synchronization
process occurs to update the From
Port, To Port, and type of
cross-connection information in the
Cross-Connection Map database.

You select Protection
Group,

a synchronization occurs to the listed
protection groups.
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Refederate a Navis™ Optical EMS Server
....................................................................................................................................................................................................................................

Purpose This procedure is used to refederate a Navis™ Optical EMS Server.

When the Navis™ Optical EMS application is upgraded to a new
release, the Navis™ Optical EMS server(s) must be refederated, which
involves re-establishing the association between the Navis™ Optical
NMS and Navis™ Optical EMS Orbix instances.

Important! This task applies to Navis™ Optical EMS R4.2 (or
greater). If the task is not run, communication would be severed
between the Navis™ Optical EMS server(s) and the Navis™

Optical NMS server because the associated Inter-operable Object
Reference (IOR) string would be lost. The task also relies on the
naming service repository being intact. If corruption is suspected,
refer to Navis™ Optical NMS release notes.

Before you begin Be sure that the Navis™ Optical NMS server is at run level 4. See
“Run level 4” (C-2) for details.

Task Complete these steps below to refederate Navis™ Optical EMS
server(s) from a Navis™ Optical NMS server.
............................................................................................................................................................

1 Using a terminal window on the Navis™ Optical NMS server, log in
as dacscan.

............................................................................................................................................................

2 At the prompt, enter cd /usr/dacscan/toolbin.

Result:

The directory is changed to toolbin.

............................................................................................................................................................

3 At the prompt, enter . refederate_snms <Navis™ Optical
EMS_hostname>.

............................................................................................................................................................

4 Using a terminal window on the Navis™ Optical NMS server, log in
as root.
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............................................................................................................................................................

5 Determine whether or not the version of the Navis™ Optical EMS has
changed.

• If the version of the Navis™ Optical EMS has not changed,
proceed to Step 16 to continue.

• If the version of the Navis™ Optical EMS has changed, continue
with the next step.

............................................................................................................................................................

6 At the prompt, enter init 3 to bring Navis™ Optical NMS to run
level 3.

............................................................................................................................................................

7 At the prompt, enter /usr/dacscan/bin/AddEMS.sh.

............................................................................................................................................................

8 Select option 2 (for Navis™ Optical EMS server).

............................................................................................................................................................

9 At the Enter the SNMS Server Name, then press [return]:?

prompt, enter the hostname of the Navis™ Optical EMS.

............................................................................................................................................................

10 At the Enter the Version of the SNMS <SNMS Name>, then

press [return]: prompt, enter the Navis™ Optical EMS version.

............................................................................................................................................................

11 At the Are the WS-NMS GUI and SNMS GUI installed on the

same desktop (y/n)? prompt, enter y if a joint workstation is
deployed or n if the Navis™ Optical NMS and Navis™ Optical EMS
GUIs are running on separate machines.

............................................................................................................................................................

12 If y was selected in the last step, enter the IP address of the Navis™

Optical NMS and Navis™ Optical EMS GUIs (when prompted). If n
was selected in the last step, enter the IP address of the Navis™

Optical NMS GUI, and then enter the IP address of the ITM-SC GUI.

............................................................................................................................................................

13 Review the displayed prompt, then enter y if the information is
correct.
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............................................................................................................................................................

14 Select quit from the displayed list.

............................................................................................................................................................

15 At the prompt, enter init 4 to bring Navis™ Optical NMS to run
level 4.

............................................................................................................................................................

16 At the Navis™ Optical NMS client GUI, click the desired Navis™

Optical EMS server icon, then select Session > Start
Communication.

Result:

A dialog box containing the following text displays: START
SESSION COMMAND SENT FOR FRAME:<ems_ name>.

............................................................................................................................................................

17 On the dialog box, click OK.

Result:

Communication is re-established between the Navis™ Optical
EMS and Navis™ Optical NMS servers. The emsmap.cfg file is
also automatically updated where necessary; therefore, editing
this file is not required.

If communication cannot be immediately established with the
refederated Navis™ Optical EMS server, restart the Navis™ Optical
NMS application using the init 3/init 4 commands. See Start the host
application in Chapter 3, “System Administration” for details.

............................................................................................................................................................

18 For each Navis™ Optical EMS server to be refederated, repeat Step 1
through Step 16 of this task.

Section I: Interact with Navis™ Optical
EMSs
Refederate a Navis™ Optical EMS Server

EMS Management

....................................................................................................................................................................................................................................

1 0 - 3 0 Lucent Technologies 365-309-264R7.0
Issue 1, July 2002

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Section II: Miscellaneous Management Communication Tasks
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Purpose This section contains a LAN communications task.
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Enable or Disable LAN Communications
....................................................................................................................................................................................................................................

Purpose Use this task to enable or disable the LAN.

Task Complete these steps to enable or disable the LAN
communications using either sam or by entering a command:
............................................................................................................................................................

1 Using the system console, log into the primary host as root.

..........................................................................................................................................................

2 Determine if you are using sam or command line entries to enable or
disable the LAN.

IF THEN

sam will be used: Bring up sam.
Select Network Communications >
Network Interface Cards.
Select the card that you want to
enable/disable.
Click Actions and Enable or Disable.

command entries will be
used:

at the prompt, enter ifconfig up to
enable the LAN or ifconfig down to
disable the LAN.
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Section III: Database Audit and Synchronization

Overview
....................................................................................................................................................................................................................................

Purpose This section describes alarm database audits and database
synchronization processes and their impact to stored data.

Contents
Alarm Database Audit 10-34

Database Synchronization 10-35

EMS Management

....................................................................................................................................................................................................................................
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Alarm Database Audit
....................................................................................................................................................................................................................................

Overview To optimize certain searches, the Navis™ Optical NMS fault
management module has data storage redundancy, which results in an
occasional deviation in data. The Alarm Database Audit feature
corrects this deviation in data.

A nightly cron job triggers—according to a schedule defined during
installation—an Alarm Database Audit.

The cron job is not triggered if an alarm synchronization with an
EMS is currently in progress. An automatic audit occurs after a
manually triggered alarm synchronization with an EMS.

At the end of the Alarm Database Audit, a message indicates that the
audit is completed. A message is not broadcast if the Alarm Database
Audit does not find any discrepancies.

Section III: Database Audit and
Synchronization

EMS Management

....................................................................................................................................................................................................................................

1 0 - 3 4 Lucent Technologies 365-309-264R7.0
Issue 1, July 2002



Database Synchronization
....................................................................................................................................................................................................................................

Overview The Database Synchronization form is used to synchronize the
Controller database and the database of an individual digital
cross-connection system. The synchronization can be a partial or a full
synchronization.

The Controller supports the following types of Database
Synchronization processes:

• Alarm Database Synchronization

• Cross Connection Map Database Synchronization

• Equipment Database Synchronization

• Complete Database Synchronization

Facility-based port parameter data synchronization can only be
performed manually (on-demand). The other three types of data
synchronization can be performed either automatically or manually.
The Controller displays associated commands, data, and status
messages on the Database Synchronization form.

Section III: Database Audit and
Synchronization

EMS Management

....................................................................................................................................................................................................................................
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11 Trouble Clearing

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes how to turn on the trace capability and to view
trace files.

For information on fault management and performance monitoring
tasks, refer to the Navis™ Optical NMS Maintenance Guide.

Navis™ Optical NMS home
directory

The home directory of Navis™ Optical NMS is /usr/dacscan. The
application servers reside in the bin directory of the home directory.
Each server has trace information linked to it and it can be turned on
and off via the tinfo file in /usr/dacscan/bin.

Important! The trace files should never be removed while the
application is up under any circumstances.

Definition: trace file A trace file contains information that identifies equipment status at a
given point in time. The typical use of a trace file is to send it to
Lucent technical support to be used as part of their remote
troubleshooting activities.

Contents
Turn on the Trace Capability for Troubleshooting 11-3

Create a Host Trace File on a Server 11-4

....................................................................................................................................................................................................................................
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Create a Trace File for FM and the
Southbound/Northbound Interface

11-6

Create a Trace File on an HP-UX Workstation 11-8

Create a Trace File on a PC 11-9

View the Log Files 11-10

View the Log File on an HP Workstation 11-12

Clear Trace Files on a Server 11-13

Create a Single File for Trace Data 11-14

View the console.log File on a PC 11-15

Overview Trouble Clearing
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Turn on the Trace Capability for Troubleshooting
....................................................................................................................................................................................................................................

Purpose This procedure is used to turn on the trace capability in the
appropriate trace configuration file. The system administrator can turn
on, capture, and send trace data to Lucent Customer Support when
troubleshooting problems.

Before you begin Trace should only be turned on when requested by Lucent Customer
Support.

In this procedure, you will be required to edit a file. To avoid losing
data, consider making a copy of this file before editing. If you choose
to copy this file, remember to delete it from the system when you are
finished editing.

Task Complete these steps to turn on the trace capability in the
appropriate trace configuration file:
............................................................................................................................................................

1 Using one of the Create Trace tasks provided in this chapter, edit the
appropriate trace configuration file to turn on trace.

............................................................................................................................................................

2 Re-initiate the condition to be checked.

Result:

Trace output should be produced.

............................................................................................................................................................

3 Send the trace output to Lucent Customer Support.

............................................................................................................................................................

4 Edit the appropriate trace configuration file to turn off trace.

Trouble Clearing
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Create a Host Trace File on a Server
....................................................................................................................................................................................................................................

Purpose Use this procedure to turn on a host trace at a particular server and to
create a host trace file for capturing information.

Before you begin The application must be at run level 3.

Task Complete these steps to create a trace file:
............................................................................................................................................................

1 Enter the command who -r to check the current run level.

Result:

The run level number displays, such as run-level 3.

............................................................................................................................................................

2 If the displayed run level is higher than 3, enter the command init 3
to bring the application up to run level 3.

............................................................................................................................................................

3 Using the system console, log in to the primary host as dacscan.

............................................................................................................................................................

4 At the prompt, enter cd /usr/dacscan/bin to change to the directory
containing the tinfo file.

............................................................................................................................................................

5 To edit the tinfo file, enter vi tinfo.

............................................................................................................................................................

6 In the tinfo file, locate a line containing the following format:
<servername> -1 0 <servername>. 0 Y.

Important! In your tinfo file, <servername> will be replaced
with the actual server name.

............................................................................................................................................................

7 To increase the trace level from 0 (the lowest level) to 5, press the
Esc button, then type :1,$s/-1 0/-1 5/ then press Enter.

Result:

The lines containing those entries will be substituted with the
higher trace level value, such as <servername> -1 5

<servername>.0 y

Trouble Clearing
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............................................................................................................................................................

8 Save and exit the file.

Result:

The file is saved with the new trace level.

............................................................................................................................................................

9 At the prompt, enter init 4 to bring the application up to run level 4.

Result:

Trace is turned on. A trace file is generated and contains a name
in the following format: <process_name>.<pid>.<hostname>,
where the <process_name> is the FM or
southbound/northbound process, such as fm_notif or
tmf_gateway.

............................................................................................................................................................

10 Verify that the trace file /dacscan/trace/<servername>.<pid> exists.

Result:

The file displays in the appropriate directory.

............................................................................................................................................................

11 To decrease the trace level from 5 to 0, repeat Step 4 to Step 6 to
bring up the tinfo file.

Result:

The tinfo file displays .

............................................................................................................................................................

12 Press the Esc button, then type :1,$s/-1 5/-1 0/ then press Enter.

............................................................................................................................................................

13 Write and save the file.

Result:

The file is saved with the new trace level.

To increase the available space in the /dacscan/trace directory, only
retain the latest version of each file, and use rm ulog.<old_date>
command to remove old trace files.

Create a Host Trace File on a Server Trouble Clearing
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Create a Trace File for FM and the Southbound/Northbound
Interface
....................................................................................................................................................................................................................................

Purpose This procedure is used to create a trace file on a particular server for
fault management (FM) and the southbound/northbound interface
configuration.

Before you begin The application must be at run level 3.

Task Complete these steps to create a trace file for FM and the
southbound/northbound interface configuration:
............................................................................................................................................................

1 Enter the command who -r to check the current run level.

Result:

The run level number displays, such as run-level 3.

............................................................................................................................................................

2 If the displayed run level is higher than 3, enter the command init 3
to bring the application to run level 3.

............................................................................................................................................................

3 Using the system console, log in to the primary host as dacscan.

............................................................................................................................................................

4 At the prompt, enter cd /usr/dacscan.

............................................................................................................................................................

5 Type ls to display a list of files.

Result:

The system displays a list of files.

............................................................................................................................................................

6 Verify that the NMSconfig file exists.

..........................................................................................................................................................

7 IF THEN

the NMSconfig file exists, go to step 9.

Trouble Clearing
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IF THEN

the NMSconfig file does
not exist,

create the file with the following
information:
EMSTRACEON fm_notif -1 -1 0

EMSTRACEON fm_gfs -1 -1 -1

EMSTRACEON fm_rms -1 -1 -1

EMSTRACEON fm_tt 0 -1 0

EMSTRACEON fm_server -1 -1 0

EMSTRACEON coproc -1 -1 0

EMSTRACEON SBGW200LSrv -1 -1 -1

EMSTRACEON Cor2tuxSvr -1 -1 -1

EMSTRACEON brokerSrv -1 -1 -1

EMSTRACEON I2KNL -1 -1 -1

EMSTRACEON fm_fls -1 -1 0

EMSTRACEON tmf_gateway -1 -1 0

EMSTRACEON STMFGWSrv -1 -1 -1

EMSTRACEON ExtObserverSrv -1 -1

-1

EMSTRACEON ExtAlarmSynchSrv -1

-1 -1

TRACELOGSIZE 5000

............................................................................................................................................................

8 Save and exit the file.

Result:

The file is saved with the new trace level.

............................................................................................................................................................

9 At the prompt, enter init 4 to bring the application up to run level 4.

Result:

Trace is turned on.

............................................................................................................................................................

10 At the prompt, enter cat NMSconfig to verify that the trace file
exists.

Result:

The file displays.

Create a Trace File for FM and the
Southbound/Northbound Interface
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Create a Trace File on an HP-UX Workstation
....................................................................................................................................................................................................................................

Purpose This procedure is used create a trace file for capturing information on
an HP-UX workstation. Use this procedure if you want to increase
global tracing and turn on the F-interface tracing.

Important! Trace files should never be removed.

Before you begin Start the Navis™ Optical NMS application; see the “Start the Navis™

Optical NMS Application on an HP-UX Workstation” (3-11) task for
details.

In this procedure, you will be required to edit a file. To avoid losing
data, consider making a copy of this file before editing. If you choose
to copy this file, remember to delete it from the system when you are
finished editing.

Task Complete these steps to turn create a trace file on an HP
workstation:
............................................................................................................................................................

1 Log in to the HP-UX workstation as dacscan.

............................................................................................................................................................

2 Edit the /usr/add-on/ui/jui/bin/run_jnm file by changing gt=1 to
gt=4 fint.tr=4.

............................................................................................................................................................

3 Save the edited run_jnm file.

............................................................................................................................................................

4 Shut down and restart the Navis™ Optical NMS GUI; see the “Stop
the Navis™ Optical NMS Application on a Desktop” (3-14) and “Start
the Navis™ Optical NMS Application on an HP-UX Workstation”
(3-11) tasks.

Result:

Tracing is turned on and a trace file is generated.

............................................................................................................................................................

5 Verify that the trace file exists.

Result:

The file displays in the appropriate directory.

Trouble Clearing
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Create a Trace File on a PC
....................................................................................................................................................................................................................................

Purpose This procedure is used create a trace file for capturing information on
a PC console. Use this procedure if you want to increase global
tracing and turn on the F-interface tracing.

Important! Trace files should never be removed.

Before you begin Start the Navis™ Optical NMS application. See the “Start the Navis™

Optical NMS Application on a Windows PC” (3-12) task for details.

In this procedure, you will be required to edit a file. To avoid losing
data, consider making a copy of this file before editing. If you choose
to copy this file, remember to delete it from the system when you are
finished editing.

Task Complete these steps to turn create a trace file on a Windows PC:
............................................................................................................................................................

1 Log in to the PC as sa.

............................................................................................................................................................

2 Edit the <drive>:\jui\bin\run_jnm.bat file by changing gt=1 to gt=4
fint.tr=4.

............................................................................................................................................................

3 Save the edited run_jnm.bat file.

............................................................................................................................................................

4 Shut down and restart the Navis™ Optical NMS GUI; see the “Stop
the Navis™ Optical NMS Application on a Desktop” (3-14) and “Start
the Navis™ Optical NMS Application on a Windows PC” (3-12) tasks.

Result:

Tracing is turned on and a trace file is generated.

............................................................................................................................................................

5 Verify that the trace file exists.

Result:

The file displays in the appropriate directory.

Trouble Clearing
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View the Log Files
....................................................................................................................................................................................................................................

Overview Operator transaction logs are stored in compressed format in the
/dacscan/log/data directory with the following naming convention:

<log-prefix>.<julian-date>.<hour>.<minute>

The following is a list of log files:

• sys (System Event) - records all system error messages. File
name is nms.log.<hostname>.

• dcs (Digital cross connect log) - records communication
information with the DACS in the network. File name is
ne.log.<hostname>.

• Notification log file - notif.log.<hostname>

• Orbix log file - orbix.log.<hostname>.

• HP client log file - File name is console.log and is stored at
/home/<user_name>/NM/<workstationname>.<pid>/jui/logs \
/console.log

• PC client log file - The file is stored at
<drive>:\jui\logs\<user>.log

All log files are maintained up to seven days; the oldest file is
overwritten first. One log file is retained for each day of the week.

Event files All significant events associated with the database backup and transfer
scheme are logged.

The events are also retained in log files in /dacscan/tmp.

Log file management for
joint workstations

Joint workstation logs record all ICA client sessions from a joint
workstation. The log files for the joint workstation are not
automatically deleted by the system. For space consideration, it is
recommended that the system administrator or user manually delete
the log files that are no longer necessary.

Location of log files

Joint workstation log files are located in c:\jui\logs and use the format
<username><win station name>#<a random number> where:

• <username> is any valid user

• <win station number> is the console on which the GUI is run

Trouble Clearing
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• # is the actual character #

• <a random number> is any random number assigned (<999). The
random number is attached to the log file to prevent a user with
the same user ID from overwriting a log file that is already in
use.

View the Log Files Trouble Clearing
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View the Log File on an HP Workstation
....................................................................................................................................................................................................................................

Purpose This procedure is used to view the log file residing on an HP
workstation.

Task Complete these steps to view the log file:
............................................................................................................................................................

1 Using the system console, log in to the primary host as dacscan.

............................................................................................................................................................

2 Change to the directory containing the log file to be viewed:

cd /<full_directory_pathname> cd /<full_directory_path>

For example, cd /home/<user>/NM/<workstation>.<pid>/jui/
logs/console.log

............................................................................................................................................................

3 Enter pg <logfilename>.log.

Result:

The contents of the log file are displayed.

Trouble Clearing
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Clear Trace Files on a Server
....................................................................................................................................................................................................................................

Purpose This procedure is used to clear trace files on a server.

Important! Be sure that you are in the correct directory because
all deleted files will not be recovered.

Task Complete these steps to clear trace files on a server:
............................................................................................................................................................

1 Using the system console, log in to the primary host as dacscan.

............................................................................................................................................................

2 At the prompt, type: cd /dacscan/trace.

Result:

The directory is changed to the one containing the trace files.

............................................................................................................................................................

3 At the prompt, type:

for i in ’ls’

do

>$i

done

Result:

The contents of the trace file are cleared.

Trouble Clearing
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Create a Single File for Trace Data
....................................................................................................................................................................................................................................

Purpose Use this task to create one file containing information from one or
more trace files produced on the server.

Task Perform the steps below to copy trace source into one file.
............................................................................................................................................................

1 Using the system console, log in to the primary host as dacscan.

............................................................................................................................................................

2 At the prompt, type cd /dacscan/trace.

Result:

The directory has changed to the one containing the trace files.

............................................................................................................................................................

3 At the prompt, type tar cvf trace.tar ./*.

Result:

The files will be copied into a single file.

Trouble Clearing
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View the console.log File on a PC
....................................................................................................................................................................................................................................

Purpose This procedure is used to view the console.log file residing on a PC.

Task Complete these steps to view the log file:
............................................................................................................................................................

1 Log in to the PC as sa.

............................................................................................................................................................

2 Using Notepad or Wordpad, display the console.log file which
resides in <drive_letter>:\jui\logs\<user>.log.

Result:

The file displays.

Trouble Clearing
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12 Software Release, Version, and
Patch Information

Overview
....................................................................................................................................................................................................................................

Purpose This chapter contains information on how to display the current
software release and load ID, how to determine which software patch
is loaded, and how to display the software version number.

Contents
Display the Software Release and Load ID 12-2

Display the Current Software Patch Loaded 12-3

Display the Version Number of the Application
Software

12-4

....................................................................................................................................................................................................................................
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Display the Software Release and Load ID
....................................................................................................................................................................................................................................

Purpose This procedure is used to display the Navis™ Optical NMS release
number and load ID.

Task Complete these steps to display the Navis™ Optical NMS release
number and load ID:
............................................................................................................................................................

1 Log into the server as root or dacscan.

............................................................................................................................................................

2 To display the release number, enter cat /etc/dscan/release.

Result:

The current release number is displayed.

............................................................................................................................................................

3 To display the load ID, enter cat /etc/dscan/ws-nmshr-loadid.

Result:

The current load ID is displayed.

Software Release, Version, and Patch Information
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Display the Current Software Patch Loaded
....................................................................................................................................................................................................................................

Purpose This procedure is used to display the current software patch that is
loaded.

Task Complete these steps to display the current software patch that is
loaded:
............................................................................................................................................................

1 Using the system console, log in to the primary host as dacscan.

............................................................................................................................................................

2 At the prompt, type swlist | grep PATCH.

Result:

A complete patch list displays.

Software Release, Version, and Patch Information
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Display the Version Number of the Application Software
....................................................................................................................................................................................................................................

Purpose This procedure is used to display the version number of Navis™

Optical NMS software.

Task Complete this step to display the version number of the
application software:
............................................................................................................................................................

1 From the Network Map, select Help > Version.

Result:

The version number of the currently installed application
software and the build date of that software are displayed.

Software Release, Version, and Patch Information
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Appendix A: Navis™ Optical NMS
Filesystems

Navis™ Optical NMS file systems
....................................................................................................................................................................................................................................

Introduction This appendix contains a list of the Navis™ Optical NMS file systems.

List of file systems The following lists the directory structure supported within Navis™

Optical NMS.

1. Root directory (/)

2. OS kernel (/stand)

3. Spool directories (/var)

4. Core OS components (/usr)

5. Optional software (/opt)

6. Provisioning documents directory (/dacscan/prov)

7. Alarms directory (/dacscan/alarms)

8. Three Oracle tablespace directories (/oradb, /oradb2, /oradb3)

9. Application logs directory (/dacscan/log)

10. Database redo logs and archives directory (/dacscan/dbarch and
/dacscan/journal)

11. Application users directory (/dacscan/users)

12. Application trace information directory (/dacscan/trace)

13. Temporary directory (/tmp)

14. Application temporary space (/dacscan/tmp)

....................................................................................................................................................................................................................................
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15. Application software (/usr/dacscan)

16. Application software patch history (/patch)

17. Filesystem used for the PAMs feature (/ITM_QA)

Navis™ Optical NMS file systems Navis ™ Optical NMS Filesystems
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Appendix B: Navis™ Optical NMS
Configuration Parameters

Overview
....................................................................................................................................................................................................................................

Description To change Navis™ Optical NMS configuration parameters, contact
Lucent Customer Support.

....................................................................................................................................................................................................................................
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Appendix C: Navis™ Optical NMS
Common UNIX Commands and Tasks

Overview
....................................................................................................................................................................................................................................

Purpose This appendix explains some UNIX commands that are used in the
administration process. Some commands in this appendix are used in
the tasks provided in this document; other commands can be used to
access remote systems or to verify network communication status.

....................................................................................................................................................................................................................................

365-309-264R7.0
Issue 1, July 2002

Lucent Technologies C - 1



init Command for Changing Run Levels
....................................................................................................................................................................................................................................

Introduction An init command is used to change the run level of the Navis™

Optical NMS application on an HP-UX machine. The following
describes two run levels, run level 3 and run level 4.

Run level 3 When the system administrator enters the init 3 command, it causes
the system to switch to run level 3, which shuts down the Navis™

Optical NMS application. The init 3 command would be entered, for
example, before creating a trace file.

Run level 4 When the system administrator enters the init 4 command, it causes
the system to switch to run level 4, which starts up the Navis™

Optical NMS application. The init 4 command would be entered, for
example, after a trace file has been created.

Navis ™ Optical NMS Common UNIX Commands and
Tasks
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who Command for Verifying System Run Level
....................................................................................................................................................................................................................................

Purpose The who command allows you to verify system run level.

Task Complete these steps to determine the current run level of the
system:
............................................................................................................................................................

1 Log into the host as root.

............................................................................................................................................................

2 At the prompt, enter who -r.

Result:

A message displays a line of current run level information, such
as run-level 3 Dec 30 11:26 3 0 S.

Navis ™ Optical NMS Common UNIX Commands and
Tasks
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ping Command for Verifying Communication
....................................................................................................................................................................................................................................

Purpose The ping command is used to determine whether it is possible to
communicate with a remote system. Failure to communicate may be
caused by the remote system being switched off or the communication
link not working correctly.

Task Complete these steps to use the ping command:
............................................................................................................................................................

1 Log in to the host as root.

............................................................................................................................................................

2 Enter ping <hostname> <-n number>; where: hostname is the name
of the host to be pinged and -n number is the number of packets to
be pinged.

Result:

When a user enters ping <host_name> —n 10 at a prompt,
output similar to the following displays:

PING <host_name>.lucent.com: 64 byte packets

64 bytes from <ip_address>: icmp_seq=0. time=155. ms

64 bytes from <ip_address>: icmp_seq=1. time=155. ms

64 bytes from <ip_address>: icmp_seq=2. time=155. ms

64 bytes from <ip_address>: icmp_seq=3. time=154. ms

64 bytes from <ip_address>: icmp_seq=4. time=155. ms

64 bytes from <ip_address>: icmp_seq=5. time=154. ms

64 bytes from <ip_address>: icmp_seq=6. time=154. ms

64 bytes from <ip_address>: icmp_seq=7. time=155. ms

64 bytes from <ip_address>: icmp_seq=8. time=155. ms

64 bytes from <ip_address>: icmp_seq=9. time=157. ms

----<host_name> PING Statistics----

10 packets transmitted, 10 packets received, 0%

packet loss round-trip (ms) min/avg/max = 154/154/157

Navis ™ Optical NMS Common UNIX Commands and
Tasks

....................................................................................................................................................................................................................................

C - 4 Lucent Technologies 365-309-264R7.0
Issue 1, July 2002



............................................................................................................................................................

3

To stop ping, type Ctrl C.

Result:

The ping command is now stopped.

ping Command for Verifying
Communication

Navis ™ Optical NMS Common UNIX Commands and
Tasks
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telnet Command for Initiating Remote Sessions
....................................................................................................................................................................................................................................

Description The telnet command is used to initiate a session on a remote
system. When telnet <system_name> is entered at a prompt, the
system requests the user to type the login ID and password. Once
successfully logged in, the session is active until the user logs off of
the remote system.
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uname Command for Displaying System Information
....................................................................................................................................................................................................................................

Purpose The uname command allows you to identify the system with which a
terminal is communicating.

Task Complete these steps to display system information:
............................................................................................................................................................

1 Log into a terminal as root.

............................................................................................................................................................

2 At the prompt, enter uname —a.

Result:

A line similar to the following displays:

HP-UX <host_name> B.11.00 A 9000/810 2013485357

two-user license.

Navis ™ Optical NMS Common UNIX Commands and
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lanscan Command for Viewing LAN Status
....................................................................................................................................................................................................................................

Purpose The lanscan command allows you to view the status of any of the
LANs that are connected to the machine, including the LAN that
connects the Navis™ Optical NMS to the EMS.

Task Complete these steps to view LAN status information:
............................................................................................................................................................

1 Using the system console, log into either the primary or the standby
host as root.

............................................................................................................................................................

2 Enter lanscan.

Result:

The LAN status information is displayed.
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vgdisplay Command for Verifying Mirroring Status
....................................................................................................................................................................................................................................

Purpose The vgdisplay command is used to verify that the application and
databases residing on separate disks are synchronized.

About the mirrored disk
configuration

A mirrored disk configuration eliminates the need to have a second
server to serve as a backup. The application and database that reside
on separate disks are mirrored onto a second set of disks. Information
that is written to disk is reflected onto the mirrored counterpart. It is
recommended that the mirroring status is checked from time to time
to ensure that all the mirrored information is synchronized with the
primary information.

Before you begin Ensure that the LVSTATUS is set to SYNC.

Task Complete these steps to obtain mirroring status:
............................................................................................................................................................

1 Using the system console, log into the primary host as root.

............................................................................................................................................................

2 Enter vgdisplay -v | pg at the # prompt.

Result:

The mirroring status displays.
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shutdown Command for Halting or Rebooting Servers
....................................................................................................................................................................................................................................

Purpose The shutdown command is used to halt or reboot the servers.

Before you begin The format for the shutdown command is the following:

shutdown -<hy/ry> <seconds>

Where: shutdown is the command verb used to halt or reboot the
servers.

-hy specifies that the servers are to be shut down using the halt
option.

-ry specifies that the servers are to be shut down using the reboot
option.

<seconds> specifies the numbers of seconds that are to elapse before
the shutdown commences.

Task Complete these steps to halt or reboot the servers:
............................................................................................................................................................

1 Log in to the server as root.

............................................................................................................................................................

2 To shut down the server using the halt option, at the prompt type
shutdown -hy 0.

To shut down the server using the reboot option, at the prompt type
shutdown -ry 0.

Result:

The server is shut down.
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ps Command for Information About Active Processes
....................................................................................................................................................................................................................................

Purpose The ps command is used to view information about active processes.

Before you begin A helpful note—by piping the output of the ps command to the wc
(word count) command, the system can display line, word, and byte
counts. For example: ps -ef | wc. The output would show numbers
such as 33 17 12, which would represent the line, word, and byte
counts of the process.

Task Complete these steps to use the ps command:
............................................................................................................................................................

1 Log in to the host server as root.

............................................................................................................................................................

2 At the system prompt, enter the ps command: ps.

Result:

The system outputs information about the active processes.
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Glossary

A Action
Order Action - Represents the work activities against a facility/circuit order.

Add Channel
One direction of a bidirectional signal; a wavelength being added into the single flow.

Add Side
Hardware that handles a signal coming in from the network to an end terminal.

ADM
Add-drop multiplexer

Aggregate
A collection of one or more network elements and/or aggregates. An aggregate is represented by
a single icon on the Network Map.

AIS
Alarm Indication Signal

AL
Alarm List

Alarm
An event, or a pair of events, that indicates there is a problem that must be resolved by the
operator. Alarms appear in the Alarm List. There are different types of alarms, including current
alarms, repeat alarms, and historic alarms.

Alarmed Object
A network resource on which a problem exists or has existed, and on which a user needs to take
action. The network resource can be a piece of equipment, a port, or a trail.

Archive
The act of copying information to an external device. The file may then be referred to as an
archive file.
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Area
Networks managed by Navis™ Optical NMS can be subdivided into smaller, manageable
networks called areas. An area is a collection of nodes and/or aggregates, and their associated
links. An area is represented by a single icon on the Network Map. Subdividing a network into
areas reduces overcrowding on the display and improves system performance because smaller
amounts of information are exchanged by the subsystems.

Assignable
A characteristic of a trail set at the time of provisioning. In Navis™ Optical NMS, a trail should
be set as assignable if it is expected that at least one client trail will be provisioned for it.

....................................................................................................................................................................................................................................

B BBE
Background Block Errors - An errored block not occurring as part of an SES.

Black box
A functional network unit, displayed on the Network Map, that is not monitored or controlled
by Navis™ Optical NMS. An example of a black box is a non-Lucent network element.

BLSR
Bidirectional Line Switched Ring

....................................................................................................................................................................................................................................

C CAC
Circuit access code - A code unique to a particular circuit that equates to a particular Circuit
Identification name for the same facility/circuit. The code is randomly generated in the circuit
provisioning system. The CAC does not change during a facility’s lifetime.

Catalogued connection
A connection that physically or logically exists in the network, and that is recorded in Navis™

Optical NMS.

Channel
When either a digital link, path, or facility is channelized, it is subdivided into channels. For
Time Division Multiplexing (TDM) equipment, channels represent the time slots with which
information is carried within a digital link or in a server trail. Channels are created by Navis™

Optical NMS for use during circuit/trail provisioning. When creating channels for digital links,
depending on the network element capability, alternate channels are created. The channel is
given an identity when it becomes either a provisioned path or facility, or a subdivision of a
digital link, path, or facility.

Channel Type
Indicates the type of channel riding on a facility/circuit.

....................................................................................................................................................................................................................................
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Circuit
A transmission path through the network, terminating at equipment at both the A and Z ends.
The transmission path combines equipments and channels of facilities. The circuit has a defined
purpose such as data, video, or voice.

Circulate
The act of moving the window at the bottom of a stack (of windows) to the top of the stack.

CKT
Circuit

CLO
Circuit Layout Order - Code (number) identifying a specific circuit layout order (configuration),
and used as the work item tracking key for a circuit order.

COI
Complete Order/Item state - The last state in most circuit order life cycles.

Cold backup
A backup that is performed while Navis™ Optical NMS is not running.

Combo circuit
The SDH version of one step combo provisioning is an optional feature in which 24N, 30N,
480N, 672N, 672N, and 1920N circuits/paths can be provisioned without an explicit
provisioning of TU12-VC11S, VC-12, VC-3, AU3S, and VC-4 respectively. These circuits/paths
provisioned via one step provisioning are identified using VC12S-24N, VC12S-30N,
VC3S–480N, VC3S-672N, AU3S-672N and VC4S-1920N respectively. The selection of either
TU12-VC11S-24N, VC12S-30N, VC3S-480N, VC3S-672N, AU3S-672N or VC4S-1920N for
provisioning is the selection of 24N, 30N, 480N, 672N, 672N, and 1920N provisioning
respectively.

Connection
Generic name for all transmission objects managed by Navis™ Optical NMS. A connection can
be a trail or a subnetwork connection or a link connection.

Console
A local terminal which is dedicated to administering a single host machine, and connected
directly via a console port.

Controlled network element
A network element controlled by Navis™ Optical NMS that displays on the network maps as
nodes interconnected by digital links. These network elements are in constant communication
with their EMS and are controlled by commands sent from the EMS. They also report and show
alarms. See Network element.
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CORBA
Common Object Resource Broker Architecture

CTM
Channel Terminations state - The state in a circuit order’s life cycle where the user enters
channel termination information.

Current Alarm
A new alarm received by, or generated by, Navis™ Optical NMS.

Customer equipment
See Equipment.

....................................................................................................................................................................................................................................

D DA
Digital Cross Connect Alarm - Displays the type of digital cross-connect alarms that are active
on the port. Possible values are: E (equipment alarm), S (signal or loss of signal alarm), P
(performance), M (multiple alarms).

Days Past Due
The number of calendar days (0-30) past the due date of a pending order.

DB
Database

DB Sync
Database Synchronization - Refers to the synchronization of digital cross-connect system
databases with the Navis™ Optical NMS database.

DCS
Display Construction Set

DD
Due date - Date when the work requested by the order is to be completed.

Default Weight
Navis™ Optical NMS calculated link weight.

Dense Wavelength Division Multiplexing (DWDM)
A connection that combines multiple optical signals to increase capacity. These signals are
amplified as a group and then transported over a single fiber.

Digital link
Fiber or electrical connections between two points. These transport facilities are assignable to
high-order and low-order circuits to carry customer services.

....................................................................................................................................................................................................................................
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Digital links can be of two types: Synchronous Digital Hierarchy (SDH) or Plesiochronous
Digital Hierarchy (PDH).

• SDH digital links are synonymous with multiplexer sections. They connect two SDH network
elements, black boxes or equipment.

• PDH digital links are asynchronous connections between two PDH ports of the network elements
assignable to the PDH circuits.

DISC
Disconnect (improper disconnect) - Indicates whether a facility/facility channel has been
improperly disconnected. If it has, a “D” appears in this field and Navis™ Optical NMS lists it
as In-Effect.

Domain
A collection of network elements that can be assigned to specific users in “database
partitioning.”

Drop Channel
One direction of a bidirectional signal; a wavelength being dropped from the single flow.

Drop Side
Hardware that handles a signal leaving an end terminal and heading out to the network.

DTE
Data Terminating Equipment

DTS
Digital Transmission System

DWDM
Dense Wavelength Division Multiplexing

DXC
Digital Cross-Connect System - A generic term for electronic cross-connect systems.

DXC Model
The model of the digital cross-connect system frame.

DXCAM
Digital Cross Connect Administration and Maintenance

....................................................................................................................................................................................................................................

E E
Specifies an alarm condition for the equipment assigned to an area.
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E1
International facility on which DS0 channels are multiplexed up. The E1 carries 32 channels;
channel 0 is used for signaling between DACS frames. Channel 16 may be used for carrying
DS0 signaling. Otherwise, channel 16 may be used for customer service and signaling is carried
inband.

EBC
Errored Block Count

EML
Element Management Layer

EMS
Element Management System

Equipment
Equipment is a network element that will never be controllable. Customer equipment does not
report alarms and the Navis™ Optical NMS does not send provisioning commands to customer
equipment. Customer equipment does not appear on the Network Map but does appear at the
Graphical Layout of the provisioned digital link, path, and/or circuit. Although customer
equipment is not displayed on the Network Map, it can be a place holder for end lines. Also
called customer equipment.

ES
Errored Seconds - A one-second period with one or more errored blocks or at least one defect.

Event
Something that has happened — either in the transmission network, or in an EMS that Navis™

Optical NMS is managing, or within Navis™ Optical NMS itself. Examples of events include an
operation that has succeeded, an operation that has failed, or failure of a network resource.
Failure events give rise to alarms. Some events occur as a pair (a raise followed by a clear).

External Address
Address used by Navis™ Optical NMS in configuration management.

....................................................................................................................................................................................................................................

F Facility
A carrier of low-order trails. A facility is a channel-assignable trail.

....................................................................................................................................................................................................................................
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Fault State
The state of an alarmed object with respect to its ability to carry traffic.

There are three fault state values:

• “Working” indicates that the object can carry traffic as intended.

• “Degraded” indicates that the object is still carrying traffic but has lost some protection or the
quality of traffic is impaired.

• “Failed” indicates that the object is not carrying traffic.

Faulted connection
A connection that has an event correlated against it.

FM
Fault Management

Form
A task window where the user can enter data, perform commands, and view data from the
system.

Full Geographic Redundancy
See Geographic Redundancy

....................................................................................................................................................................................................................................

G Geographic domain
A geographic domain is a partition of the network that is defined to include a group of network
elements.

Geographic domain partitioning
Geographic Domain Partitioning is an optional feature that allows a network to be partitioned
into geographic domains. A geographic domain is a partition of the network that is defined to
include a group of network elements. Access to the geographic domains can be controlled on a
per-user basis.

Geographic redundancy
Geographic redundancy provides site protection by maintaining a primary server and a standby
server in separate locations and ensuring that the two servers are far enough apart so that
natural disasters or adverse weather conditions cannot affect the primary and standby servers at
the same time. The database of the standby server is maintained as a copy of the primary server.
If the primary server fails, the standby server can be manually brought on-line.

There are two types of geographic redundancy:

• simplified, an optional Navis™ Optical NMS feature which uses nightly backups to update the
database of the standby server.

• full, an optional Navis™ Optical NMS feature which uses a mirroring facility to update the
database of the standby server every 30 minutes.

....................................................................................................................................................................................................................................
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The two types of geographic redundancy differ in the frequency of database updates from the
primary server to the standby server.

GR
Geographic Redundancy

GUI
Graphical User Interface

....................................................................................................................................................................................................................................

H Historic alarm
An alarm that has been deleted.

Hot backup
A backup that is performed while Navis™ Optical NMS is running.

....................................................................................................................................................................................................................................

I IMP
Implementation state - The state in the life cycle of a circuit order where the digital
cross-connect system commands are implemented.

IMR
Implementation Roll state - The state in the life cycle of a circuit order that permits testing
between the bridge and roll commands.

Int ChType
Internal Channel Type

Integrated Transport Management - Cross-Connect Module (ITM-XM)
An EMS to which Navis™ Optical NMS has direct access; no interface is required.

Integrated Transport Management - Subnetwork Controller (ITM-SC)
Previously known as Transport Management Application Group (TMAG).

Internal Address
Address sent to the network element via the ITM-SC (Element Management System), sometimes
referred to as the software address of the port. This address is specified by the vendor.

IOR
Inter-operable Object Reference

ITM-PRM
Integrated Transport Management - Physical Resource Manager

....................................................................................................................................................................................................................................

G L O S S A R Y
G L - 8

Lucent Technologies 365-309-264R7.0
Issue 1, July 2002



ITM-SC
See Integrated Transport Management - Subnetwork Controller.

ITM-XM
See Integrated Transport Management - Cross-Connect Module.

....................................................................................................................................................................................................................................

L LAY
Layout state

Local Terminal
The terminal that resides next to the digital cross-connect in the central office and can be used
to interface directly with the ITM-SC. Also known as “console terminal”.

Location
The location code of the equipment or digital cross-connect frame.

LOF
Loss of frame

Log
Record of past and/or current activities.

Logical Port Address (External or Internal)
Address of a channel (logical channel) riding on a higher-order system; the higher-order system
is terminated on a physical port. There are two address formats: network-level (external)
and EMS-level or Network Element level (internal).

LOM
Loss of multiframe

LOP
Loss of pointer

LOS
Loss of signal

LSR
Line-Switched Ring

....................................................................................................................................................................................................................................

M MDI
Miscellaneous Discrete Input
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MDO
Miscellaneous Discrete Output

MIB
Management Information Base. A conceptually organized database that contains the management
information accessed through SNMP.

MODE
Execution (Restoration) mode of a preplan circuit.

MS
Multiplex Section

MS-SPRING
Multiplex Section-Shared Protection Ring

MSP
Multiplex Section Protection

MT
Moyens de Transmission (Transmission Means)- A digital transmission medium (facility) of
specific bandwidth between A Location and Z Location. Contract circuits are routed on MTs.

....................................................................................................................................................................................................................................

N Navis Optical Element Management System (EMS)
Navis™ Optical EMS is a management system for the WaveStar product family, providing
Element Management Layer (EML) management functions for WaveStar products. This system
has configuration management, fault management, performance management, and security
management functions.

NE
Network Element

NEID
Network Element Identifier of digital cross-connect systems under ITM-SC. (Same as TID.)

Network
A network carries a payload from one point to another. This payload can consist of data, voice,
video, or images. Only circuits carry data. Digital links, facilities, and paths carry the circuits
that carry the data.

Network connection
A transport connection that is connected at each end to a trail termination point.

....................................................................................................................................................................................................................................
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Network element
A network element is a functional unit in a customer’s network that the Navis™ Optical NMS
displays on the Network Map and is monitored by the Navis™ Optical NMS user through the
graphical user interface. Network elements supply switching, transmission, or multiplexing
functionality in a network. A network element is either controlled or noncontrolled.

Node
Physical location representing any managed equipment, including regenerators.

Non-assignable
A characteristic of a trail set at the time of provisioning. In Navis™ Optical NMS, a trail should
be set as non-assignable if it is expected that no client trail will be provisioned for it.

Non-service-affecting alarm
Alarms categorized as non-service-affecting indicate that at least one channelized facility,
without provisioned circuits, is alarmed.

Noncontrolled network element
A noncontrolled network element is a Black box or Customer equipment that cannot be
controlled by Navis™ Optical NMS. These network elements do not report alarms.
Noncontrolled network elements support only manual provisioning and are listed in the database
as a part of provisioning records. See Network element.

NSA
Non-service-affecting

NTN
Network Telephone Number - Used on a network to represent a physical address.

NTN1
Network Telephone Number - Primary telephone number of the digital cross-connect frame on
the packet network.

NTN2
Network Telephone Number - Backup telephone number of the digital cross-connect frame on
the packet network.

....................................................................................................................................................................................................................................

O OA
Optical Amplifier

OCH
Optical Channel
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OFS
Out-of-Frame Seconds

OLS
Optical Line System

OMS
Optical Multiplex Section

Order
Circuit Order number

OTU
Optical Translator Unit

....................................................................................................................................................................................................................................

P Path
An SDH transmission object between two SDH/virtual ports. There are high-order paths (VC-4)
and low-order paths (VC-3 and VC-12).

PDH
Plesiochronous Digital Hierarchy

Performance Monitoring (PM) Export
An optional feature that allows performance-monitoring information to be exported to a
predefined data file, which can be used for a variety of purposes.

Physical Port
The object responsible for the processing of the signal on the communication infrastructure.

• For an SDH port, the physical port is the processing from the fiber to the MS level.

• For a PDH port, the physical port is the PDH processing before insertion/extraction to the SDH.

• For an optical port, the physical port is the processing from fiber to the optical MS level.

Physical Port Address (external or internal)
Address of the port that physically terminates a facility.

Plesiochronous Digital Hierarchy
A transmission hierarchy wherein all the elements have the same nominal digital rate but are
synchronized on different clocks (near synchronization).

Port
The port address of the facility.

....................................................................................................................................................................................................................................

G L O S S A R Y
G L - 1 2

Lucent Technologies 365-309-264R7.0
Issue 1, July 2002



Post
Command to initiate the continuity check of a facility/circuit layout across the network and to
determine the route of a facility or circuit.

Preplan Circuit
The preplan circuit is the protecting circuit used to restore the service circuit. Also known as
service circuit.

Preplan Restoration
An optional feature that allows a dedicated backup route to be specified for paths and circuits.
When Preplan Restoration is used, a disrupted circuit is temporarily rerouted on an alternate
route to restore service. The restoration process is triggered manually or automatically by an
alarm. Once the alarm situation is resolved, the restored circuit can be manually reinstated to its
original route.

Primary Alarm
An alarm that is a direct result of a failure in the network, such as Loss of Service (LOS).

Protection Path
The protection path is a backup route that protects the service path. The service path is the path
that is standards operational.

PSR
Path-Switched Ring

PTI
Path Trace Identifier

PTP
Port

....................................................................................................................................................................................................................................

R Receive Date
The date an order is received.

Redline
Indicates whether circuit requires special service protection marking and treatment.

Refederate
The process of re-establishing the association between the Navis™ Optical NMS and Navis™

Optical EMS Orbix instances.

Repeat Alarm
A type of current alarm; a current alarm that has the same source as probable cause as another
current alarm becomes a repeat alarm.

....................................................................................................................................................................................................................................
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Response Display
You specify whether you want to see all responses from the frame, only your own responses, or
your own and alarm responses.

Ring
Rings are formed when the digital links connect all participating network elements to form a
closed loop.

RNAME
The system name that identifies the specific DTE to use to communicate with the packet
network and the host name.

....................................................................................................................................................................................................................................

S SA
Service affecting

Scheduled entity
A provisioning assignment for a facility, path, or circuit that has been designated to occur at a
future date and time. All assignments, with the exception of digital links, can be scheduled.

SDH
Synchronous Digital Hierarchy

Section
A trail in a section layer.

Service Circuit
See Preplan circuit.

Service Domain
A partition of the network that is defined to include a subset of a network’s link connections
(channels) and physical ports and their derived connectivity.

Service domain partitioning
Service Domain Partitioning is an optional feature that allows a network to be partitioned into
service domains. A service domain is a partition of the network that is defined to include a
subset of a network’s link connections (channels) and physical ports and their derived
connectivity. Access to the service domains can be controlled on a per-user basis.

Service Path
The path that is standards operational. The protection path is a backup route that protects the
service path.

....................................................................................................................................................................................................................................
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Service-affecting alarm
Alarms categorized as service-affectingindicate that at least one non-channelized facility is
alarmed or that at least one channelized facility with provisioned circuits is alarmed.

SES
Severely Errored Seconds - A one-second period that contains 30% or more errored blocks or at
least one defect. SES is a subset of ES.

Shared Risk Group
A group of entities that share the risk among fibers which use the same conduit.

SI
Session indicator - Type of session between the Navis™ Optical NMS and the DACS: DS
(Navis™ Optical NMS Session) or VS (VCIT Session).

Simplified Geographic Redundancy
See Geographic Redundancy.

SNC
Subnetwork Connection

SNCP
Subnetwork Connection Protection

SNMP
Simple Network Management Protocol

SNMS
See Navis Optical Element Management System (EMS).

Speed
Baud rate

Status
Current condition or state of progress of an instance or object.

Subnetwork
A collection of interconnected network elements that has a certain behavior. The subnet concept
allows Navis™ Optical NMS to manage fixed cross-connect systems and rings through SDH
multiplexers. Also called a ″subnet.″

Synchronous Digital Hierarchy
A transmission hierarchy wherein all the elements are synchronized.

....................................................................................................................................................................................................................................
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....................................................................................................................................................................................................................................

T Tandem connection
A sublayer between the management system connection and path layer that allows users to
monitor the quality of the signal transport within its managed domain. Tandem connections also
provide users with information about the total quality of a signal before the signal travels from
the user’s managed network to a network managed by a different user. Users can create tandem
connections on paths that do not terminate in its managed network but traverse its network from
other user managed networks.

TCA
Threshold Crossing Alert

TCAL
Traffic Correlated Alarm List

TCM
Tandem Connection Monitoring

Termination
Port address

TID
Target Identifier - The target identification name of the digital cross-connect frame, that is used
in the network to identify a digital cross-connect frame. (Same as NEID.)

TMAG
See Transport Manager Application Group.

TMN
Telecommunications Management Network Integration Module

TP
Termination Point

Trail Termination Point
The transport, trail termination, and adaptation functions that terminate a trail.

Transport Manager Application Group
An interface that uses Lucent proprietary TMAG protocol to interface with the ITM-SC EMS.

Tributary Port
Generally forms the add/drop side of an ISM. This is where signals going from the tributary
side to the line side of an ISM get added, or where signals going from the line side to the
tributary side of an ISM get dropped. The tributary ports terminate 2-Mb/s (CEPT-1 or VC-12),
140 Mb/s (CEPT-4 clear channel), or 155 Mb/s (STM-1 clear channel or TUG structured)

....................................................................................................................................................................................................................................
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signals.

TTP
Trail Termination Point

....................................................................................................................................................................................................................................

U UAP
Unavailable Period

UAS
Unavailable Seconds - A period containing 10 or more consecutive Severely Errored Seconds.

UID
User Identification - Host login of the user.

Uncatalogued connection
A connection that physically or logically exists in the network, and that is not recorded in
Navis™ Optical NMS.

Uncorrelated Alarm
Specifies an alarm condition that exists on ports or network elements assigned to an area that
does not terminate links, trails, or circuits in Navis™ Optical NMS.

Uncorrelated Event
An event that does not affect any trail provisioned in Navis™ Optical NMS.

User defined area maps
These maps allow a specific user to define which network elements to display on the screen
within a submap. See User defined submaps.

User defined sub maps
These maps allow a specific user to define what areas to display on the screen. See Area and
User defined area maps.

User ID
A login ID. Each user ID represents a person who has been granted access to use Navis™

Optical NMS.

User Profile
A user profile is an association of a list of tasks with a User ID. The user profile controls which
tasks the user is allowed to perform.

....................................................................................................................................................................................................................................
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....................................................................................................................................................................................................................................

V VCG
A Virtual Concatenation Group is a logical entity that is a grouping of member VC-n trails. A
VCG, its end ports---which are referred to as PTPs---and any number of VC-n trails can belong
to the same service domain.

VCIT
Virtual Craft Interface Terminal

Virtual Port
Terminates the two line ports in a protection scheme. You enter the line port addresses in the
normal manner. The virtual port address is in addition.

Virtual Port Address (External or Internal)
Addressing scheme that allows you to enter a virtual port address that controls the two line
ports; the address allows one line port to be the service port and the other line port to be the
protection port. Virtual port addressing is a protection scheme.

VPN
Virtual Private Network

....................................................................................................................................................................................................................................

W Work Log
The history of a work item; a log of significant operations performed on work items.

....................................................................................................................................................................................................................................
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Index

A Add

an area, 7-13

member to aggregate,
7-7

administration

sa, the default, 4-3

Aggregate

add, 7-7

modify acronym, 7-11

remove member from,
7-9

Alarm database audit,
10-34

Alarm preferences on
forms

set, 3-68

Area

add, 7-13

delete, 7-15

modify, 7-14

Area Map, 7-16

add a user defined, 7-17

delete a user defined,
7-19

display/modify a user
defined, 7-18

Areas, 7-12

Asynchronous port setup
for TIM interface, 2-31

Audience, xix

Auto-Discovery Tool, 9-3

add or migrate
networks, 9-10

parameters, 9-12

Automatic package
switching, 3-32, 3-33

........................................................

B Background Map

install, 3-56

Backups, 8-3

cold, 8-4, 8-6

hot, 8-3, 8-5

Buffers

clearing single server,
8-33

Bulk circuit provisioning
tool, 9-68

Bulk Link Provisioning
tool, 9-65

........................................................

C CDE, 3-11, 4-6

set up printer icon, 2-40

Change

network element name
in ITM-SC, 9-19

network element name
in Navis™ Optical
EMS, 9-23

Channels

display assigned, 6-9

modify, 6-14

Clusters

re-add a server to using
SAM, 3-34

view status information,
3-35

CMISE, 9-58

Cold backup, 8-4, 8-6, 8-12

Commands

init, C-2

lanscan, C-8

Navis™ Optical NMS
geographic
redundancy, 8-19

ping, C-4

ps, C-11

shutdown, C-10

telnet, C-6

uname, C-7
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vgdisplay, C-9

who, C-3

Common Desktop
Environment (CDE)
See: CDE

Communication

restart, 8-25

Communications Software
Launcher (CSL)
See: CSL

Configuration

parameters, B-1

Connection Renaming tool,
9-62

Conventions

typographical, xxii

cron file, 3-39

dacscan, 3-41

edit, 3-43

root, 3-42

CSL, 10-13

Cut-through, 10-23

from Navis™ Optical
NMS to Navis™

Optical EMS, 10-13

set up a user ID for
cut-through to Navis™

Optical EMS, 4-21
........................................................

D dacscan cron file, 3-41

Data export feature

administer, 3-47

Database cleanup, 9-75

Database synchronization,
10-35

Default administrator, 4-3

Delete

an area, 7-15

Navis™ Optical EMS
controlled node from a
digital link, 9-43

network element from
ITM-SC digital link,
9-40

Desktops

start the application on,
3-9

stop the application on,
3-14

Disconnect order, 9-77,
9-78

Display

release number, 12-2

DNO, 9-50

Documentation

font usage, xxii

list of, xxiii

on CD-ROM, xxiii

on-line version, xxiii

Dynamic Network
Operation (DNO)
See: DNO

........................................................

E Event indications
preferences

set, 3-66

Export tool

execute, 3-53
........................................................

F File systems, A-1, C-1

Filtering criteria

set for application
alarms to be sent to
TIM, 3-64

FM operational preferences

set, 3-69

Font usage, xxii
........................................................

G Geographic Domain
Partitioning

add, 5-6

add a network element,
5-13

add a user, 5-13

assigning users to, 5-5

definition, 5-2

delete, 5-12

delete a network
element, 5-19

delete a user, 5-19

display, 5-8

display network
elements, 5-9

display users, 5-15

display users assigned
to a network element,
5-17

feature installation, 5-3

feature particulars and
restrictions, 5-3

getting started, 5-3

list user-assigned
network elements, 5-18

modify, 5-10

types of users, 5-4
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Geographic redundancy,
8-18

Geographic Redundancy

power down the servers,
2-13

power on the servers,
2-6

Geographic redundancy

restart Navis Optical
NMS communication
with, 8-27

Geographic Redundancy

start and stop tasks,
3-19

Geographic redundancy

switch the roles of the
servers, 8-29

geographic redundancy

view which server is
running on the
application, 8-31

Geographic
RedundancyNavis™

Optical NMS

start the application on,
3-20

stop the application on,
3-21

GUI_Server.cfg file, 10-13
........................................................

H Help

screen help, xxiii

Host database, 8-9

Hot backup, 8-3, 8-5

Hot backup recovery, 8-10

HP-UX Workstation

power down, 2-22

power on, 2-19

start the application on,
3-11

........................................................

I

icon behavior

EMS, 8-22

Information products

font usage, xxii

how to order, xxiv

on CD-ROM, xxiii

on-line version, xxiii

init command, C-2

Insert

ITM-Navis™ Optical
EMS controlled node
into a digital link,
9-35

ITM-SC controlled node
into a digital link,
9-29

INSERTNODE tool, 9-27

Intended audience, xix

ITM-SC

add, 10-15

ITM-SC servers

restart Navis Optical
NMS communication
with, 8-28

........................................................

L LAN

enable, 10-32

reset, 10-32

lanscan command, C-8

load ID, 12-2

Local Redundancy
Configuration

disable automatic
package switching
using SAM, 3-33

enable automatic
package switching
using SAM, 3-32

overview, 3-22

power down the server,
2-11

power on the servers,
2-5

re-add the HP server to
a cluster using SAM,
3-34

start the application on,
3-24

start the application on
using SAM, 3-27

stop the application on,
3-26

stop the application on
a specific server using
SAM, 3-28

stop the application on
using SAM, 3-29

switch to a standby
server using SAM,
3-30

view cluster status
information on, 3-35

Location Reference Table

network element search,
3-58

Log file

management for joint
workstations, 11-10

view on an HP
workstation, 11-12
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view on Windows PC,
11-15

Log files

renamed connections,
9-61

........................................................

M Maintenance

routine, 8-32

Map preferences

set, 3-67

Messages

recovery, 3-45

warning, 3-45

Mirrored disk
configuration, C-9

Mirroring status, C-9

Model name change of a
network element, 3-62

Monitoring space, 3-45

MSP, 9-65

Multiplex Section
Protection (MSP)
See: MSP

........................................................

N Navis™ Optical EMS

add a new, 10-5

cut-through for, 10-13

restart Navis™ Optical
Network Management
System communication
with, 8-26

restart server
communication, 8-25

Navis™ Optical NMS
database

synchronize with an
EMS, 10-26

Network elements

add to geographic
domain, 5-13

Change Network
Element Tool, 9-14

change the model name,
3-62

change the TID, 9-16

delete from a
geographic domain,
5-19

display those assigned
to a geographic
domain, 5-9

display those assigned
to a user, 5-18

modify information on
noncontrolled network
elements, 3-60

rename in ITM-SC,
9-19

rename in Navis™

Optical EMS, 9-23

search for, 3-58

update position on
Network map, 3-57

verify the
communication status
with Navis™ Optical
EMS, 10-25

Network Map

update network element
and ODO positions on,
3-57

........................................................

O ODO, 3-55, 3-60

update position on
Network Map, 3-57

ODO tool, 9-71

Off-line tools, 9-27

Auto-Discovery Tool,
9-3

Bulk circuit
provisioning, 9-68

Bulk Link Provisioning,
9-65

Change network
element, 9-19, 9-23

Connection Renaming,
9-62

exporting PM data, 3-47

ODO, 9-71

Reparenting ITM-SC
Network Elements,
9-47

Reparenting Navis
Optical EMS network
elements, 9-49

Upgrade Navis™ Optical
NMS OLS 400G from
CMISE to TL1, 9-58

Upgrade WaveStar®
OLS 400G to
WaveStar® OLS 800G,
9-54, 9-55

OMS, 9-27

OMSP, 9-27

On-line documentation,
xxiii

On-line help
See: Screen help

Optical Multiplex Section
(OMS)
See: OMS

Optical Multiplex Section
Protection (OMSP)
See: OMSP
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Oracle database, 3-36

restart, 3-37

stop, 3-38

Ordering

information products,
xxiv

OS Superuser, 1-3

Out-of-Domain Object
(ODO)
See: ODOs

........................................................

P Package switching

disable automatic, 3-33

enable automatic, 3-32

Parameters, B-1

Patch

software, 12-1

Performance monitoring

displaying variable
settings, 3-49

export tool, 3-53

variables, 3-48

workstation set up task,
3-51

Performance monitoring
data

administer, 3-47

Performance Monitoring
Data Export transfer

schedule run time, 3-50

ping command, C-4

Port address preferences

set, 3-71

Ports

modify, 6-16

Service Domain, 6-10

Preferences

set, 3-65

set alarm preferences,
3-68

set event indications
preferences, 3-66

set FM operational
preferences, 3-69

set map preferences,
3-67

set port address
preferences, 3-71

Printer

add local printer, 2-39

add network printer,
2-37

install network printer
on a Navis™ Optical
NMS server, 2-35

set up CDE printer icon,
2-40

Privileges

system administrator,
4-18

user, 4-14, 4-16

ps command, C-11

PTP, 6-3
........................................................

R Recover database to
different server, 8-14

Recoveries

cold backup, 8-12

host database, 8-9

hot backup, 8-10

Redundancy

full, 8-18

full geographic, 8-18

geographic, 8-18

local, 8-18

simplified geographic,
8-18

Refederate Navis Optical
EMS server, 10-28

REMOVENODE tool, 9-27

Rename

ITM-SC network
element, 9-19

Navis™ Optical EMS
network element, 9-23

Reparent

ITM-SC Network
Elements, 9-47

Navis Optical EMS
network elements, 9-49

Navis Optical NMS
EMS resources, 9-52

rhosts file, 3-51

root cron file, 3-42

Run levels, C-2, C-3

Run status verification,
10-24

........................................................

S sa, 4-3

SAGE, 4-5

add a user to a
workstation, 4-31

delete a user on a
workstation, 4-33
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SAM

create an application
user ID, 4-6, 4-10

disable automatic
package switching in a
local redundancy
configuration, 3-33

enable automatic
package switching in a
local redundancy
configuration, 3-32

re-add the HP server to
a cluster in a local
redundancy
configuration, 3-34

start the application on
a local redundancy
configuration, 3-27

stop the application on
a local redundancy
configuration, 3-29

stop the application on
a specific server, 3-28

switch to a standby
server in a local
redundancy
configuration, 3-30

Schedule

Performance Monitoring
Data Export file
transfer, 3-50

Scheduled entities, 7-24

delete, 7-26

filter list, 7-28

modify, 7-27

view list of, 7-25

view list of
successful/failed, 7-30

Screen help, xxiii

Secure Access Gateway for
Enterprises (SAGE)
See: SAGE

Server Configuration with
UPSNavis™ Optical NMS

stop the application on,
3-18

Servers

adding a user, 4-20

clear single server
buffers, 8-33

clear trace files on a
server, 11-13

switching roles of, 8-29

view which server is
running on the
application, 8-31

Service Domain
Partitioning

add, 6-5

add users, 6-20

channels, 6-3

dedicated mode, 6-3

definition, 6-3

delete, 6-6

delete users, 6-23

display assigned
channels, 6-9

display assigned ports,
6-10

display assigned trails,
6-8

display users, 6-22

display VDGs assigned,
6-11

feature particulars and
restrictions, 6-4

modify channels
assigned, 6-14

modify ports assigned,
6-16

modify trails assigned,
6-12

modify VCGs assigned,
6-18

ports, 6-3

shared mode, 6-3

trails, 6-3

user types, 6-4

VDGs, 6-3

Set up

cut-through session for
ITM-SC, 10-18

cut-through session for
Navis™ Optical EMS,
10-8

shutdown command, C-10

Single Server
Configuration

power down the server,
2-9

power on the server, 2-4

Single server configuration

start the application on,
3-6

Single Server
Configuration

start the application on,
3-15

sncFint.cfg file, 10-14

Software patch, 12-3, 12-4

Spacewatch

monitoring, 3-45

Spacewatch program, 3-45
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Submap

add a user defined, 7-21

delete a user defined,
7-23

display/modify a user
defined, 7-22

user defined, 7-20

Switching packages on the
servers, 3-32, 3-33

Switching servers, 8-29

Switchover

automatic, 8-20

detection of, 8-24

EMS icon behavior,
8-22

manual, 8-20

Switchover behavior

ITM-SC, 8-23

Navis Optical EMS
local redundancy, 8-22

Navis™ Optical EMS
geographic
redundancy, 8-22

Synchronize

Navis™ Optical NMS
database, 10-26

System administrator
privileges

assigning on a Windows
PC, 4-18

System information, C-7
........................................................

T TCP/IP configuration setup
for TIM, 2-27

telnet command, C-6

TID

change, 9-16

TIM, 3-63

asynchronous port
setup, 2-31

set filtering criteria for
application alarms,
3-64

TCP/IP configuration
setup, 2-27

TL1, 9-58

TMN Integration Module
(TIM)
See: TIM

Tools
See: Off-line Tools

Trace

capture data, 11-3

create on a server, 11-4

create trace files on a
PC, 11-9

create trace files on an
HP-UX, 11-8

fault management, 11-6

southbound/northbound
trace, 11-6

Trace file

create, 11-14

single, 11-14

tracestrt command, 10-14

Trails

listing, 6-8

modify, 6-12, 6-18

Typographical conventions,
xxii

........................................................

U uname command, C-7

Uninterruptible Power
Supply (UPS)

UPS, 3-18

Upgrade WaveStar® OLS
400G to WaveStar® OLS
800G, 9-54, 9-55

UPS, 3-18

User defined area map,
7-17

User defined submap, 7-21

User profiles
See: Users

User types

system administrator,
1-3

Users

add a user profile, 4-27

add on a server, 4-20

add to a SAGE
workstation, 4-31

add to geographic
domain, 5-13

add to service domain,
6-20

adding, 4-22

assign user privileges to
a user on a Windows
2000 PC, 4-16

assign user privileges to
a user on a Windows
PC, 4-14

create a user ID through
GUI based SAM, 4-6

create a user ID through
terminal based SAM,
4-10
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delete from a
geographic domain,
5-19

delete from a SAGE
workstation, 4-33

delete from service
domain, 6-23

delete ID information,
4-26

delete user profile, 4-30

display those assigned
to a geographic
domain, 5-15

display those assigned
to a network element,
5-17

display those in service
domain, 6-22

modify a profile, 4-28

modify ID information,
4-24

profiles, 4-4, 4-4, 4-5

set up user-ID for
alternate cut-through
to Navis™ Optical
EMS, 4-21

types of, 4-4

types of in a service
domain, 6-4

types of in geographic
domain, 5-4

........................................................

V Variables

display performance
monitoring, 3-49

performance monitoring,
3-48

VCGs, 6-3

display those in service
domain, 6-11

vgdisplay command, C-9

Virtual Concatenation
Group (VCG)
See: VCG

Virtual disconnect tool,
9-75

........................................................

W wc command, C-11

who command, C-3

Windows Desktop

assign system
administrator
privileges, 4-18

assign user privileges
on a Windows 2000
PC, 4-16

assign user privileges
on a Windows PC,
4-14

power down, 2-23

power on, 2-20

Windows PC

start the application on,
3-12

Windows Terminal Server

power down the server,
2-16

power on the server, 2-7

start the application on,
3-8, 3-10

stop the application on,
3-17

Workstation

add to Navis Optical
NMS host, 2-25
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